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1

Introduction

ragon NaturallySpeaking lets you talk to your computer instead of typing. As 
you talk, your words are transcribed onto your screen and into your documents 

or e-mail messages.

Talking to a computer while it types what you say is called dictating. You can dictate 
into Microsoft® Word, Corel® WordPerfect®, e-mail programs, personal information 
organizers, and virtually any other program in which you normally type. 

You can use Dragon NaturallySpeaking to:

■ Compose letters, memos, and send e-mail messages. You can cut and paste 
inside your documents as well as revise and format text. Just think about what 
you want to say, and then say it into the microphone.

■ Enter data into forms or spreadsheets. Most people can dictate numbers faster 
than they can type. Using Dragon NaturallySpeaking Professional or higher 
editions, you can create custom voice commands to let you move from field to 
field on your form by voice.

■ Work on the Web. You can search the Web, access information, and navigate 
Web pages by speaking URLs and links.

■ Start programs and open menus.

■ Use handheld recorders to dictate while you are away from your computer. 
Dragon NaturallySpeaking can then transcribe what you said. (Available in 
Preferred and higher editions.)

D
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About this guide

This guide covers all editions of Dragon NaturallySpeaking. 

Most of the information presented in this guide is applicable to all the editions. 
Differences between the editions is noted in the text. 

Conventions used in this guide
1 This guide contains many examples of words and phrases you can say when 

using Dragon NaturallySpeaking. These examples appear in italics with 
quotation marks, for example: “Format That Bold.”

2 Some procedures also include sample text for you to dictate. Sample text 
appears in a different typeface, with punctuation in square brackets.

3 This guide applies to the five English dialects that ship with Dragon 
NaturallySpeaking: 

■ US English

■ UK English

■ Australian English

■ Indian English

■ Southeast Asian English

US English uses US spelling, punctuation, and time and currency formats. We 
recommend US English for Canadian users since this dialect formats numbers 
(including times, telephone numbers, and currency) in North American formats.

All other dialects use UK spelling, punctuation, and time and currency formats 
(some number settings depend on your Windows Regional Settings). Where 
multiple dialects are used in dictation examples, those dialects appear in a 
different font style. For example:

You can also correct a longer phrase by saying “Correct [text] Through [text]” (US/
Canada) or  “Correct [text] To [text]” (Other Dialects). 

4 This guide uses US spelling and punctuation for consistency.

5 This guide also includes tips and notes to help you use the software more 
effectively. Tips and notes appear like this:

 If you pause correctly, but Dragon NaturallySpeaking still types a command as dictation, you 
can force it to recognize what you say as a command by holding down the CTRL key.
TIP
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 With Numbers Mode on, Dragon NaturallySpeaking tries to interpret everything you say as 
a number. If you dictate words, the results will be unpredictable. However, you can still navigate 
menus and switch between programs by voice when Numbers Mode is on.

What’s new in Version 8? 
Dragon NaturallySpeaking Version 8 includes the following new features:

■ Accuracy: Version 8 speech engine is more accurate than Version 7. Expanded 
language models and improved acoustic training techniques deliver a large 
accuracy increase over Version 7.

■ Roaming Users: Dragon NaturallySpeaking Version 8 makes your user files 
available anywhere on the network through the Roaming User feature, and 
automatically synchronizes updates and adaptations centrally (Professional 
only).

■ Upgrade user files from previous versions of Dragon NaturallySpeaking during 
installation or after installation from the Open User dialog box.

■ Support for Palm OS®: Dictate into any device that supports the Palm OS® 
and have your recording transcribed by Dragon NaturallySpeaking 8 when you 
synchronize with your PC. This functionality is installed separately from 
Dragon NaturallySpeaking. See the online help for more 
information.(Preferred and Professional only). 

■ Support for Additional Input Devices: Dragon NaturallySpeaking Version 8 
now supports additional digital handheld recorders, array microphones and 
cordless microphones. 

■ Multiple Dictation Sources: With Multiple Dictation Sources you can use a 
single vocabulary for your microphone and handheld recorder profiles. 
(Professional only)

■ With new text formatting options you can specify how Dragon 
NaturallySpeaking formats dates, measurements and acronyms to meet your 
requirements. 

■ The Word Properties dialog box gives you the power to establish the specific 
configuration of any word in specific contexts. 

■ Use text and graphics commands with dynamic variables to instantly define the 
variables in any boilerplate text. 

■ The simplified Add Words from Documents wizard makes customizing your 
vocabulary from documents or word lists faster and easier. 

■ An improved Vocabulary Editor makes it easier to fine-tune custom 
dictionaries.

■ An improved Acoustic Optimizer Scheduler makes it easier to schedule running 
the Acoustic Optimizer

NOTE
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What should I expect from Dragon 
NaturallySpeaking?

One reason to use Dragon NaturallySpeaking is to do your writing more quickly; 
creating letters, reports, and other documents by voice. Another is to reduce the 
stress associated with keyboarding. Or maybe you just like the idea of being able to 
lean back in your chair, put your feet up on the desk, and still get work done.

Dragon NaturallySpeaking is good for all these reasons, but making it work well 
requires some effort from you. Dragon NaturallySpeaking learns about your voice 
and pronunciation as you use it. When you use words the program doesn’t know, it 
will misrecognize them. By correcting your mistakes, you help Dragon 
NaturallySpeaking improve its ability to recognize your way of speaking.

Do I still need my keyboard and mouse?
Although you can use Dragon NaturallySpeaking to do almost everything on your 
computer by voice, some things are still easier to do by mouse or keyboard. 

If using a mouse and keyboard is an option for you, try experimenting with using 
your voice and using your hands for different tasks, to see what works best. If using a 
mouse and keyboard is not an option, see “Working on your Desktop” on page 27.
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2

Installation and Training

his chapter describes how to install, set up, and train Dragon Naturally 
Speaking. 

System requirements
To run Dragon NaturallySpeaking, your system must meet the following 
requirements:

■ Intel® Pentium® III 500MHz or greater (or equivalent AMDTM processor)
 Dragon NaturallySpeaking will not install on machine with a processor of less than 

500MHz.

■ 512MB RAM (256 MB free minimum).

■ 500MB of free hard disk space for a Custom Installation where you install only 
the program files and 1 set of speech files. Installations can range from 800 MB 
(Standard Edition) to 2.5 GB (US English Medical).

■ Windows 2000 Service Pack 4 or higher, Windows XP Pro, Windows XP Home. 
Windows ME is supported only for Standard and Preferred editions.

■ 16-bit Creative® Labs Sound Blaster®, or compatible sound card capable of and 
set to 16bit, 11KHz for Audio Recording.

■ Microsoft® Internet Explorer® 5 or higher (free download available at 
www.microsoft.com).

■ CD-ROM drive (8x or faster) required for installation.

■ ScanSoft-approved noise-cancelling headset microphone (included).

■ Speakers - optional for playback of recorded speech and text-to-speech 
features. (Available only in Preferred and higher editions).

■ An Internet connection for product activation and automatic updates. 

T

NOTE
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Plugging in the microphone

To use Dragon NaturallySpeaking, you will need to plug in your microphone.

1 Insert the microphone plug into the MIC input jack of your sound card. 
Microphones and sound cards vary, but the microphone jack is usually red and 
has a picture of a microphone. If your sound card does not have a MIC jack, use 
the LINE IN jack. 

If you are not sure how to plug in your microphone, consult the documentation 
that came with your computer. 

Also, if you have a USB or array microphone (supported in Preferred and higher 
editions), follow the instructions that came with it instead of this description.

2 Insert the headphone plug into the LINE OUT jack on your sound card. If your 
sound card does not have a LINE OUT jack, use the SPEAKER or 
HEADPHONE jack.

 If you already have speakers for your computer, you can also use these to playback 
recorded speech instead of your headphones. 

Installing the software
Before installing, modifying or upgrading Dragon NaturallySpeaking:

■ Close all open applications. 

■ Turn off or disable any antivirus software; installation can sometimes trigger a 
false virus report.

Multiple users on one computer

Dragon NaturallySpeaking is licensed on a “per individual” basis. You are 
permitted to install the software on more than one computer (for example, on 
a desktop and a laptop computer, or on a work computer and a home 
computer), although you may not use the software concurrently on more than 
one computer, and you are permitted to create multiple voice profiles, so long 
as each voice profile is for you. If someone else desires to create or use another 
voice profile, however, that person must purchase a separate license for 
Dragon NaturallySpeaking. Volume license agreements are available.

NOTE
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 You must have Administrator rights to install or uninstall Dragon NaturallySpeaking on 
Windows 2000 and Windows XP. 

For Windows 2000 and Windows XP Professional systems with limited user accounts (users with 
restricted privileges), if the administrator wants to create a Dragon NaturallySpeaking user for a 
limited user, the administrator must log on as the limited user. If an administrator creates a Dragon 
NaturallySpeaking user for a limited user account from an administrator account, the limited user 
account will not be able to access that user. Administrator rights are not required to create a user or 
use the software after installation. This also applies for an upgrade installation. 

To install Dragon NaturallySpeaking:
1 Insert the Dragon NaturallySpeaking CD into your CD-ROM drive. 

If the installation does not start automatically, use the Windows Explorer to 
find and double-click setup.exe on your CD-ROM drive.

Follow the on-screen instructions during installation.

2 Provide your customer information, including the serial number supplied with 
your Dragon NaturallySpeaking installation. 

3 Choose your destination location. If there are no previous version of Dragon 
NaturallySpeaking on your system, the default directory is:

C:\Program Files\ScanSoft\NaturallySpeaking8

If you have Version 6 or 7 on your system, Version 8 will install to the previous 
version’s directory. 

For a list of directories created by installation, see Appendix A, “Version 8 File 
Structure” on page 191.

4 Choose your Setup Type (Preferred and higher editions)

"Typical/Complete" installs all options and speech files and requires the most 

Upgrading from a previous version

Upgrading from Version 6 or 7:
You can upgrade from any edition of Dragon NaturallySpeaking Version 6 
or 7 to Version 8. When upgrading from Version 6 or 7, you can choose to 
migrate your user files and vocabularies to Version 8. Once V8 is installed, 
Version 6 or 7 will no longer be functional.

Directory Changes
For information on changes to the directory structure when upgrading from 
Version 6 or 7, see “Version 8 File Structure” on page 191 .

NOTE
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disk space. "Custom" lets you select which options and speech files to install and 
can greatly reduce the disk space required for installation. 

Click Next to continue.

 If you decide not to install some Dragon NaturallySpeaking components by selecting 
Custom installation, you can install them later by running the Setup program again and choosing 
Modify.

5 You can enable the Dragon NaturallySpeaking QuickStart option. By enabling 
QuickStart, Dragon NaturallySpeaking launches at system startup time and 
adds the Dragon NaturallySpeaking QuickStart icon to the Windows task bar. 
For more information on the QuickStart option, see “Using QuickStart” on page 
24.

Installing other languages and dialects
To install user files for the other languages or dialects supplied with 
your edition, choose “Custom Installation” from the setup screen 
and click Next. 

Select the user file for the dialect you want and click Next to 
continue installation.

The user files for each language or dialect contain both spellings and 
pronunciations specific to that region. For example, users who wish 
to dictate US English spellings—including users with accents—
should install the US (American) English user files.

NOTE
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6 (Upgrade only) If you are upgrading from Version 6 or 7, the Version 8 
installation prompts you to upgrade your users. You may be prompted later to 
re-train some of your existing users. You can upgrade your V6 or V7 users at a 
later time by running the User Upgrade Wizard from the Open User dialog box 
once the product is installed. For more information, see “Upgrading Users” on 
page 138.

7 Continue following the on-screen instructions. The setup program will copy 
the files for Dragon NaturallySpeaking to your computer. 

8 When prompted, make sure to register your copy of Dragon NaturallySpeaking. 
Once registered, ScanSoft can notify you of product updates and other offers.

9 Select "Check the Internet for program updates after setup completes." This 
lets you automatically update Dragon NaturallySpeaking over the Internet 
when updates are available. Click Finish to complete the installation. The 
program may ask you to reboot your computer.

Activating Dragon NaturallySpeaking
The first time you start Dragon NaturallySpeaking, you will be prompted to 
activate your copy of Dragon NaturallySpeaking. 

If you do not activate the software, Dragon NaturallySpeaking will stop working 
after starting the product fives times. 

 You must be connected to the Internet to activate Dragon NaturallySpeaking. The activation 
process sends only your product serial number and a number that uniquely identifies the machine 
where Dragon NaturallySpeaking is being installed. No personal information is transmitted to 
ScanSoft.

To activate the Dragon NaturallySpeaking:
1 Start Dragon NaturallySpeaking. This displays the Activation dialog box.

If you choose “Activate Later”, you will be prompted to activate each time you 
start Dragon NaturallySpeaking. If you start the program five times without 
activating, Dragon NaturallySpeaking will be disabled.

NOTE
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2 Click “Activate Now”. This displays the Activation Screen:

3 Click Activate Automatically. Clicking Activate Automatically automatically 
activates the Dragon NaturallySpeaking and requires no further action from you.

 ScanSoft strongly recommends that activate automatically.

If you choose “Activate Manually”, the activation process will direct you to the ScanSoft product 
activation web site where you will be prompted to complete several steps to activate Dragon Naturally 
Speaking.

Creating a new user
When you launch the software for the first time, the New User Wizard starts and 
leads you through creating a new user. For example:

 If you upgraded a single user from a previous version, Dragon NaturallySpeaking loads that 
user. If you upgraded multiple users, Dragon NaturallySpeaking displays the Open User dialog box. 

NOTE

NOTE
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Creating a user
1 To create a user, you must type a name in the Your Name field. The software 

automatically picks the best speech model and vocabulary settings for your 
system. For more information, see “About vocabularies and languages” below.

2 Select your dictation source. If you are using a USB microphone or another type 
of input device, choose the appropriate option from the “Dictation source” 
drop-down list.

3 Click Next to continue.

About vocabularies and languages

Languages
Some editions of Dragon NaturallySpeaking Version 8 let you to create and train 
users in multiple languages. If you have purchased an edition with support for more 
than one language, you can add additional languages by choosing "Custom Install" 
during Setup. For Preferred and Professional editions, if you didn't select additional 
languages during Setup, you can also select an additional language when you create 
a new user. In this instance, you will need the Dragon NaturallySpeaking CD to 
install the language files before you can create the user.

Vocabulary
Dragon NaturallySpeaking uses a vocabulary to recognize words correctly based not 
only on the sound of the words, but on their context.

Vocabulary size
When you create a set of user files, Dragon NaturallySpeaking recommends the 
vocabulary that best fits your computer's speed and memory. For most users, this 
recommendation should be followed. 

Depending on your edition, you may see an Advanced button. Experienced users 
may want to click the Advanced button to specify a different vocabulary size:

■ Medium: for computers with 128 MB of RAM.

■ Large: for computers with more than 256 MB of RAM.

■ Empty Dictation: a vocabulary with a language model but without any words. 
Empty Dictation is designed for experienced users or re-sellers who want to 
create highly specialized vocabularies. (Professional and higher editions)

Speech Model
Dragon NaturallySpeaking uses the speech model to adapt to your voice during 
training. When you create a set of user files, Dragon NaturallySpeaking 
recommends the speech model that best fits your computer's speed and memory. 
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Setting up your microphone 
Click Next to have the New User Wizard lead you through setting up your 
microphone. 

Positioning your microphone
The New User Wizard first explains how to position your microphone: 

Once you have correctly positioned the microphone, click Next to continue.

Position the microphone
Positioning the microphone is important. If the microphone is out of place, Dragon 
NaturallySpeaking may not be able to hear you clearly and may make more 
mistakes.

Consistent position is also important. Make sure that you position the microphone 
the same way each time you use Dragon NaturallySpeaking.

Using a headset microphone
■ Position the microphone about a half-inch (approximately the width of your 

thumb) from your mouth and a little off to the side. The microphone should not 
touch your mouth, but it can be almost touching your lips.

■ If you need to move the microphone out of the way, you can lift the "boom" up 
and over your head, rather than bending it out of position or removing the 
headset.
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Using a handheld microphone (Preferred and Professional)
■ Hold the microphone one to three inches from your mouth and a little off to 

the side.

■ If the volume display on the DragonBar turns red, try holding the 
microphone slightly farther from your mouth. 

Using an array microphone (Professional and higher)
■ Position the array between 18 and 30 inches from and pointed at your 

mouth. 

■ Avoid blocking the path between your mouth and the array, for example by 
holding a book or paper in front of your face. 

■ Avoid having any source of noise or signal other than your voice directly 
facing the array within at least 15 feet. 

Check your volume
When the “Adjust Your Microphone: Volume Check” screen appears, click the 
“Start Volume Check” button and then read aloud the text displayed in the 
box. 

When the program beeps to indicate it has finished checking the volume, click 
Next.

Sound quality check
When the “Adjust Your Microphone: Quality Check” screen appears, click 
“Start Quality Check” and then read aloud the text displayed in the box. 

The program beeps when it has finished evaluating the sound quality of your 
system. If Dragon NaturallySpeaking displays “PASSED,” click the Next 
button to continue. 
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Training a new user
You must now train Dragon NaturallySpeaking to recognize your voice.

 For more information on training a mobile user, see “Using Portable Recorders 
(Preferred and Professional)” on page 151.

A yellow arrow shows you where to start reading. To take breaks while you're 
training the program, click Pause.

To advance through the first two screens, you must say the sentences without 
pausing. For the rest of the screens, it's okay to pause in the middle of a 
sentence. 

When the words change color, it means the computer has heard and recognized 
them. If you keep reading the same words, and the computer still doesn't get it, 
just click Skip. Otherwise, click Next to continue.

NOTE
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Choose a text to read aloud and click OK. 

You only need to read for about five minutes to train Dragon NaturallySpeaking to 
recognize your voice. 

You can take breaks during this training by clicking Pause. Don't worry if you make 
mistakes or laugh. You should try to read exactly what you see on the screen, but it's 
okay if you read something incorrectly. The computer will either ignore the mistake 
or display the yellow arrow so you read the text again.

The progress bar shows how much text you have left to dictate. 

 During training, dictating punctuation is not necessary. 

When you’ve read enough, the New User Wizard displays a congratulations 
message. When you click OK, Dragon NaturallySpeaking starts adapting to your 
voice.

NOTE
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Adapting to your writing style
After adapting to your voice, the New User Wizard prompts you to adapt Dragon 
NaturallySpeaking to your writing style.

Dragon NaturallySpeaking can analyze your writing style to increase your overall 
recognition accuracy during dictation. This tool scans documents in your My 
Documents directory. These documents include Microsoft Word, Corel WordPerfect, 
text files, HTML files, and rich text files (.rtf).

Adapting to your writing style can add 5 to 30 minutes to user training. Make sure all 
other programs are closed when you run this step.

 Though we recommend that you run this part of the New User Wizard, if you plan to skip 
this part of User creation, select "Skip this step" rather than Cancel.

Click Start to continue. While scanning your system, the New User Wizard displays 
its status. When Dragon NaturallySpeaking is done adapting to your writing style, 
click Next.

You are now ready to dictate.

NOTE
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3

Starting to Dictate

ow that you’ve installed your software and completed training, you’re ready to 
dictate your first sentence.

Starting Dragon NaturallySpeaking
If Dragon NaturallySpeaking is not already running, you can start it by:

■ Double-clicking the Dragon NaturallySpeaking icon.

■ Selecting Programs>Dragon NaturallySpeaking from the Start menu.

■ Right-clicking the QuickStart taskbar tray icon and selecting Start 
Dragon NaturallySpeaking, if the QuickStart option is enabled. 
For more information on using the QuickStart option, see “Using 
QuickStart” on page 24. 

Turning on the microphone
Before you can dictate, you need to turn on the microphone. You turn on the 
microphone by:

■ Clicking the microphone icon on the DragonBar.  You can click this icon again 
to turn it off.

■ Pressing the plus (+) key on the numeric keypad to turn the microphone on, 
and then press it again to turn the microphone off.

■ Clicking the microphone icon in the Windows task bar.

N

Microphone
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The button and the volume meter on the DragonBar change to show if the 
microphone is off or on.

 Once the microphone is off, you cannot turn it on again by voice.

Sleeping and waking up
To make Dragon NaturallySpeaking stop listening temporarily:

1 Say "Go to Sleep" or "Stop Listening." 
Dragon NaturallySpeaking ignores everything except the "Wake Up" or "Listen 
To Me" commands.

2 To reactivate the microphone, say "Wake Up" or "Listen To Me." 

You can also press the numeric (+) key to turn on the microphone.

Starting to dictate
To begin dictating, start a word processor (such as Microsoft® Word or Corel® 
WordPerfect®) and begin a new document. Make sure your text insertion point is at 
the start of the new document. 

 Remember to click in the window you want to talk to before you speak.

Start talking. As you talk, text displays in the Results box while Dragon 
NaturallySpeaking figures out what you said. The Results box is a small yellow 
window that appears on-screen as you dictate. For example:

The words in the Results box may change as the program considers different 
interpretations of what it heard.

Shows that the microphone is off

Shows that the microphone is on

DragonPad
You can use the DragonPad, a simple word processor included with 
Dragon NaturallySpeaking. To open the DragonPad, from the Tools 
menu on the DragonBar, click DragonPad.

NOTE

TIP
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The Results box displays a line that changes from yellow to green as you speak, 
indicating the volume of your dictation.

 When Dragon NaturallySpeaking recognizes what you said as a command, the Results box 
displays a bold blue border.

You can also anchor the Results box permanently in one place. From the Tools 
menu of the DragonBar, click Options, then click the View tab and enable the 
Anchor option.

Don’t worry about mistakes at this point; Dragon NaturallySpeaking improves as 
you use it.

Using Natural Punctuation

Dragon NaturallySpeaking can automatically add periods and commas at the 
appropriate places in your dictation without you having to explicitly speak that 
punctuation. The Natural Punctuation feature can be useful in helping you get 
used to dictation by focusing on what you are saying rather than how your speech is 
punctuated. 

Natural Punctuation inserts only periods and commas. You have to dictate other 
punctuation marks. Even with Natural Punctuation turned on, you can still dictate 
periods and commas. As you become more adept at dictation and want more control 
over where punctuation appears, you may want to explicitly dictate all your 
punctuation.

 You can turn Natural Punctuation on and off by voice by saying "autopunctuation on" and 
"autopunctuation off" or by selecting Options from the Tools menu of the DragonBar and clicking 
"Automatically add commas and periods" on the Formatting tab.

For more information on Natural Punctuation see “Using Natural Punctuation” on 
page 91.

NOTE

NOTE
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Dictating punctuation
You can dictate punctuation at any time while you are using Dragon 
NaturallySpeaking, even when Natural Punctuation is enabled. 

Use the following list as a guide to dictating the most common punctuation marks. 
(For a complete list of punctuation, see the online help.)

Starting new lines and paragraph
While you are dictating, you can use the following commands to duplicate the action 
of pressing the Enter key once (to add a new line) or twice (to add a new paragraph).

Saying "New Paragraph" presses the Enter key twice and capitalizes the next word you dictate.

Tips for dictating text
■ To erase the last thing you said, say "Scratch That." 

■ You can repeat "Scratch That" to undo a sequence of phrases. 

■ To undo the effects of a command, say "Undo That." If “Undo That” fails to 
undo an action, try repeating the command until you completely undo the 
operation.

■ To stop a recognition in progress (and turn the microphone off), click the small 
red button inside the Results box. 

■ You can change the very last phrase you spoke by saying "Bold That," "Cap 
That," "Correct That," and so on; you do not have to select the text first. 

■ To remove a trailing space after a word, you can say "Delete Previous 
Character." 

■ You can create a spoken form for words you prefer not to say aloud. For 
example, you can create a command that types "Snookums" whenever you say 
"Mary's nickname." 

TO ENTER SAY (US/Canada) SAY (Other Dialec ts )

, comma comma

. period full stop

! exclamation point or 
exclamation mark

exclamation mark

? question mark question mark

- hyphen hyphen

: colon colon

TO SAY 

Add a new line "New Line" 

Add a new paragraph "New Paragraph" 
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■ To clear (deselect) your last selection, say "Unselect That." 

For information on correcting any mistakes, see Chapter 5, “Correcting and 
Editing.”

Printing and saving your dictated text

Printing
From the File menu of your word processor, use the mouse to choose Print. Or say 
“Click File,” pause, and say “Print.” You can also simply say, “Print Document” or 
“Print File” if the Natural Language Commands are enabled. See “Commands 
Options” on page 179. Also see “Using the Command Browser” on page 103.

Saving
From the File menu, choose Save. You can also say “Click File” and then say “Save.” 
Remember, you have to pause between the “Click File” and the “Save” commands 
to have Dragon NaturallySpeaking recognize them as two separate commands. If 
the Natural Language Commands have been enabled, you can say “Save Document.”

Getting Help
To access the online Help for Dragon NaturallySpeaking, click the Help menu on 
the DragonBar and choose Help Topics. Alternately, you can say “Give Me Help.” 
You can print individual Help topics with the Print button in the Help window. To 
open the online Help links, just say their names. The links will be displayed next to 
the application window and will give you examples of the most common commands 
that work in the application you are currently using. 

“What Can I Say?”
Saying “What Can I Say?” will bring up the Sample Commands window. The 
Sample Command window displays a small selection of useful commands that 
Dragon NaturallySpeaking recognizes for the current context, whether it is a 
particular program you are using or the Windows desktop.

To open the Sample Command Window
Choose Sample Commands from the Help menu on the DragonBar or say “What can 
I say”. The Sample Commands window opens, displaying a selection of commands 
next to the window you are working in.
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If you want to see additional commands that are available to you, click Command 
Browser at the top of the Sample Commands window. The Command Browser is 
described in more detail on page 103.

Notes

■ A list of Global commands (available everywhere) appears if there are no sample 
commands available for a specific program. 

■ Commands marked with an asterisk (*) are available only if the Enable Natural 
Language Commands check box is selected on the Startup/Shutdown tab of the 
Options dialog box. 

Tutorial
To start the Tutorial, choose Tutorial from the Help menu on the DragonBar. The 
Tutorial includes a number of lessons covering the basics of Dragon 
NaturallySpeaking.

Troubleshooting
If you are having problems using Dragon NaturallySpeaking, or if you are getting 
unexpected results, please refer to the “Resolving Problems” and “Tips” section of 
the online help.

The contents of the 
Sample Commands 
window change 
depending upon what 
application is currently 
active.

For example, when you 
switch between Microsoft 
Word and Microsoft 
Outlook, the contents of 
the Sample Commands 
window changes 
accordingly
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The DragonBar

The DragonBar gives you access to Dragon NaturallySpeaking functions and 
features.

The Sound menu and the Extras toolbar is available only in Preferred and higher 
editions.

Microphone button and volume display
When the microphone is on, the Volume Display shows the sound level. Yellow 
means silence or that your speaking too softly, green means you are speaking at a 
proper level, and red means you are speaking to loudly.

Extras toolbar (Preferred and higher editions)
If present in your edition, you can click the Extras button  on the far right of the 
DragonBar to open the Extras toolbar. The Extras toolbar displays buttons for hand-
held recorder transcription and playing back your dictation.

Correction
Clicking the Correction button opens the Correction menu to teach the computer 
what you said. See Chapter 5, “Correcting and Editing.”

Transcribe 
Use this button to transcribe your speech from a handheld recorder. See Chapter 13, 
“Using Portable Recorders (Preferred and Professional).”

Start Playback, Fast Playback, and Stop Playback 
When you select text and click the Start Playback button, you hear a recording of 
your dictation. A yellow arrow displays on your screen during playback, following 
what you said. Click the Fast Playback button to play the recording at a faster 
speed. Click the Start Playback button to return to a normal speed. Click the Stop 
Playback button to stop the recorded speech playback.

Microphone Menus Status Extras
position

Change

Volume display

Correction

Start Playback Skip ForwardStop Playback

Fast Playback Skip Back Transcribe
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Skip Back and Skip Forward
Use these buttons to skip backward or forward one utterance. To Dragon 
NaturallySpeaking, an utterance is a group of words said together without pausing. 
The Extras menu items can be displayed in the main DragonBar. See “View 
options” on page 180.

Changing the DragonBar position
To change the position of the DragonBar, click the Dragon icon at the far left of the 
DragonBar. A menu displays which lets you move the DragonBar as follows:

 You can also hide the DragonBar by saying “Switch to Tray Icon Only Mode.” To make a 
hidden DragonBar reappear, right-click on the small microphone in the lower right corner of the screen. 
From the menu that appears, click Restore Previous DragonBar Mode.

Controlling Dragon NaturallySpeaking with voice commands
You can operate Dragon NaturallySpeaking with voice commands. For example, to 
show the Extras toolbar, say “Show Extras Bar.” For a list of other voice commands 
that control Dragon NaturallySpeaking, see “Controlling the DragonBar” in the 
online help.

Using QuickStart
The Dragon NaturallySpeaking QuickStart taskbar tray icon gives you quick access 
to Dragon NaturallySpeaking and recent users. Right-clicking the QuickStart icon 
displays the QuickStart menu.

 This option is installed at the end of Dragon NaturallySpeaking Setup process. 

Enabling QuickStart

By enabling QuickStart, Dragon NaturallySpeaking launches automatically at 
system startup time and adds the Dragon NaturallySpeaking icon to the Windows 
taskbar.

SELECT... TO...

Docked to Top mode (default) lock the DragonBar to the top of the screen

Docked to Bottom mode lock the DragonBar to the bottom of the screen

Floating mode freely position the DragonBar

Cling mode make the DragonBar appear just above the window 
into which you are dictating.

Tray Icon Only mode  hide the DragonBar completely and only display 
the Microphone icon in the Windows task bar.

NOTE

NOTE
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There are two ways to enable QuickStart:

■ During installation. The final installation screen includes the option to enable 
QuickStart.

■ From the Options dialog box. From the Tools menu on the DragonBar, click 
options and then click the Startup/Shutdown tab. To enable QuickStart, select 
“Launch in QuickStart mode on Windows startup.” See page 25 for more 
information.

Shutting off QuickStart
To permanently disable QuickStart, de-select it from the Startup/Shutdown tab of 
the Options dialog box. 

Temporarily Disabling QuickStart
To temporarily disable QuickStart, right-click the QuickStart taskbar tray icon    
and select “Exit NaturallySpeaking QuickStart.” This removes the QuickStart 
taskbar tray icon from the Windows taskbar. When you re-start Windows, the 
QuickStart taskbar tray icon re-displays. You can also re-start QuickStart without re-
starting Windows by selecting Start->Programs->Startup->Dragon 
NaturallySpeaking.

Using QuickStart
You access QuickStart by right-clicking the QuickStart taskbar tray icon. This 
displays the QuickStart menu.

If the QuickStart icon becomes unavailable for any reason, you can always start the 
program from the Windows Start Menu.

SELECT... TO...

Start NaturallySpeaking Start NaturallySpeaking
If you have only one user defined, NaturallySpeaking 
opens with that user loaded. If you have more than one 
user, the Open User dialog box displays and 
NaturallySpeaking starts once you select a user to load. 

Open User… Display the Open User dialog box. Once you select (or 
create) a user, NaturallySpeaking starts.

Open Recent User Open a menu listing your most recently loaded users.

Help Open the Help menu

Close DragonBar Unload all users and closes the DragonBar

Exit NaturallySpeaking 
QuickStart

Remove the QuickStart taskbar tray icon from the 
Windows taskbar and closes NaturallySpeaking if it is 
currently running. You must re-start Windows to re-start 
the QuickStart feature.
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Dragon NaturallySpeaking Log Files, samples, and tools

You can view the NaturallySpeaking log file (dragon.log), the Dragon 
NaturallySpeaking setup files, and samples of structured commands from the 
Windows Start menu.

To view the:

■ NaturallySpeaking log file (dragon.log), select  Programs>Dragon 
NaturallySpeaking 8.0>Show Dragon Log from the Start menu.

■ NaturallySpeaking setup files (dgnsetup.log),  select  Programs>Dragon 
NaturallySpeaking 8.0>Show Setup Log from the Start menu.

■ Samples of structured commands, select  Programs>Dragon NaturallySpeaking 
8.0>Sample Commands from the Start menu. Professional editions only.

■ Tools, select  Programs>Dragon NaturallySpeaking 8.0>Dragon 
NaturallySpeaking Tools from the Start menu. Professional editions only. 

Note: If you are upgrading from NaturallySpeaking V6 or V7.0 to NaturallySpeaking V8 the upgrade 
initially creates a dragon.log file in same location as the relocated \Data and \Users directories (see the 
locations describe in “” on page ). This initial dragon.log is a log of the upgrade from V6 ot V7.0 to V8. 
Once you start using NaturallySpeaking V8, the dragon.log is maintained as described in the 
"Changed file locations" section and can be viewed using the new Dragon NaturallySpeaking Tools 
start menu choice.
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4

Working on your Desktop 

his chapter describes how to control almost everything on your computer with 
Dragon NaturallySpeaking voice commands. 

Programs, documents and folders
Using voice commands, you can start programs and open documents and folders 
that appear in your Start menu or desktop. 

You can’t start Dragon NaturallySpeaking by voice. However, you can automatically 
start Dragon NaturallySpeaking in sleep mode whenever you start Windows by 
selecting “Microphone on (asleep)” option in the Miscellaneous tab of the Options 
dialog box.  See “Miscellaneous options” on page 184 for more information. 

Starting a program
To start a program from the Start menu, say “Start” and then the name of the 
program exactly as it appears on the menu or submenu of the Start menu. You can 
also say the name displayed below the icon on your desktop. 

For example, to start Microsoft® Internet Explorer®, say “Start Internet Explorer.” 

Opening documents and folders from the Start menu
To open a document or folder from the Start menu, say “Start” and then the name 
of the document or folder exactly as it appears on the menu.

For example, to open a document named sales.doc, you could say “Start Sales dot 
doc.” To open a document named journal.wpd, you could say “Start journal dot w p 
d.”

T
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To open a document or folder from your Windows® desktop, just say “Start” and 
then the name below the icon. For example, to open a folder named “Projects,” say 
“Start Projects.”

Switching between open windows
You can switch between the windows you have open by saying “Switch to” and then 
say the name of the program or document window exactly as it appears in the title 
bar. 

For example, if Microsoft® Word® is running, you can switch to it by saying “Switch to 
Microsoft word.” 

You can also switch between open windows by saying “Switch to Previous Window” 
(same as pressing ALT+TAB) and “Switch to Next Window” (same as pressing 
ALT+SHIFT+TAB).

Opening and closing menus 
You can activate any menu by saying the menu name.

To open a menu:
1 Open a program window (for example, Microsoft® Word) and make it active.

SAY THIS TO 

Switch to Next Window Switch to the next application.

Switch to Previous Window Switch to the previous application.

Switch to Microsoft Word Make Microsoft® Word the active application.

Switch to (name of 
application)

Switch to the open application you specify. Say the 
name of the application as it appears in the title bar 
of the application window.

Say “Start Projects”
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Say the name of the menu you want to open (for example, say “File”). If the 
command does not work, try saying “Click” and then the name of the menu you 
want to open (for example, say “Click File”). 

2 In this example, the File menu should open. If the command doesn’t work (for 
example, if the word “click” is typed into your document), you may have 
paused in the middle of the command.

3 Say the name of a menu item to activate it (for example, say “Save”).

4 To close a menu, say “Cancel.”

 To open the Start menu, say “Click Start” or “Click Start Menu.”

 If commands are often typed into your document instead of recognized as commands, you 
can make Dragon NaturallySpeaking recognize commands only when they are preceded by saying 
“Click.” To do this, select the “Require ‘Click’ to select menu or control” check box on the Commands 
tab of the Options dialog box, described on page 184. 

Selecting buttons, tabs, and options
When Dragon NaturallySpeaking is running, you can select any button, check box, 
text box, or other dialog box option you see by saying it’s name. If that doesn’t 
work, say “Click” and then its name.

For example, to select a check box labeled “Toolbar,” say “Toolbar” or “Click 
Toolbar.” To clear the check box (deselect it), say its name again. 

Say “File or 
“Click File” 

Say “Save” 

TIP

NOTE

Say “Wrap to window” or 
“Click Wrap to window” 

Say 
“Toolbar” or 
“Click 
Toolbar” 
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You can select tabs by saying the name of the tab, alone or preceded by “Click.” In 
the dialog box pictured, you could say “Options” or “Click Options” to select the 
Options tab. You can also move between tabs by saying “Go to Next Tab” and “Go to 
Previous Tab.”

 In some programs, you may not be able to select dialog box items by saying their names. If 
this happens, the following method of selecting items may work: say “Tab Key” repeatedly to move to 
the item you want, then say “Press Space Bar” to select it. See also “Moving the mouse pointer and 
clicking the mouse,” on page 36.

Selecting icons on the desktop
You can use voice commands to select icons on the Windows® desktop.

To select an icon on the desktop:
1 Switch to the Windows® desktop. To do this by voice, minimize all open 

applications and place the mouse pointer over the desktop icon. Say “Mouse 
Click” to make the desktop active.

2 Say the name of the icon (for example, “My Computer”). Dragon 
NaturallySpeaking types the icon name and Windows® selects it.

3 To select another icon, say “Move” and then the direction (up, down, left, right) 
and number of icons (up to 20). 

For example, say “Move Right 1,” “Move Down 2,” or “Move Up 3.” 

After you select an icon, you can say “Press Enter” to start or open it and “Press Shift 
F10” to display its menu (as if you right-clicked the icon with the mouse.)

NOTE

Say “Move Right 1” 
to select My 
Briefcase

Say “Move Down 2” 
to select Recycle Bin

Say “My Computer” 
to select My 
Computer
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You can also use voice commands for these actions. See “Marking and dragging 
objects” on page 38.

Resizing and closing windows
To resize and close windows, say “Click” and then one of the following window 
commands:

 “Click” is NOT optional for the Control menu commands.

 If you have trouble getting Dragon NaturallySpeaking to recognize any of the window 
commands, you can open the Control menu by saying “Click Control Menu” and then say them. 

Scrolling in windows and list boxes
You can scroll vertically in a window (for example, an online Help window) or list 
box by saying “Move Down” and “Move Up” and then a number of scroll bar arrow 
clicks (up to 20). For example, say “Move Down 4” or “Move Up 10.” 

You can scroll horizontally by saying “Move Left” and “Move Right” and then a 
number of scroll bar arrow clicks (up to 20). For example, say “Move Left 10” or 
“Move Right 5.” 

SAY THIS TO 

Click Minimize or
Click Control Menu 
(pause) Minimize

Minimize the active window.

Click Maximize or
Click Control Menu 
(pause) Maximize

Maximize the active window.

Click Restore or
Click Control Menu 
(pause) Restore

Restore window to previous size.

Click Close or
Press ALT F4

Close the active program.

Press CTRL F4 Close the active document, not the whole 
program (works in many programs).

Click Start Menu or
Click Start or
Press CTRL ESC

Open the Windows® Start Menu.

NOTE

TIP
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Opening lists and making selections
You can activate any list box by saying the list box name.

To open a list box:
1 Say the name of the list box you want to open.

2 Say "Show Choices," "Drop List," or "Open List." The list box opens to show all 
the choices available in the list.

To make a selection from an open list
1 Say the full name of the selection. 

2 Say "Move Down" or "Move Up" and the number of places your selection is from 
the current selection. 

Pressing keyboard keys
You can activate Windows® menus and controls by pressing keys. With Dragon 
NaturallySpeaking you can “press” any key on your keyboard by voice. You can 
press letters, numbers, modifier keys (SHIFT, CTRL, and ALT), and so on. 

You can say “Press,” “Press Key,” or “Type”—all three voice commands work the same 
way.

 “Scratch That” will not erase keystrokes dictated with the Press Key commands. You must 
select the text by voice or mouse and delete it or say “Press Delete.”

Pressing letters
You can press any letter on your keyboard by saying “Press” and then the letter. 
When you’re pressing letters, you must say “Press” before each one. For example, to 
enter “txt,” say “Press t,” “Press x,” “Press t,” pausing between letters.

 You can also spell words using Spell mode. See “Switching Recognition Modes” on page 101 for 
more information.

For similar-sounding letters (such as b, d, and v), you can use the International 
Communications Alphabet to “spell” the letter keys, for example, “Press alpha” or 
“Press bravo” or say “Press d as in David,” and so on (you can also say “Press d for 

NOTE

TIP
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David,” and so on) as you would if you were spelling something to another person 
over the phone.

 You can say “Press c” or “Press Charlie” but you cannot say “Press Cathy” or “Press Carl.”

SAY THEN  

Press a

b 

any letter a–z or any international alphabet word alpha 
through zulu

a as in Albert/Alice/alpha

b as in Bill/Buffalo/bravo

c as in Cathy/Carl/Charlie

d as in David/daughter/delta

e as in Edgar/enter/echo

f as in Frank/fancy/foxtrot

g as in George/gopher/golf

h as in Henry/helmet/hotel

i as in Iris/Ireland/India

j as in John/justice/Juliet

k as in Karen/kitchen/kilo

l as in Larry/lemon/lima

m as in Mickey/magic/Mike

n as in Nancy/nobody/November

o as in Otto/over/Oscar

p as in Paul/people/papa

q as in Quentin/question/Quebec

r as in Robert/Rachel/Romeo

s as in Sam/Singapore/sierra

t as in Terry/Tyler/tango

u as in Ursula/unit/uniform

v as in Valerie/visit/Victor

w as in Wendy/wake/whiskey

x as in Xavier/Xerxes/xray

y as in Yolanda/Yvonne/yankee

z as in Zachary/zookeeper/zulu

(you can also say “for” instead of “as in”)

NOTE
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Capitalizing a letter
You can capitalize a letter by saying “Press Cap” and then the letter. 

For example, to enter “28K” say “twenty eight” and then “Press Cap K” (or “Press Cap 
K for Karen”).

Pressing numbers
You can press numbers (0 to 9) by saying “Press” and then the number. For example, 
say “Press 8.” 

Pressing key combinations
When you’re pressing keys, you can press any combination of the modifier keys 
(SHIFT, CTRL, and ALT) at the same time as another key, such as a letter. For 
example, you can say:

■ “Press Control Z” (undoes last action)

■ “Press Alt F” (opens File menu)

■ “Press Shift Tab” (moves backward through dialog box options)

 Dragon NaturallySpeaking ignores the command “Press Control Alt Delete” (the keyboard 
shortcut for restarting a computer).

Pressing function and numeric keypad keys
To press a function key (F1 to F12), say “Press Function” and then the name of the 
key. For example, say “Press Function 1” to bring up the online Help.

To press the keys on the numeric keypad, say “Press Keypad” and then the name of 
the key. For example, you can say “Press Keypad Minus” to press the keyboard 
shortcut that opens the Correction Menu. See the complete list below: 

SAY THEN

Press Keypad 1 

Keypad 9 (you can say any number from 0 to 9) 

All Dialects: Keypad Point (.) 
US/Canada: Keypad Period (.) 
Other Dialects: Keypad Full Stop (.) 

Keypad Slash (/) 

Keypad Asterisk (*) 

Keypad Minus (-) (opens the Correction menu)

NOTE
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 Num Lock must be on for the “Press Keypad” commands to work. You can say “Press Num 
Lock” to turn Num Lock on.

Pressing other keys
Here’s a list of other keys you can press by voice:

Keypad Plus (+) (turns the microphone on or off) 

Keypad Star (*) (opens the NaturallySpeaking menu on the 
DragonBar) 

Keypad Enter 

SAY THEN 

Press Up Arrow 

Down Arrow 

Right Arrow 

Left Arrow 

Home Key 

End Key 

Page Up 

Page Down 

Insert Key 

Delete Key 

Control Key 

Shift Key 

Alt Key 

Print Screen

Scroll Lock

Pause Key

Num Lock

Caps Lock

SAY THEN

NOTE
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Moving the mouse pointer and clicking 
the mouse

Dragon NaturallySpeaking provides hands-free mouse control with MouseGrid and 
the mouse motion voice commands. You can use these features to position the 
mouse pointer anywhere on the screen, click the mouse buttons, and drag objects—
all by voice.

Moving the mouse pointer with MouseGrid
You can position the mouse pointer anywhere on the screen by using MouseGrid. 
You can move the pointer relative to the full screen or the active window.

To use MouseGrid:
1 Say “MouseGrid” to place the MouseGrid over the full screen (as in this 

example) or say “MouseGrid Window” to place it over the active window. For 
example: 
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2 Say a grid number from 1 to 9 to position the pointer in that numbered area. In 
this example, to position the pointer over the Recycle Bin, say “4.” A smaller 
MouseGrid will appear in the chosen grid square. 

3 To zoom in over the desired area, say another grid number. In this example, say 
“4” to place the pointer over the Recycle Bin icon.

4 Continue to say the respective grid number to zoom in until the mouse pointer 
is over an icon or other object. You can use voice commands to click the mouse 
or mark and drag the object. See the following sections for instructions.

 You can undo the last MouseGrid action by saying “Undo That.” 

To close MouseGrid, say “Cancel.” 

Moving the pointer with the “Mouse” command
You can move the mouse pointer up, down, left, or right a short distance (a few 
millimeters) by using the mouse pointer commands.

You can combine moving the mouse pointer and clicking the mouse in a single 
voice command. For example, you can say “Mouse Up 3 Click” or “Mouse Right 2 
Double Click.” 

To move the pointer:
1 Say “Mouse” followed by the direction and number of times to move it (up to 

10). For example, say “Mouse Up 5” or “Mouse Left 10.” 

Say “4” to place 
a smaller 
MouseGrid over 
grid square 
number 4.

TIP



4 Working on your Desktop

Dragon NaturallySpeaking User’s Guide38

2 When the pointer is over an icon or other object, you can use voice commands to 
click the mouse or mark and drag the object.

Clicking the mouse
You can click, double-click, left-click, and right-click the mouse buttons by voice.

To click the mouse:
1 Position the mouse pointer over the object you want to select (for example, say 

“MouseGrid 9 1” or “Mouse 2”).

2 Say “Mouse Click,” “Mouse Double Click,” “Mouse Left Click,” or “Mouse Right 
Click.” 

When an object is selected, you can mark and drag the object (as described in the 
next section).

Marking and dragging objects
You can mark an object and drag it to a different location by voice. 

To mark and drag an object:
1 Position the mouse over the icon or object you want to drag and then say “Mark” 

(for example, say “MouseGrid 9 1 Mark”).

2 Move the mouse pointer to where you want to drag the object and then say 
“Drag” (for example, say “MouseGrid 6 3 Drag”).

 Instead of “Drag,” you can also say “Control Drag” and “Shift Drag” to drag while holding 
down the CTRL or SHIFT key.

Moving the pointer with the mouse motion commands
In addition to the mouse movement methods described above, you can also move 
the mouse by using the mouse motion commands. Say, for example, “Move Mouse 
Right.” The mouse pointer will begin moving to the right and will keep moving until 
you say “Stop.”

Enabling the mouse motion commands
To use the mouse motion commands:
1 From the Tools menu on the DragonBar, choose Options and then the 

Commands tab.

2 Select “Enable mouse motion commands” and click OK. 

TIP



4 Working on your Desktop

Dragon NaturallySpeaking User’s Guide 39

3 Click the Speed button to choose how fast the mouse pointer moves when you 
use a mouse motion command.

The mouse motion commands
Here is a summary of the available mouse motion commands.

While the mouse is moving, you can say any of the commands above. You can also 
say: 

■ “Stop” or “Cancel” to stop the mouse from moving

■ “Up,” “Down,” “Left,” “Right,” “Upper Left,” “Lower Left,” “Upper Right,” or 
“Lower Right” to change the direction in which the mouse is moving

■ “Faster,” “Much Faster,” Slower,” or “Much Slower” to change the speed at which 
the mouse is moving

■ “Click,” “Double Click, “Right Click,” or “Left Click” to click the mouse buttons

■ “Go to Sleep,” “Stop Listening,” or “Microphone Off” to turn the microphone off

To specify which mouse button (left, right, or center) is being held down during 
mouse drags or if you want the SHIFT, CTRL, or ALT key held down during the 
mouse drag, use one of these commands before saying one of the drag commands in 
the table above:

■ Left

■ Middle (requires a three-button mouse)

■ Right

■ Shift

■ Control

■ Alt

■ Right Shift

■ Right Control

■ Right Alt

SAY THEN A 

DIRECTION

THEN A SPEED 

(OPTIONAL)

Move Mouse
Mouse Move
Drag Mouse
Mouse Drag

Up
Down
Right
Left
Upper Left
Lower Left
Upper Right
Lower Right

Fast
Faster
Much Faster
Very Fast
Slow
Slower
Much Slower
Very Slow
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For example, to drag with the SHIFT key held down, you could say “Shift Mouse Drag 
Up.” To drag with the right ALT key held down (the ALT key on the right side of the 
keyboard), you could say “Right Alt Drag Mouse Upper Left.”
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5

Correcting and Editing

hen Dragon NaturallySpeaking types the wrong words, you should correct 
these mistakes. By giving the program the right word, you actually teach the 

program not to make the same mistakes again. 

Correcting mistakes requires some extra effort, but it saves you time in the long run 
by making Dragon NaturallySpeaking more accurate. You’ll probably need to 
correct mistakes often when you first start dictating, and then less frequently as the 
program learns from your corrections.

Make it a habit to correct mistakes to continue to improve the accuracy of the 
program. Make sure you save your speech files when prompted, to preserve the 
adjustments the program makes.

 You must select a word before typing over it. Using the backspace key and retyping (or saying 
“Scratch That”) will not enable the software to learn from corrections and improve recognition 
accuracy. For accuracy to improve, you must first select text and then correct it or overwrite it with the 
words you said.Mrs.

Correcting mistakes
There are a number of ways you can correct the misrecognitions in a document. The 
following techniques describe the most basic methods, but you can combine these 
techniques in any manner that suits your working style.

Correcting text with the keyboard
1 Move the insertion point to the beginning of the dictation you want to correct. 

2 Press the Correction hot key to display the Correction menu. By default, this is 
the minus (-) key on the numeric keypad. You can change the hot key 
assignment on the Hot keys tab of the Options dialog box. You can also click 
the Correction button on the Extras toolbar of the DragonBar. 

W

TIP
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3 If one of the alternatives is correct, press the Down Arrow key to highlight that 
choice and then press Enter to accept it. If no alternative is correct, just type or 
say the correct text. 

4 Continue until all the text is correct. 

Correcting text using voice commands 
1 Say "Select" or “Correct” and the text that is incorrect, the Correction menu 

appears with a number of alternatives. 

■ If one alternative is correct, say "Choose" and the number of that alternative. 

■ If none of the alternatives is correct, say "Spell That," spell the correct word or 
words into the Spell dialog box, and then say "OK." 

Selecting a large amount of text or an entire document and then saying “Spell 
That” can produce unpredictable results.

2 Verify that the correct text appears in the document in place of the 
misrecognized text and continue to the next misrecognition. 

Correcting text while playing back dictation (Preferred and 
higher editions)
1 Move the insertion point to the beginning of the dictation you want to correct. 

2 Click Play That Back on the Sound menu of the DragonBar or click the Start 
Playback button on the Extras toolbar. You can also say, “Play that back”.

3 When the playback of your dictation reaches a recognition error, press the 
correction hot key. By default, this is the minus (-) key on the numeric keypad.

4 If one of the alternatives is correct, press the Down Arrow key to highlight that 
choice and then press Enter to accept it. If no alternative is correct, just type or 
say the correct text and press the Correction hot key again. Playback will 
continue automatically from the point where you stopped. 

5 Continue until all the text is correct. 
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Using the Correction menu
The Correction menu shows Dragon NaturallySpeaking’s best guess of the 
alternatives to the words you dictated and selected. 

In the following example, Dragon NaturallySpeaking heard the word “quick” as 
“clinic.”

In this example, you would choose the correct word from the Correction menu by 
saying “Choose” and the number next to your choice.

 You can change the number of choices displayed to you. In the Options dialog box, click the 
Correction tab and increase the number in “Show no more than n choices.” If you want to display your 
choices without the Correction menu taking up too much space on the screen, select the “Show only the 
choices” option. See “Correction options” on page 178.

When the Correction menu list appears, you can also choose to:

■ spell the word (in this example, say “Spell That q-u-i-c-k”). Selecting a large 
amount of text and then saying “Spell That” can produce unpredictable results.

■ Pressing the Correction hot key (-) while the Correction menu is open will 
display the Spell Dialog box.

■ listen to a recording of what you just said (say “Play That Back”)

■ capitalize it (say “Cap That,” in this example, to get “Clinic”)

■ say “Unselect That” to cancel the selection and close (dismiss) the Correction 
menu

■ ignore the Correction list and keep dictating (in the example above, just say 
“quick,” which replaces the selected text)

Say “Choose 2” to 
replace “clinic” with 
“quick.”

You can also say 
“Spell That” to spell a 
word or “Cap That” 
to capitalize it.

TIP
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 If you prefer not to see the Correction menu every time you select text by voice, you can turn it 
off. In the Options dialog box, click the Correction tab to display the Correction options, then clear the 
check box “‘Select’ commands bring up Correction menu.” 

To help you quickly find the alternative you want, the recognition choices in the 
Correction menu appear in boldface where they differ from the word you’ve 
selected. (This is only applicable when you’ve selected more than one word at a 
time.)

If you select any leading or trailing spaces (including paragraph marks) along with 
the text you want to correct, choosing one of the alternatives in the Correction menu 
deletes those leading and trailing spaces. 

Correcting Punctuation
Note the following when correcting punctuation:

■ When you select a phrase (more than one word) that has punctuation, make sure 
to dictate that punctuation. For example, say you initially dictated, "Today is 
Thursday I have a meeting at 11 o'clock" and the text was transcribed as "Today 
is Thursday, I have a meeting at 11 o'clock." If you want to change the comma to 
a period, say "Select Thursday comma". If the correct punctuation appears in the 
Correction menu, select it. Otherwise you can dictate over the selection, for 
example by saying "Thursday period".

■ When you select punctuation, the Correction menu may include alternate 
punctuation. For example:

TIP

The words that are 
different from the 
selection appear in 
bold, to help you find 
the correct alternative 
quickly. 



5 Correcting and Editing

Dragon NaturallySpeaking User’s Guide 45

■ If Natural Punctuation is turned on, when you select a phrase that has 
punctuation added by NaturallySpeaking, the choices will include punctuation 
changes. For example:

 When you select a word that has adjacent punctuation added by the Natural Punctuation 
feature, the selection will extend to include that punctuation.

Selecting text by voice

Using Select-and-Say®

You can revise your dictation without correcting it by selecting the text using the 
“Select” command and then saying new words to replace the selected text. 

To use Select-and-Say®:
1 Dictate the sentence below:

US/Canada: Let’s meet for lunch on Tuesday [period]

Other Dialects: Let’s meet for lunch on Tuesday [full stop]

2 Say “Select lunch on Tuesday.” The words “lunch on Tuesday” should be 
highlighted on the screen.

3 Say “dinner on Wednesday.” These words should replace “lunch on Tuesday.” 

Since “Tuesday” and “Wednesday” sound completely different, Dragon 
NaturallySpeaking will know you are not correcting a recognition mistake but rather 
revising your dictated text. 

 You can also select punctuation marks.

4 Say: “Select period” (US/Canada) or “Select full stop” (Other Dialects). If there’s 
more than one period or full stop, you can say “Select Again” to select a different 
one.

NOTE

TIP
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5 To replace the period or full stop with an exclamation mark, say “exclamation 
mark.” 

 It is often easier for Dragon NaturallySpeaking to find the matching text if you select a short 
phrase rather than individual words. If you select some words that are already correct, just say them 
again along with the ones you want to change.

Selecting the same text again 
If the words you’re trying to select appear more than once on the screen and Dragon 
NaturallySpeaking selects the wrong ones, just say “Select Again.” The program then 
looks for another instance of the same word or words.

You can also say “Select Again” if Dragon NaturallySpeaking selects a word that 
sounds like the word you want, but is not the correct one (for example, “two” 
instead of “too”).

Unselecting words 
If the wrong text is selected, say “Unselect That.” 

You can also “unselect” words by moving your insertion point (by mouse or voice) to 
another part of your document. For example, say “Go to End of Line” or click 
somewhere else in your document. 

Selecting a longer phrase 

You can select a longer phrase by saying “Select [text] Through [text]” (US/Canada) or 
“Select [text] To [text]” (Other Dialects). For [text], substitute the actual word or words 
at the beginning and the end of the range of wrong words. For example, you could 
correct the underlined words in the following sentence:

With a little practice, who will develop a habit of dictating an unclear, steady voice, 
and the computer will understand you better.

by saying:

(US/Canada) “Select who Through unclear” or “Select who will Through an unclear”

(Other Dialects) “Select who To unclear” or “Select who will To an unclear”

Then dictate the correct text:

“you will develop the habit of dictating in a clear”

The final corrected sentence reads:

TIP
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With a little practice, you will develop the habit of dictating in a clear, steady voice, 
and the computer will understand you better.

 If you’re correcting more than one word, the words must all be in sequence (next to each 
other). You can’t use a single command to correct words that are in different parts of your document.

Selecting your whole document 
To select all the text in your document, say “Select Document” or “Select All.” This 
command is useful when you want to change the font or the way text is aligned.

When you want to copy all the text in a document to another window, the easiest 
way to do it is with the “Copy All to Clipboard” command. 

 When a lot of text is selected, the “Scratch That” and “Cut That” commands don’t work, nor 
can you overwrite the selection by dictating new text. This prevents you from accidentally deleting a 
large part of your document. To remove a large selection, you can say “Delete That” instead.

Selecting an entire paragraph or line 
You can select the current paragraph by saying “Select Paragraph.” To select the 
current line, say “Select Line.”

You can also select a number of paragraphs or lines (up to 20). For example, you can 
say “Select Previous 5 Paragraphs.”  

Selecting a word or character  
You can select the current word by saying “Select Word.” To select a character, say 
“Select Next Character” or “Select Previous Character.” 

You can also select a number of words or characters (up to 20). For example, say 
“Select Previous 2 Words.”  

SAY THEN THEN

Select Next Paragraph

Previous 2...20 Paragraphs

Forward Line

Back 2.20 Lines

Last

SAY THEN THEN

Select Next Word

Previous 2...20 Words

NOTE

NOTE
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Moving around in a document 
When you’re editing a document, you can move around in it by voice. After you 
place the insertion point where you want it, you can dictate more text, select text, 
copy and paste, or apply formatting.

Going to the top or bottom of a page or document 
You can move to the top or bottom of the current page by saying “Page Up” 
(equivalent to pressing the PAGE UP key) or “Page Down” (equivalent to pressing the 
PAGE DOWN key).

You can move to the top or bottom of your document by saying “Go to Top” or “Go to 
Bottom.”

Going to the beginning or end of a line 
You can move to the beginning or end of the current line by saying “Go to Beginning 
of Line” or “Go to End of Line.” 

Forward Character

Back 2...20 Characters

Last

SAY THEN

Go to Top

Move to Bottom

Top of Document

Beginning of Document

Start of Document

Bottom of Document

End of Document

SAY THEN

Go to Beginning of Line

Move to Start of Line

End of Line

SAY THEN THEN
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Placing the insertion point before or after a specific word 
You can place the insertion point before a specific word by saying “Insert Before” and 
then the word or words. You can place the insertion point after a word by saying 
“Insert After” and then the word or words.

After you move the insertion point where you want it, you can dictate more text, 
paste text, add punctuation, and so on.

To place the insertion point before a specific word:
To move the insertion point before the word “lets” in the sentence below, say 
“Insert Before lets” (or “Insert Before lets me talk”). Remember not to pause between 
any of the words.

Dragon NaturallySpeaking lets me talk instead of type.

To place the insertion point after a specific word:
To move the insertion point after the word “talk” in the sentence below, say “Insert 
After talk” (or “Insert After lets me talk”).

Dragon NaturallySpeaking lets me talk  instead of type.

Moving up or down a paragraph or line 
You can move up or down a paragraph by saying “Move Up a Paragraph” or “Move 
Down a Paragraph.” You can also move up and down a number of paragraphs (up to 
20). For example, you can say “Move Up 3 Paragraphs.” 

You can move up or down a line by saying “Move Up a Line” or “Move Down a Line.” 
You can also move up and down a number of lines (up to 20). For example, you can 
say “Move Down 3 Lines.”:

Moving right or left a word or character 
You can move to the right or left of a word by saying “Move Right a Word” or “Move 
Left a Word.” You can also move right or left a number of words (up to 20). For 
example, you can say “Move Right 3 Words.” 

You can move to the next or previous character by saying “Move Right a Character” or 
“Move Left a Character.” You can also move forward and backward a number of 

SAY THEN THEN

Move Up a Paragraph or 1 Paragraph

Back 2...20 Paragraphs

Down a Line or 1 Line

Forward 2...20 Lines
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characters (up to 20). For example, you can say “Move Left 4 Characters” or “Move 
Back 6 Characters.”

Copying, cutting, and pasting text
You can move text from one place to another by using the “Copy That,” “Cut That,” 
and “Paste That” commands. 

To copy, cut, or paste text:
1 Select the text you want to copy or cut.

2 Say “Copy That” or “Cut That.”

3 Move the insertion point to where you want to paste the text.

4 Say “Paste That.”

Deleting text

Deleting the last words you dictated 
You can erase the last words you dictated by saying “Scratch That.” When you say 
this command, Dragon NaturallySpeaking deletes the last thing it typed into your 
document. This may be a full sentence, a phrase, or just one word, if that’s all you 
said before pausing.

You can say “Scratch That” up to 10 times to delete the last few things you said. If 
you repeat the command, you must pause before saying it again. You can also say, for 
example, “Scratch That 5 Times.”

Going back as you dictate 
When you’re dictating, sometimes you may hesitate or think of a better way to say 
something right after you’ve said it. When this happens, you can use the “Resume 
With” command to return to where you were before the mistake.

SAY THEN THEN

Move Right a Word or 1 Word

Forward 2...20 Words

Left a Character or 1 Character

Back 2...20 Characters
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Just say “Resume With” followed immediately by the word or words to which you 
want to return. Then, continue dictating. Any text after the new position of the 
insertion point will be replaced with your new dictation.

 When using the “Resume With” command, remember not to pause in the middle. Say 
“Resume With” and then immediately say the words to which you want to return. These words must be 
in the last three or four sentences (100 characters) you said; you can’t use “Resume With” to return to 
an earlier part of your document.

To go back as you dictate:
1 Suppose you dictate this sentence: “I have a deadline this week, but we could meet 

for lunch… um… er… next Wednesday.”

2 To correct the sentence, return to the last correct words you remember 
dictating. For example, say “Resume With meet for lunch.” (Remember not to 
pause in the middle.)

3 Then, dictate the rest of the sentence. For example, say “next Wednesday at 
noon.”

Deleting specific words 
You can delete text by selecting it and saying “Delete That.” 

To delete text:
1 Select the text you want to delete.

2 Say “Delete That.” 

You can also say “Scratch That” to do the same thing.

Deleting the next or previous paragraph or line 
You can delete the next or previous paragraph by saying “Delete Next Paragraph” or 
“Delete Previous Paragraph.” You can delete the next or previous line by saying 
“Delete Next Line” or “Delete Previous Line.” 

You can also delete a number of paragraphs or lines (up to 20). For example, you can 
say “Delete Previous 5 Paragraphs.” See the complete list below: 

SAY THEN THEN

Delete Next Paragraph

Previous 2...20 Paragraphs

NOTE
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Deleting the next or previous word or character 
You can delete the next or previous word by saying “Delete Next Word” or “Delete 
Previous Word.” You can delete the next or previous character by saying “Delete Next 
Character” or “Delete Previous Character.” 

You can also delete a number of words or characters (up to 20). For example, you can 
say “Delete Previous 5 Words.” See the complete list below: 

 Another way to delete the previous character is by saying “Backspace.” This is equivalent to 
pressing the BACKSPACE key. You can “press” it multiple times (up to 20) by saying, for example, 
“Backspace 5.”

Spelling as you dictate
With the Spell command in Dragon NaturallySpeaking, you can easily spell a word 
or phrase you want to dictate into your document. This can be useful if you are 
dictating a word that is not likely to be in the Dragon NaturallySpeaking vocabulary, 
such as a proprietary term, a proper name, or a non-English word. Say, for example, 
“Spell b-u-o-n space g-i-o-r-n-o.” The word you spelled appears right in your 
document. 

You must say “Cap” if the word contains a capital letter. For example, say “Spell Cap 
R-u-m-p-e-l-s-t-i-l-s-k-i-n” to type “Rumpelstilskin.”

Forward Line

Back 2...20 Lines

Last

SAY THEN THEN

Delete Next Word

Forward 2...20 Words

Previous Character

Back 2...20 Characters

Last 2...20 Characters

SAY THEN THEN

NOTE
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If you say “Spell” by itself, without any letters after it, the Spell dialog box opens.

You can then speak the letters and Dragon NaturallySpeaking will type them or you 
can correct any errors in the word you spelled. 

When spelling, you can say numbers and special characters as well as letters. For 
example, to dictate an automobile license plate number, you could say “Spell y-h-m-
6-0-9.” Dragon NaturallySpeaking would type “yhm609.” Say “Spell Cap-m-a-c-m-i-
l-l-a-n-trademark” to get “MacMillan™” in your document.

Spelling a word adds that word to the active vocabulary. Words that contain 
numbers are not added to the vocabulary.

 To dictate unusual text such as automobile license plate numbers or product codes, you can also 
switch to Spell mode by saying “Switch To Spell Mode,” and then dictate letters.

You can make the Spell dialog box appear whenever you use the Spell command by 
setting the “Spell” commands bring up the Spell dialog box option on the Correction tab 
in the Options dialog box. See page 177 for more information. 

You can also access the Spell dialog box when using the "Select" or “Correct” 
commands.

For a list of how to spell special characters, see the Spelling topic in the online 
Help.

TIP
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Playing back your dictation 
(Preferred and higher)

Playback commands work in the DragonPad, Microsoft Word 97, 2000, 2002 and 
2003, Corel WordPerfect 8 and 9, and Lotus Notes.

Although Dragon NaturallySpeaking never makes a spelling mistake, the mistakes it 
does make can be challenging to find and fix. Sometimes, what the program types 
looks very different from what you actually said.

To make correcting mistakes easier, Dragon NaturallySpeaking records your voice 
as you dictate. You can play back your voice whenever you cannot tell by looking at 
your document what you originally said.

 Unless you have Dragon NaturallySpeaking Professional or a higher edition, playback is 
available only until you close a document. After you close a document, Dragon NaturallySpeaking 
deletes the recorded dictation for that document. See page 56 for information on saving dictation for 
later correction (Professional and higher editions).

Playing back dictation from the Correction menu
When you’re working in the Correction menu, click the Play Back button or say 
“Play That Back” to play the dictation that goes with the words you’re correcting. 
Then edit the text to match what you said.

You can set up Dragon NaturallySpeaking to play back dictation automatically 
whenever you open the Correction menu. On the NaturallySpeaking menu, select 
Tools>Options>Correction tab. On the Correction tab, select “Automatic playback 
on correction.”

Sometimes, there’s no dictation to play back. For example, you cannot play back 
text that wasn’t entered by voice, such as words you typed or pasted into your 
document. 

 Even when you have entered text by voice, you cannot play it back after you have cut it, 
copied it, pasted it, or otherwise moved it around in the document.

If you have Dragon Naturally Speaking Professional or a higher edition, you can save 
your dictation with your document for later playback (see “Dictate now, correct 
later” on page 56). Otherwise, you cannot play back dictation after closing a 
document. 

NOTE

NOTE
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If dictation is not available, the Play Back button is dimmed (grayed out). When 
playback is not available, you may find text-to-speech useful for checking your 
work. See “Using text-to-speech” on page 58.

Playing back dictation in a document
To help you check your work for mistakes, you can play back a line, a paragraph, a 
selection, or the whole document. After playback starts, you can stop it as soon as 
you notice a mistake and automatically open the Correction menu.

The Playback toolbar is an extra section of the DragonBar that is normally hidden. 
To see the Playback toolbar, click the double chevron icon on the DragonBar to 
open the Extras toolbar (Preferred and higher editions).

To play back dictation:
To play back dictation, do any of the following:

■ Select the text you want to play back, and say “Play That Back.” 

■ Click the Start Playback button on the Playback toolbar. 

■ Move the insertion point to the text you want to play back and say any of the 
following commands:

To stop playback:
To stop playback, do any of the following:

■ Click the Stop Playback button on the Playback toolbar.

■ Click anywhere in the document window. 

■ Press the ESC key.

SAY TO

Play Back Line Play back dictation for the current line.

Play Back Paragraph Play back dictation for the current paragraph.

Play Back Document Play back dictation for the whole document.

Play Back Window Play back dictation for the text in view.

Play Back to Here Play back dictation from the top of the document 
window to the insertion point.

Play Back from Here Play back dictation from the insertion point to the 
bottom of the document window.

Correction

Start Playback Skip ForwardStop Playback

Fast Playback Skip Back Transcribe
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(It’s not possible to stop playback by voice, because the computer cannot hear 
speech input when it’s playing back dictation.)

To skip backward or forward:
You can skip backward or forward in your document by a few words by clicking the 
Skip Backward and Skip Forward buttons. 

To stop playback and correct a mistake:
To stop playback and correct a mistake, do any of the following:

■ Click the Correction button on the Playback toolbar.

■ Press the minus (-) key on the numeric keypad. 

This stops playback and simultaneously opens the Correction menu. There you can 
correct the text for the last phrase played back.

 By default, Dragon NaturallySpeaking stores about 30 minutes of dictation (40 MB). If you 
want to be able to store more dictation, you can change the amount of disk space that’s set aside for 
storing it. On the Tools menu, click Options, and then click the Data tab. Increase the number in the 
“Disk space reserved for playback” box.

Dictate now, correct later
When you dictate into the DragonPad, you can save your dictation with your text so 
either you or someone else can correct it later. You must create and edit your file in 
the DragonPad to be able to play back dictation. This feature is available in Dragon 
NaturallySpeaking Professional and higher editions.

You can save dictation with your document if you select the Save recorded dictation 
with document box on the Data tab of the Options dialog. The first time you save a 
document in DragonPad during an editing session, Dragon NaturallySpeaking asks 
you whether you want to save your speech data. If you save your speech data, you 
can reopen the document at a later time and play back your dictation. If you do not 
save your speech data, your dictation is stored only during the current editing 
session.

Correcting your own dictation
If you save your dictation, you can open your file later and play back and correct the 
text as if you had just dictated it.

Correcting someone else's dictation
You can play back someone else's dictation and correct the text to match the 
dictation. You can do this in two ways: 

■ You can correct the dictation using your user files. 

■ You can correct the dictation using the document author's user files. 

NOTE
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Correcting with your user files
You should use this correction technique if you regularly correct another person's 
text by voice and it is not important to maximize the author's recognition accuracy.

When you use your user files, you can correct the dictation just as you would correct 
your own dictation, using any combination of voice commands and keyboard typing. 
Even though you are correcting someone else's dictation, your work won't reduce 
recognition accuracy for either you or the person who dictated the text. But your 
corrections to the other person's dictation won't improve recognition either.

Correcting with the document author's user files
You should use this correction technique if you do not need to correct by voice and 
it is important to maximize the author's recognition accuracy. 

 This technique works if all work is done on a single computer. Consult your Dragon 
NaturallySpeaking reseller about ways to dictate on one computer and correct on another.

If you correct dictation using the author’s user files, you must not correct by voice, 
or you may reduce that person’s recognition accuracy. You can, however, improve 
the author’s recognition accuracy if you make corrections by using the keyboard and 
mouse with the Correction Menu. See the following procedure for details. 

To correct using someone else's user files:
1 Make sure you are not wearing the microphone headset, or that the microphone 

is not turned on or plugged in. This will ensure that you don't accidentally 
reduce the accuracy of someone else's user files by using your voice. 

2 Make sure the DragonPad Extras toolbar is displayed so you can see the 
playback command buttons. 

3 Open the user files of the person whose text you will correct. 

4 In DragonPad, open the document to correct. 

5 Use the buttons on the Extras toolbar to play back dictation. 

6 Select the text you want to correct by mouse or keyboard. 

7 Press the correction hot key (normally the minus [-] key on the numeric key 
pad) or click the Correct button on the DragonBar Extras toolbar. The 
Correction Menu appears with the selected text. 

8 Use the keyboard to correct the text. 

9 Save the text and the user's speech files when you are done. 

TIP
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Using text-to-speech
Text-to-speech is available in Dragon NaturallySpeaking Preferred and higher 
editions. 

You can use text-to-speech to have text on your screen (not your current dictation) 
read aloud in a computer voice. For example, you can have a document that you (or 
someone else) dictated read back while you listen for mistakes and sections you may 
want to revise.

Text-to-speech is available only in the DragonPad, Microsoft Word, and Corel 
WordPerfect. You can, however, copy and paste text from other programs and then 
use text-to-speech.

To start text-to-speech:
To start text-to-speech, do any of the following:

■ Select the text you want to hear (a line, a paragraph, and so on), and then say 
“Read That.”

■ Select the text you want to hear, and then select Read That from the Advanced 
submenu (or right-click in your document and click Read That from the 
shortcut menu).

■ Move the insertion point to the text you want to hear and say any of the 
following commands:

To stop text-to-speech:
To stop text-to-speech, do any of the following:

■ From the NaturallySpeaking menu, point to Advanced and click Stop Playback/
Reading.

■ Right-click in your document and click Stop Playback/Reading from the 
shortcut menu.

■ Press the ESC key.

SAY TO

Read Line Read back the current line.

Read Paragraph Read back the current paragraph.

Read Document Read back the whole document.

Read Window Read back the text in view.

Read to Here Read back from the top of the document window to the 
insertion point.

Read from Here Read back from the insertion point to the bottom of the 
document window.
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You can control the speed, pitch, volume, and other text-to-speech settings. From 
the Tools menu, click Options>Text-to-Speech Tab

Notes on correcting with another author’s user files

This technique works if all work is done on a single computer. Consult your Dragon 
NaturallySpeaking reseller about ways to dictate on one computer and correct on 
another. 

To display the DragonBar Extras toolbar, click the double chevron icon  on the 
DragonBar. You cannot display the Extras toolbar if the DragonBar is in cling 
mode. 

In the Correction Menu, you can use the mouse or keyboard to select any of the 
commands displayed below the correction choices. For example, you can click 
“Spell That” to open the Spell dialog box and spell the word. 

You may want to select the following on the Correction tab of the Options dialog 
box: 

■ “Correct” command brings up Correction menu 

■ Automatic playback on correction box 

With these settings, Dragon NaturallySpeaking will automatically play back the 
author's dictation for each text selection you correct. The Correction Menu does not 
play back dictation.

When you correct someone else's dictation, make sure that the amount of disk space 
you have reserved for storing dictation is at least as large as the amount allocated for 
the user that created the text. You allocate the disk space on the Data tab of the 
Options dialog box. 

Saving dictation with documents can take up a lot of disk space, typically more than 
a megabyte per minute of dictation. To save this space, delete any dictation you no 
longer need. Dragon NaturallySpeaking saves dictation in a file with the same name 
as the document, but with the extension .dra. For example, if you dictate a 
document called MyDoc.rtf and save your dictation, Dragon NaturallySpeaking 
saves your dictation in a file called MyDoc.dra in the same directory as your 
document. 
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6

Formatting

ou can bold text, change font sizes and styles, capitalize text, and apply other 
formatting by voice.

Many Dragon NaturallySpeaking formatting commands work for text that is 
selected (highlighted) in your document. To select text by voice, say “Select” plus 
the words you want to select. See “Selecting text by voice” on page 45 for 
information.

 You can change the formatting properties of a word (such as whether Dragon 
NaturallySpeaking should type a space before or after the word, or whether the word is capitalized in 
a title) by using the Word Properties dialog box, described in “Changing word properties” on page 
128.

Capitalizing text

Capitalizing the first letter of the next word you dictate 
Dragon NaturallySpeaking capitalizes many words automatically. It capitalizes the 
first word in a sentence (following a period, question mark, or exclamation mark). It 
capitalizes the first word after you say “New Paragraph” (though not when you say 
“New Line”) and it capitalizes proper names (when these words are already in the 
Dragon NaturallySpeaking vocabulary in capitalized form).

 You can change the spacing and capitalization rules for a word in the Word Properties 
dialog box. See “Changing word properties“ on page 128 for more information.

Types of commands
Most of the commands listed in this chapter are global—they are available in 
virtually every application. In addition to the global commands listed here, 
Dragon NaturallySpeaking includes many commands for editing and 
formatting that work in common applications. For more information on 
finding these commands see page 103.

Y

NOTE

NOTE
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When you’re dictating, you can capitalize words that aren’t automatically capitalized 
by saying “Cap” and then the word. For example, say “Cap zelda” to get “Zelda.”

 If saying “Cap <word>” doesn’t work, try say “Cap Next <word>.”

 To dictate the word “cap,” for example, in this sentence: “The company is putting a cap on 
salary increases,” you must say “the company is putting a” then say “Spell c-a-p,” and then say “on 
salary increases.” In this way, Dragon NaturallySpeaking knows that you do not want to capitalize any 
of the words within the sentence.

Capitalizing consecutive words 
When you want to capitalize consecutive words (for example, if you’re dictating a 
book title), you can turn capitals on and then turn them off when you’re finished. 
This is usually easier than saying “Cap” before each word. Another way to do 
consecutive capitalization is to dictate the words, pause, and then say “Capitalize 
That” or “Cap That.”

To capitalize consecutive words:
1 Say “Caps On” to turn capitals on.

 When “Caps On” is active, Dragon NaturallySpeaking uses title case. This means it 
capitalizes all words except for articles and prepositions (such as “the” and “to”).

2 Dictate the words you want capitalized. For example, say: “success is a journey 
[colon] seven steps to achieving success in the business of life”

Dragon NaturallySpeaking types: “Success Is a Journey: Seven Steps to 
Achieving Success in the Business of Life”

3 Say “Caps Off” to turn capitals off.

Dictating the next word in all capital letters 
When you’re dictating, you can enter a word in all capital letters by saying “All Caps” 
and then the word. 

For example, say “All Caps please” to get “PLEASE.”

TIP

TIP

NOTE
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Dictating consecutive words in all capital letters 
When you want to dictate consecutive words in all capitals, you can turn all capitals 
on and then turn them off when you’ve finished.

To dictate consecutive words in all capitals:
1 Say “All Caps On” to turn all capitals on (like pressing the CAPS LOCK key).

2 Dictate the words that you want to appear in all caps. For example, say “the 
end”. Dragon NaturallySpeaking types “THE END”

3 Say “All Caps Off” to turn all capitals off.

Dictating the next word in all lowercase letters 
When you’re dictating, you can enter a word in all lowercase letters by saying “No 
Caps” and then the word.

For example, say “No Caps Jennifer” to get “jennifer.” (Dragon NaturallySpeaking 
normally capitalizes this and other proper names.) 

Dictating consecutive words in all lowercase letters 
When you want to dictate consecutive words in lowercase letters (for example, 
names of computer files or e-mail addresses), you can turn the “no capitals” feature 
on and then turn it off when you are finished. This is usually easier than saying “No 
Caps” before each word.

To dictate consecutive words in all lowercase letters:
1 Say “No Caps On” to turn no capitals on.

2 Dictate the words you want to appear in all lowercase.

3 Say “No Caps Off” to turn no capitals off.

Capitalizing (or uncapitalizing) text already in your document 
You can change the capitalization of text already in your document by selecting it 
and then saying “Capitalize That,” “Cap That,” or “All Caps That,” or “Uncapitalize 
That,” “Uncap That,” or “No Caps That.”

To capitalize or uncapitalize text:
1 Select the text you want to change.

2 Say “Capitalize That,” “Cap That,” or “All Caps That,” or “Uncapitalize That,” 
“Uncap That,” or “No Caps That.”
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Formatting text
You can use voice commands to specify any combination of font name, size, and 
style, in that order. These commands change text you dictate from then on or text 
you have selected. 

To set a new style for text you are about to dictate, use the “Set Font” and “Set Size” 
commands. To change the style of text you have already selected, use the “Format 
That” command.

Changing the font as you dictate 
While dictating, you can change the font face, size, and style by saying “Set Font” 
followed by the font attributes you want. For example, you can say “Set Font Times” 
or “Set Font Arial 12 Bold.” When you continue dictating, the new text appears with 
the font attributes you set.

Changing font face

Changing font size
Say “Set Size” and then a size from 4 to 100 points. For example, say “Set Size 18.” 
Then, continue dictating.

SAY THEN

Set Font Arial

Courier

Courier New

Garamond

Helvetica

Palatino

Times

Times New Roman
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Changing font style

Changing a combination of font face, size, and style
Say “Set Font” and then the attributes you want (listed in the previous sections). 
You can specify any combination of font face, size, and style, but you must specify 
these attributes in that order (font face, then size, then style). See the list of 
examples below:

■ “Set Font Arial” 

■ “Set Font Arial 12” or “Set Font Arial 12 Point” 

■ “Set Size 12 Bold” 

■ “Set Font Arial Bold” 

■ “Set Font Bold” 

 If you’re changing only the font size, use the “Set Size” commands, not the “Set Font” 
command.

Changing the font later
You can go back and change the font face, size, or style of text by selecting it and 
then using the “Format That” commands. “Format That” works on selected text 
with the same combinations of font face, size, and style as the “Set Font” commands 
(see the tables in the previous section.)

To change the font:
1 Select the text you want to change.

2 Say “Format That” and then the font attributes you want to apply as described 
in the previous section. For example, say “Format that Arial 18.”

SAY THEN

Set Font Bold 

Italics 

Bold Italics

Underline 

Strikeout

Plain or Plain Text or Normal or Regular

NOTE
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Bold, italics, and underlining 
You can apply formatting to text in your document by selecting it and then saying 
“Bold That,” “Italicize That,” or “Underline That.” You can also say “Strikeout That.”

To add bold, italics, and underlining:
1 Select the text you want to change.

2 Say “Bold That,” “Italicize That,” Underline That,” or “Strikeout That.”

To remove formatting:
1 Select the text you want to change.

2 Say “Restore That” to remove formatting. 

Aligning text
You can change how text is aligned by placing your insertion point in the text and 
saying “Center That,” “Left Align That,” or “Right Align That.”

To align text:
1 Move the insertion point to the text you want to align.

2 Say “Center That,” “Left Align That,” or “Right Align That.” 

You can also use the following commands on selected text: “Format That Centered,” 
“Format That Left Aligned,” and “Format That Right Aligned.”

Bulleted text
To add bullets to text, place your insertion point in the text and say “Format that 
Bullet Style.” To remove bullets, say “Format that Bullet Style” again.
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7

Working with Applications

his chapter describes using Dragon NaturallySpeaking with most popular e-
mail programs, Microsoft® Internet Explorer, Microsoft® Word, and Microsoft® 
Excel. 

For information on using Microsoft® Powerpoint and Microsoft® InfoPath, see the 
online help.

Working with e-mail
Dragon NaturallySpeaking contains built-in commands for the following e-mail 
applications:

■ America Online® versions 8 and 9. Only one version of version 9is supported. 
Please check our Web site for the correct version information:
www.ScanSoft.com/NaturallySpeaking/support/

■ Microsoft® Outlook® versions 2000, XP, and 2003 (Professional and higher 
editions)

■ Microsoft® Outlook® Express versions 5 and 6 (Professional and higher editions)

■ Lotus® Notes® 5, 6, and 7(Professional and higher editions)

What can I say?
Saying “What Can I Say?” will bring up the Sample Commands window. 
The Sample Command window displays a small selection of useful 
commands that Dragon NaturallySpeaking recognizes for the current 
context, whether it is a particular program you are using or the Windows 
desktop.

For more information, see “What Can I Say?” on page 21.

T
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The e-mail commands described in this chapter are designed to work in these four 
applications. To use them, make sure Dragon NaturallySpeaking and your e-mail 
application are both running.

 If you use Microsoft® Outlook®, Outlook® Express, or Lotus® Notes®, you can add the contact 
names in your address book to your vocabulary, which improves accuracy when you dictate these 
names. You can also have Dragon NaturallySpeaking automatically scan your sent e-mail messages so 
it can better learn your writing style. For instructions on how to do this, see “Increase accuracy from e-
mail” on page 123.

Checking for new e-mail
To check for new mail, say “Check For New Mail” or “Check For E-Mail.” You must be 
connected to the Internet to check your e-mail.

 You can say “Mail,” “Message,” “Memo,” or “E-Mail” interchangeably in any of the e-mail 
commands.

Opening and closing e-mail
To open an e-mail message, select it and say “Open Mail” or “Open That.” To close 
an open message, say “Close Mail.”

 You can also move to the message and select it by “pressing” function and arrow keys by voice 
(see “Pressing keyboard keys” on page 32) or using the mouse movement commands (see page 36).

Composing e-mail
To compose a new message, say “New Mail” or “New Message.” Once the new blank 
message appears, you can navigate to any field by voice and start dictating.

If you use a different e-mail program
If you use an e-mail application that is not listed above, you can still 
compose, edit, and send e-mail using the global (use anywhere) commands 
described in “Working on your Desktop” on page 27.

TIP

TIP

TIP
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To navigate e-mail fields:

To dictate an e-mail message:
1 Say “New Mail.” The new message opens on your screen.

2 Say “Go to To Field.” Pause (to make sure you are in the correct field), then 
dictate the recipient’s e-mail address, for example, “jeff at a-o-l dot com.” If you 
are entering more than one address, separate each one by saying “semicolon” or 
“comma”; depending on your application.

3 Say “Go to CC Field” or “Go to BCC Field,” pause, and dictate the addresses of 
the people who should receive copies or blind copies of your message 
(optional).

 In many e-mail programs, you can also say just “Subject” or “BCC” to move to the 
respective field by that name.

4 Say “Go to Subject Field,” pause, and dictate the subject of your message, for 
example, “Planning a trip to see you.”

5 Say “Go to Body Field,” pause, and begin dictating the body of your message. 

 For instructions on dictating e-mail addresses and Web URLs, see “Dictating e-mail and Web 
addresses” on page 96.

Sending and printing e-mail
Once your message is ready to send, you can simply say “Send Mail” to send your e-
mail on its way. To print a message, say “Print Mail” and the message will be sent to 
your printer.

Forwarding and replying to e-mail

To forward a message selected in your Inbox, simply say “Forward Mail,” then 
dictate the recipient’s address in the To Field of the new message.

SAY THEN

Go to or To Field

Move to CC Field

BCC Field

Body Field

First Field

Last Field

Next Field

TIP

TIP
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Select a message and say “Reply to Mail” to create a new message addressed to the 
sender. To reply to everyone on the mailing list, say “Reply To All.” Then move to 
the Body Field and dictate your reply.

Deleting mail
You can delete the currently selected message by saying “Delete Mail.” This 
command will work on all selected messages, so make sure you have selected only 
those you want to delete.

 If you use Microsoft® Word as your e-mail editor in Microsoft® Outlook®, some e-mail 
commands will not work when viewing or editing a e-mail message. In addition, you cannot select 
menu items by voice in the e-mail message window with Microsoft® Word as your default editor.

Working with Microsoft Internet Explorer
You can use Dragon NaturallySpeaking to control Microsoft® Internet Explorer® and 
browse the Web by voice. Just say the name of a link to click on it. To use this 
feature, you must have Microsoft® Internet Explorer® version 5.0 or later installed.

You can use voice commands to:

■ Go to any Web page on the Favorites menu

■ Enter a Web address (URL) in the Address bar

■ Go back to the previous Web page or forward to the next

■ Click links, buttons, and images

■ Scroll in a Web page

■ Select check boxes and other options

■ Enter text in a text box (such as a Search box)

To use Microsoft® Internet Explorer® by voice, simply start Microsoft® Internet 
Explorer® while Dragon NaturallySpeaking is running. To start Microsoft® Internet 
Explorer® ‘‘by voice, say “Start Internet Explorer.”

 Any program that embeds the Microsoft® Internet Explorer® application, such as the Dragon 
NaturallySpeaking online Help, can also be used by voice.

Going to favorite Web pages 
You can use voice commands to go to any Web site saved in your Favorites list by 
saying “Click Favorites” to displays the Favorites menu. Once the Favorites menu is 
displayed, simply say the site name exactly as it appears in the Favorites menu. 

NOTE

NOTE
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 If Dragon NaturallySpeaking misunderstands your command and opens the wrong page, you 
can return to where you were by saying “Go Back.”

To add a page to the Favorites menu:
1 Go to the page you want to add to the Favorites menu.

2 Say “Click Favorites” to open the Favorites menu.

3 Say “Add to Favorites” to open the Add Favorites dialog box.

4 Type or dictate a name for the page. Select a short name, so it will be easy to 
open the page by voice.

5 Save the page anywhere on the Favorites menu.

6 Click OK or say “Click OK” to close the Add Favorites dialog box.

Entering a Web address in the Address bar 
You can dictate Web addresses (URLs) by saying “Go to Address.” Follow these 
steps.

To enter a Web address:
1 Say “Go to Address” to move to the Address bar.

2 Dictate the Web address (for example, say “w w w dot company dot com”). Most 
URLs are not case sensitive, but you may need to say “Cap” if the Web address 
contains capital letters. For more information about dictating Web addresses, 
see “Dictating e-mail and Web addresses” on page 96.

3 Say “Go There” to open the page (same as pressing the ENTER key).

 You can also say “Click Go” instead of “Go There.”

Going back to the previous Web page or forward to the next
You can Say “Go Back” or “Go Forward” to do the same the Back and Forward 
buttons do in Internet Explorer.

TIP

Address bar

TIP
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Here’s a list of all the voice commands you can use to control the Microsoft® Internet 
Explorer® toolbar. 

Entering text in a text box 
When Dragon NaturallySpeaking is running, you can dictate text into Search boxes 
and other text boxes on a Web page.

To enter text in a text box:
1 Say “Type Text” to move to the first text box on the page.

 You can also say “Edit Box” or “Text Field” instead of “Type Text.”

2 If the page has more than one text box, they will be numbered like this . (See 
the following procedures for examples.) Choose the number you want, or move 
to the next or previous text box by saying “Next” or “Previous.”

3 When the insertion point is in a text box, you can dictate text. 

In text boxes, you can also correct recognition mistakes by voice, just as you do when 
you’re dictating into a document.

Clicking links, buttons, and images 
You can click the text links and buttons on a Web page simply by saying the link or 
button name. 

If the text link or button name is long, you don’t need to say all of it. Just say enough 
to distinguish it from other links on the page.

SAY TO

Go To Address Move the insertion point to the Address box.

Click Go or
Go There

Go to the Web address in the Address box.

Go Back Go back to the previous Web page (same as clicking the Back 
button).

Go Forward Go forward to the next Web page (same as clicking the 
Forward button).

Stop Loading Stop a Web page from loading (same as clicking the Stop 
button).

Refresh or Reload Refresh the current Web page (same as clicking the Refresh 
button).

Go Home Go to your home page (same as clicking the Home button).

TIP
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To click a text link:
1 Say the text link (it must be visible on the screen). For example, to click the 

link Finance and Budget on the Web page pictured below, say “Finance and 
Budget.”

2 An arrow appears briefly to indicate which link was selected and then the 
page opens.

 You can also say “Click” and then the link text. For example, you could say “Click News 
and Events.” Sometimes saying “Click” first is more reliable than just saying the link text alone.

3 If more than one link matches what you said (for example, if there are two links 
on the page that contain the word “Internship”), Dragon NaturallySpeaking 
numbers all the links on the page like this .

4 Say “Choose” plus the number of the link you want. For example, say “Choose 
2.” 

 On secure Web pages this feature is disabled. You cannot select links on secure pages by 
voice.

TIP

Say “Choose 1” 
to click the first 
link containing 
“Internship,” or 
say “Choose 2” 
to choose the 
second link.

NOTE
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To click an image:
1 When you say “Image” (or “Click Image”), Dragon NaturallySpeaking numbers 

all the images on the page like this .

2 Click the image you want by saying, for example, “Choose 3.”

 If Dragon NaturallySpeaking misunderstands your command and opens the wrong page, you 
can return to where you were by saying “Go Back.”

To click a button:
Say the button name. For example, to click the button pictured below, say “Search.”

You can also say “Click” and then the button name. For example, you could say 
“Click Search” (or “Click Search Button”). 

To unselect the button, you must select a different one.

To click a check box, list box, or radio (option) button:
1 Say “Check Box,” “List Box,” or “Radio Button” to number the buttons like this 

. Then choose the number you want, as in the previous procedure.

Some Web pages, 
like this one, display 
text as graphic 
images. When you 
say “Image,” Dragon 
NaturallySpeaking 
numbers each 
image.

To click the “Travel 
resources” link, say 
“Choose 10.” To 
click the Spanish 
flag, say “Choose 
13.”

TIP
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Here is a table of commands you can use for clicking links, images, check boxes, 
lists, and buttons.

Frames and panes
When you’re viewing a Web page that uses frames, say “Next Frame” or “Previous 
Frame” to move between the different frames.

To move between different Microsoft® Internet Explorer® panes, say “Next Pane” or 
“Previous Pane.” Panes are different windows within the Microsoft® Internet 
Explorer® application, such as “Search” and “Tip of the Day.”

Scrolling in a Web page 
When Dragon NaturallySpeaking is running, you can scroll in a Web page by voice. 
You can use voice commands to go to the top or bottom of a page or to move up or 
down a screen or line at a time.

SAY TO

Type Text or Edit Box Go to the first place on a Web page where you can 
enter text.

Click Check Box or Check 
Box

Number all check boxes on the page and go to the first 
one. 

Click Image or Image Number all images with links on the page and go to 
the first one.

Choose 2 Select the image, option, button, and so on from the 
numbered list of choices. You can say any number that 
appears in the list.

Click Radio Button/Radio 
Button

Number all option (radio) buttons on the page and go 
to the first one.

Click List Box or List Box Number all boxes with a list of choices (drop-down 
lists) on the page and go to the first one. 

Show Choices Open a list of choices.

Hide Choices Close a list of choices.

Choose Thursday or 
Thursday

Choose an entry from a list of choices, in this example, 
Thursday. 

Show Choices or Drop List 
or Open List 

Opens the list box to show all the choices available in 
the list.
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You can also start automatic scrolling by saying “Start Scrolling Down” or “Start 
Scrolling Up.” Automatic scrolling is convenient when you want to read a Web page 
without using the mouse or keyboard. See the complete list of commands below:

While a Web page is scrolling, you can click by voice the text links and buttons you 
see if the page is moving slowly enough. The page will continue to scroll, however, 
unless you say “Stop Scrolling” before saying the link.

Working with Microsoft Word
Dragon NaturallySpeaking contains built-in commands for Microsoft® Word 2000, 
XP, and 2003.

Dragon NaturallySpeaking provides a large number of commands that work with 
different versions of Microsoft Word. Since the number of valid commands is so 
large, you should just try saying what you want to do. If you get unexpected results, 
say "Undo That" to undo the action and try a different way to say the command. 
Alternatively, you can open the Command Browser or the sample command window 

SAY TO

Go to Bottom Scroll to the end of the Web page.

Go to Top Scroll to the beginning of the Web page.

Page Down Scroll down one screen (same as pressing the Page 
Down key).

Page Up Scroll up one screen (same as pressing the Page Up 
key).

Line Down Scroll down one line (same as clicking the down arrow 
in the scroll bar once).

Line Up Scroll up one line (same as clicking the up arrow in the 
scroll bar once).

Start Scrolling Down Start automatic scrolling toward the end of the page.

Start Scrolling Up Start automatic scrolling toward the beginning of the 
page.

Speed Up Increase scrolling speed. (Say it again to speed up 
more.)

Slow Down Decrease scrolling speed. (Say it again to slow down 
more.)

Stop Scrolling Stop automatic scrolling.
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For more information. The Command Browser is described in more detail on page 
103.

Creating, opening, and closing a document
You can use the following voice commands to perform basic document operations 
using Microsoft Word:

Using other word processing programs
Dragon NaturallySpeaking works with other popular word processing 
programs other than Microsoft Word, for example Corel WordPerfect. 

As with Microsoft Word, you should just try saying what you want to do; you 
can always say "Undo That." NaturallySpeaking has built-in commands that 
work with Corel WordPerfect as well as “global” commands that work in all 
applications. You can also use the Command Browser for more information 
on these commands; for more information see “Using the Command 
Browser” on page 103.

TO SAY

Start Microsoft Word Start Microsoft Word

Create a new document Create New File
or 
Open New File

Open an existing document Open File
or
"<file name> dot <file extension>", for 
example, "My Document Dot Doc". 
or
Click Open

Save a document as a .doc file Save Changes 
You may need to dictate a file name if this is 
the first time the file has been saved.
Click Save

Close a document Close File
or
Close Document
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Selecting text 

You can use the following voice commands to select text in Microsoft Word

For more information on selecting text, see “Correcting and Editing” on page41.

Formatting text 

You can use the following voice commands to format text in Microsoft Word:

TO DO THE FOLLOWING

Select a word, line, or 
paragraph

Move the insertion point to the word, line, or 
paragraph you want to select and say, "Select 
Word/Line/Paragraph." 

Select an adjacent word, line 
or paragraph

Move the insertion point to either before or after 
the word, line, or paragraph you want to select 
and say, "Select Next/Previous Word/Line/
Paragraph." 

TO SAY

Change text properties Set Word/Line/Paragraph to Strikeout 
or
Underline this Word/Line/Paragraph 
or
Italicize Next <number> Words 
or
Bold This Page 

Change font properties Turn on Bold and Italics
or
Format That Regular
or
Unitalicise That

Change font name and point 
sizes

Set the Font to Twenty Four Points Times in the 
Word/Line/Paragraph
or
Increase/Decrease the Font Size to Eighteen or
Points in the Word/Line/Paragraph
or
Set the Font to Courier in the Selection/Word/
Line/Paragraph/Page/Section/Document
or
Decrease Selection by Two Points



7 Working with Applications

Dragon NaturallySpeaking User’s Guide 79

Working with tables

You can use the following voice commands to work with tables in Microsoft Word:

Create and delete bullet points or 
list numbers

Set the paragraph to Bulleted/Numbered
or
Delete Bullets From the Document
or
Unnumber the Selection

TO DO THE FOLLOWING

Create a table Move the insertion point to the location where you 
want to create a table 
Say "Add a Table" 
or
Create a <number of rows and columns> Table, for 
example, "Create a Five by Seven Table"

Add rows and columns Say: Add a New Row/Column 
or
Add <number> Rows/Columns, for example, "Add 
Three Columns"

Delete rows and columns Delete the <ordinal number> Column, for example, 
"Delete the Third Column" 
or
"Delete this Column"

Move by cells, columns, 
rows, or tables

Right/Left/Up/Down <number> Columns 
or
Right/Left/Up/Down <number> Rows
or
Go Right/Left/Up/Down <number> Rows
or
<number> rows to the Right/Left/Up/Down 
or
Go To Last/First Cell/Row/Column 
or
Go To Next/Previous Table

TO SAY
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Working with Microsoft Excel 
(Preferred and higher)

Dragon NaturallySpeaking contains built-in commands for Microsoft® Excel 2000, 
XP, and 2003.

You can use Select-and-Say commands and built-in commands to enter and revise 
content and to navigate between cells in Microsoft Excel. For more information on 
using Select-and-Say, see “Selecting text by voice” on page 45.

 Dragon NaturallySpeaking provides a large number of commands to use with Microsoft 
Excel. Because the number of valid commands is so large, you should just try saying what you want to 
do. If you get unexpected results, say "Undo That" to undo the action and try a different way to speak 
the command. Alternatively, you can open the Command Browser or the sample command window for 
more information. The Command Browser is described in more detail on page 103.

Dictation and Editing Modes
There are two modes for using voice commands in Microsoft Excel. The two modes 
are described below.

Dragon Quick Edit Mode
Quick Edit Mode allows you to enter new content into a cell, overwrite the current 
contents of a cell, or format the entire contents of a cell. When you select a cell and 
begin dictating, a yellow background appears to indicate that the dictated text will 
be inserted into the cell. If the cell currently contains text, the new dictated text will 
overwrite the existing text. If you want to format the contents of a cell, select the 
cell, or select a portion of the cell’s contents using Select-and-Say commands, and 
say a formatting command, such as “Set Font Arial 10 Point Bold”. Line and 
Paragraph commands, such as “New Line” or “Move Left 3 Rows” change the focus to 
another cell in Quick Edit Mode.

Dragon Full Edit Mode
Full Edit Mode allows you to edit the existing contents of a cell. If you want to add 
to or edit the current contents of a cell, select the cell and say “Edit Cell” or “Press 
F2” to open the cell for editing. When you enter Full Edit Mode, the background 
color changes to blue. Entering Full Edit Mode is analogous to double-clicking a 
cell. Line and Paragraph commands, such as “New Line” operate within the selected 
cell in Full Edit mode. 

Using Select-and-Say
In general, Select-and-Say is available in cells except when you type something into 
a cell before you dictate and when you enter Full Edit Mode. For example:

NOTE
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■ If you dictate into a cell, then type some characters, and dictate more text into 
that cell, Select-and-Say is available.

■ If you type at the beginning of a cell and dictate some text or numbers, Select-
and-Say is not available. 

■ Once you have edited a cell using any combination of typing and dictation, 
when you move back to that cell by voice, Select-and-Say is available in the 
entire cell.

Moving Around a Worksheet
You can use the following commands to navigate between cells in a worksheet:

 If column letters are not being recognized correctly, try using the alpha-bravo version of the 
letters, as in “Move to Cell Alpha 3”.

Editing and Formatting Content
Use the following commands to format a worksheet and the text and numbers you 
enter. The following commands are samples. Other commands that use similar 

COMMAND FUNCTION

Press Left, Right, Up, Down 
or Move Left, Right, Up, 
Down

Move to the next cell. If you are currently editing 
the cell, saying any of these commands completes 
the cell entry and moves to the next cell. If the cell 
is open for editing, these commands move the 
cursor within that cell. You can also add a number 
to any of these commands, as in “Move Down 3 
Rows”.

Next/Previous Row/Column Move to the next or previous row or column.

Start of Row/Column Move to the first cell in a row or column.

Row, Column, Row/Column 
coordinates

Move to the specified row or column. For example, 
“Column H”. Move to a cell defined by a column 
and a row. For example, “Column D, Row 30” or 
“D 30”.

New Line Move down one cell in Quick Edit mode. Move to 
new line within the current cell in Full Edit Mode.

Create New Worksheet, 
Workbook

Add a new worksheet or workbook.

Apply Complete a cell entry and stay in the cell.

Press Enter Complete a cell entry and move down one cell.

Press Escape or 
Press Cancel

Cancel a cell entry and remain in the cell.

Open Excel Help View the Microsoft Excel online help.

TIP
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words should also work, such as saying “Make Row Height 5” in place of “Set Row 
Height 5”

 If the numbers you dictate are transcribed as words you can switch to Numbers Mode by 
saying “Numbers Mode On” or by choosing Numbers Mode from the Words menu on the DragonBar.

Performing Operations
Use the following commands to enter formulas and to perform other Microsoft Excel 
operations by voice. These commands are samples. Other commands that use similar 
words should also work.

COMMAND FUNCTION

Press F2, Edit Cell Switch to Full Edit Mode. The selected cell is opened 
for editing and the insertion point is placed at the 
end of the line.

Set Row Height, Column 
Width

Change the height of a column or the width of a 
row. For example, “Set Column Width to 5”.

Right/Left/Center Align Cell, 
Row, Column

Format the contents of the selection right aligned, left 
aligned or center aligned.

Color/Shade This Cell Open the Format Cell dialog box with the Patterns 
tab selected so you can choose a color.

Format This Cell, Row, 
Column

Open the Format Cell dialog box so you can make 
selections by voice.

Clear Cell/Row/Column Clear the contents of the specified region.

COMMAND FUNCTION

Average the selected cells Compute the average of the selected cells and enter 
the result in the selected cell.

Divide cell x by cell y Divide one cell by another. For example, “Divide cell 
A2 by A4”.

Multiply cell x by ten percent Multiply the contents of cell x by 10% and enter the 
result in the selected cell.

Compute <Formula> End 
Formula

Compute a formula. For example, “Compute Five 
Plus Seven Times Three End Formula.”

Recalculate Recalculate the formula in the selected cell and 
overwrite the existing value with the new value.

Sort This Column Ascending, 
Descending

Sort the selected column.

Hide/Unhide selection Hide or unhide a selection.

Lock/Unlock selection Lock or unlock a selection.

NOTE
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8

Dictating Names, Numbers, 
Punctuation & Special 
Characters

his chapter describes how to dictate numbers, punctuation, Web addresses, and 
a few other special items. For complete information on this topic, see the 

online help.

 If Dragon NaturallySpeaking is not formatting a word as you would like, you can change 
the formatting properties of the word by using the Word Properties dialog box. See “Changing word 
properties” on page 128.

Dictating numbers
In most cases you can dictate numbers, including postal codes, as you normally say 
them. Dragon NaturallySpeaking will display either a number (“3”) or the word 
(“three”), based on the context. To force recognition of digits as numerals instead of 
text without using the Numbers Mode, say "Numeral" before you say the digit, for 
example, say "Numeral Three" to get 3. When dictating numbers:

■ You can use or omit the word "and" as part of a number. For example, say "one 
hundred fifty" instead of "one hundred and fifty" to get the number 150. 

■ You can use "oh" and "zero" interchangeably to get 0. 

■ If you want a comma in a four-digit number, you must speak it explicitly. 
Numbers with five or more digits automatically include commas, with the 
exception of US ZIP codes. 

■ For a decimal point, say “point.”

 If you want to dictate only numbers, you can switch to “Numbers Mode.” See “Switching 
Recognition Modes” on page 101 for more information.

T
NOTE

TIP
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 If you are having problems dictating numbers, currency, times, or dates, make sure that your 
Regional Settings match the language (dialect) you selected when you created your user. 

Changing the format of a number
If Dragon NaturallySpeaking enters a number in a format you don’t want, you can 
use voice commands to convert it to a numeral or to spell it out. 

For example, you can change “seven dollars” to “$7” (US/Canada) or “seven 
pounds” to “£7” (Other Dialects) by saying “Format That Number.”

And you can change “$7” to “seven dollars” (US/Canada) or “£7” to “seven pounds” 
(Other Dialects) by saying “Format That Spelled Out.” 

TO ENTER SAY

1 one
numeral one

5 five
numeral five

17 seventeen

23 twenty three

179 one hundred seventy nine
one seventy nine

5423 five thousand four hundred and twenty three

5,423 five [comma] four twenty three

12,537 twelve thousand five hundred and thirty seven

142,015 one hundred and forty two thousand and fifteen

35.23 thirty five [point] two three

0.03 All Dialects: zero [point] zero three 
Outside US/Canada: nought [point] nought three

43.28% forty three [point] twenty eight [percent sign]

02460 oh two four six zero

02460-1458 oh two four six zero [hyphen] one four five eight

2 3/4 two and three fourths

11/32 eleven over thirty two

$99.50 ninety nine dollars and fifty cents

45.35 45 Euros and thirty-five cents

£120.35 pound sterling sign one hundred and twenty point thirty five 
[All Dialects]

NOTE
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These commands change the last number dictated or a selected number.

 The “Format That Number” and “Format That Spelled Out” commands work for numerals 
and currency, but not for dates, times of day, telephone numbers, and most fractions. 

Using Numbers Mode
Any time you need to dictate a series of numbers and do not want Dragon 
NaturallySpeaking to recognize them as words, you can turn on Numbers Mode. 
This could be useful, for example, if you are dictating in a spreadsheet program, 
such as Microsoft® Excel®.

To turn on Numbers Mode, say “Start Numbers Mode” or “Numbers Mode On.” To 
turn off Numbers Mode, say, “Stop Numbers Mode” or “Numbers Mode Off” or “Switch 
to Normal Mode.”

For more information on Numbers Mode and more ways to turn Numbers Mode on 
and off, see the section “Switching Recognition Modes” on page 101.

Dates 
You can dictate most dates the way you would normally say them. Say “oh” or “zero” 
to enter 0. In dialects other than US/Canada, you can also say “nought.”

SAY TO CHANGE

Format That Number one to 1
first to 1st
nineteenth to 19th
5 million to 5,000,000
five million to 5,000,000
eight dollars to $8 (US/Canada)
seven pounds to £7 (Other Dialects)

Format That Spelled Out 4th to fourth
27 to twenty-seven
5,000,000 to five million 

TO ENTER SAY

22 January 1999 twenty two January nineteen ninety nine

April 9, 2001 April 9 [comma] two thousand and one

14/07/85 fourteen [slash] oh seven [slash] eighty five

3/11/02 three [slash] eleven [slash] zero two

3/11/2002 three [slash] eleven [slash] two thousand and two

April 1st April first

March 22nd March twenty second

the 1980s the nineteen eighties

NOTE
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Times of day 

Dictate the time of day the way you would normally say it.

US/Canada: Dragon NaturallySpeaking automatically types the colon (:) if you say 
“a m” or “p m” when dictating the time. Say “o’clock” or “colon zero zero” to enter:00.

 Dragon NaturallySpeaking will recognize times more accurately if you say “numeric colon” 
instead of “colon” when dictating times.

Other Dialects: Dragon NaturallySpeaking automatically types the point (.) if you 
say “a m” or “p m” when dictating the time, depending on the regional setting. Say 
“o’clock” or “point zero zero” to enter .00.

 The format of “a.m.” and “p.m.” depends on your computer’s regional Windows® settings.

Telephone numbers 

North American phone numbers
Say US and Canadian phone numbers as you normally would, pausing briefly 
between each group of numbers.

TO ENTER SAY

8:30 eight [colon] thirty or eight [numeric colon] thirty

7:45 AM seven forty five a m

10:22 PM ten twenty two p m

3:00 three o’clock or three [colon] zero zero

5:00 PM five o’clock p m

TO ENTER SAY

8.30 eight [point] thirty

7.45 AM seven forty five a m

10.22 PM ten twenty two p m

3.00 three o’clock

5.00 PM five o’clock p m

TIP

NOTE
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You don’t need to dictate hyphens for most phone numbers (numbers that are 7, 10, 
or 11 digits long). Dragon NaturallySpeaking will add them automatically. 

Telephone numbers outside North America
To dictate other phone numbers, including European phone numbers, you must 
say all the punctuation, including the hyphens, spaces, and parentheses.

 In dialects other than US/Canada, you can say “bracket” instead of “parenthesis.”

Fractions 
You can dictate most common fractions the way you would normally say them. To 
dictate 1/2, 1/3, 1/4, 1/5, 1/6, 1/7, 1/8, 1/9, 1/10, and 1/16 or a multiple of these 
fractions, just say the fraction normally. 

TO ENTER SAY

965-5200 nine six five fifty two hundred

617-965-5200 six one seven nine six five fifty two oh oh

1-800-555-1212 one eight hundred five five five one two one two

(617) 965-5200 [open parenthesis] six one seven [close 
parenthesis] nine six five five two zero zero

1-212-555-1212 one two one two five five five one two one two 

TO ENTER SAY

(01628) 894150 [open parenthesis] oh one six two eight [close 
parenthesis] eight nine four one five oh

027 629 8944 oh two seven [space bar] six two nine [space 
bar] eight nine four four

61-7-4695-2055 six one [hyphen] seven [hyphen] four six nine 
five [hyphen] two zero five five

(65) 2778590 [open parenthesis] six five [close parenthesis] 
two seven seven eight five nine zero

TO ENTER SAY

1/2 one half

1/4 one fourth or one quarter

15/16 fifteen sixteenths or fifteen over sixteen

3 7/8 three and seven eighths or three and seven over eight

TIP
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If the denominator (bottom number in the fraction) is greater than 10, you can enter 
the fraction by saying “slash” or “over” between the two numbers.

A few common fractions can also be displayed on your computer as special characters 
(such as ¼, ½, or ¾) instead of two numbers separated by a slash character (such as 1/
4, 1/2, or 3/4). For information about dictating fraction characters, see “Dictating 
uncommon special characters” on page 98.

Roman numerals 
You can dictate Roman numerals by saying “Roman numeral” and the number. For 
large numbers, say the number in small combinations (as in the examples shown 
here).

 Don’t pause after the word “Roman Numeral” when you’re dictating a Roman numeral. If you 
pause, Dragon NaturallySpeaking may enter, for example, “Roman numeral three” instead of “III.”

Postal and ZIP Codes
Dragon NaturallySpeaking can automatically formats postal codes. This feature is 
controlled from the Formatting tab of the Options dialog box. For more information, 
see “Formatting options” on page 186. 

TO ENTER SAY

9/12 nine [slash] twelve or nine over twelve

5 3/56 five [space bar] three [slash] fifty six

130/70 one thirty over seventy

TO ENTER SAY

I Roman Numeral one

IV Roman Numeral four

V Roman Numeral five

X Roman Numeral ten

L Roman Numeral fifty

C Roman Numeral one hundred

D Roman Numeral five hundred

M Roman Numeral one thousand

XXIV Roman Numeral twenty our

XXXI Roman Numeral thirty one

MCMXCVII Roman Numeral one thousand
Roman Numeral nine hundred
Roman Numeral ninety
Roman Numeral seven

TIP
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US ZIP Codes
You can dictate US five-digit ZIP codes just as you dictate any group of numbers. 
When dictating nine-digit ZIP codes, you must say the hyphen.

UK and Canadian Postal Codes
You can dictate UK postcodes by saying “Postcode” followed by the letters and 
numbers that make up the postcode. For Canadian postal codes, say “Postal code” 
followed by the letters and numbers that make up the postal code. Spacing and 
formatting will happen automatically.

TO ENTER SAY

01886 oh one eight eight six

94704-1150 nine four seven oh four [hyphen] one one five oh

TO ENTER SAY

NG3 2HX Postcode n g three two h x

E10 7BD Postcode e ten seven b d

EC2Y 4LK Postcode e c two y four l k

K1A 0M5 Postal code k one a zero m five

X0A 0H0 Postal code x oh a oh h oh
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Currency and coin 
You can dictate your own currency as you would normally say it.

Currency in US/Canada (US English dialect) 

Currency in Other Dialects (UK, Australian, Indian, and Southeast Asian English) 

 Dragon NaturallySpeaking uses the currency symbol ($, £, and so on) specified in your 
Windows Regional Settings as your default currency.

Dictate other currencies by first saying the currency symbol followed by the digits.

US/Canada: If your Regional Settings are set to the United States or Canada, your 
default currency is $ (dollar). If you want to dictate a dollar currency amount, dictate 
it the way you normally do. If you want to dictate a pound sterling currency amount, 
say, for example, “pound sterling sign fifty eight” (to enter £ 58), and so on.

 In US/Canada, you must say “pound sterling sign” to enter £, since “pound sign” means # in the 
U.S. vocabulary. In all other dialects, you can say “pound sign” to type £.

Other Dialects: If your Regional Settings are set to the United Kingdom, your 
default currency is £ (pound sterling). If you want to dictate a pound sterling 

TO ENTER SAY

$58.00 fifty eight dollars and zero cents

$1.75 one dollar and seventy five cents

$5.25 five dollars and twenty five cents

$3.9 billion three point nine billion dollars

 45 forty five euros

 99.50 ninety-nine euros and five cents

£ 2.20 pound sterling sign two point two oh

£ 5 million pound sterling sign five million

TO ENTER SAY

$58.00 dollar sign fifty eight

$1.75 dollar sign one point seventy five

 4.25 four euros and twenty five cents

 3.9 billion three point nine billion euros

£ 45 forty five pounds

£ 99.50 ninety nine pounds and fifty pence

£ 2.20 two pounds twenty

£ 5 million five million pounds

NOTE

TIP
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currency amount, dictate it the way you normally do. If you want to dictate a dollar 
currency amount, say, for example, “dollar sign fifty eight” (to enter $58) and so on.

 Australian users can say “fifty eight dollars” to dictate $58, since the Australian default 
currency is $ in Windows Regional Settings. 

Punctuation

Using Natural Punctuation

Dragon NaturallySpeaking can automatically add commas and periods at the 
appropriate places in your dictation without your having to explicitly speak that 
punctuation. This Natural Punctuation feature can be useful in helping you get 
used to dictation by focusing on what you are saying rather than how your speech is 
punctuated. 

Natural Punctuation only inserts periods and commas. You still have to dictate other 
punctuation marks. Even with Natural Punctuation turned on, you can still dictate 
periods and commas. As you become more adept at dictation and want more control 
over where punctuation appears, you may want to explicitly dictate all your 
punctuation.

For information on correcting punctuation, see Correcting Punctuation on page 44.

 Periods will only appear at the end of a sentence once you have started the next utterance or 
said "New Line" or "New Paragraph"

Enabling and disabling automatic punctuation

Natural Punctuation is turned on by default.

There are two ways of turning Natural Punctuation on and off:

1 Select Options from the Tools menu of the DragonBar and click "Automatically 
add commas and periods" on the Formatting tab. For more information on this, 
see page 186.

2 By saying "autopunctuation on" and "autopunctuation off". Turning Natural 
Punctuation on and off by voice sets the option on the Formatting tab listed 
above. If your disable Natural Punctuation by voice, it stays disabled until to 
enable it again.

NOTE

TIP
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Dictating Punctuation
You can enter the punctuation marks and symbols listed below in text you dictate. 
For a list of all punctuation marks, see the online help.

You can use the Vocabulary Editor to view or change the formatting properties of the 
punctuation. For more information, see “Changing word properties” on page 128.

TO ENTER SAY

, comma

. period
dot
point
[each one has different spacing characteristics]

? question mark

! exclamation mark (All Dialects)
exclamation point (US/Canada)

“ open quote
close quote

‘ open single quote
close single quote

( open paren (US/Canada)
left paren (US/Canada)
left parenthesis (All Dialects)
open parenthesis (All Dialects)

) close paren (US/Canada)
right paren (US/Canada)
right parenthesis (All Dialects)
close parenthesis (All Dialects)

‘ apostrophe

‘s apostrophe-ess

- hyphen
minus sign

-- [double 
hyphen]

dash

space bar
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Words that end with ’s
To dictate a word ending with (apostrophe) ’s, just say it as you normally would. 
Dragon NaturallySpeaking will often add it. If Dragon NaturallySpeaking doesn’t 
include the ’s, you can add it later.

Including ’s as you dictate
When you want to make sure that Dragon NaturallySpeaking types a word with ’s, 
say “apostrophe ess” after saying the word. For words that already end in “s,” say 
“apostrophe” after the word, as in the second example shown here. 

 You can add ’s to a word by selecting it and then saying it again with “apostrophe 
ess.“

Dictating hyphenated words 
Many hyphenated words and phrases are already in the Dragon NaturallySpeaking 
vocabulary. To dictate a word or phrase that is usually hyphenated, just say it as you 
normally would.

TO ENTER SAY

We took Mary’s car We took Mary’s car

that’s enough that’s enough

it’s time to go it’s time to go

TO ENTER SAY

We took my brother’s car We took my brother [apostrophe ess] car

I met my friends’ children I met my friends [apostrophe] children

TO ENTER SAY

long-lasting long lasting

up-to-date schedule up to date schedule

Tokyo-based company Tokyo based company

nine-year-old boy nine year old boy

TIP
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Including hyphens as you dictate 
To hyphenate words that Dragon NaturallySpeaking doesn’t hyphenate 
automatically, just say “hyphen” wherever you want a hyphen.

You can hyphenate words you just dictated with the command “Hyphenate That.” 
Select the words you want to hyphenate and say “Hyphenate That.” If you say this 
command when no words are selected, Dragon NaturallySpeaking will usually 
hyphenate the last few words that you said.

Removing hyphens 
You can remove a hyphen by selecting it and replacing it with a space. 

To remove a hyphen:
1 Say “Select hyphen.”

2 Say “Space Bar.”

Preventing hyphens 
You can prevent Dragon NaturallySpeaking from entering a hyphen by pausing 
where the hyphen would normally be.

For example, to type “long lasting” (normally hyphenated) say “long,” then pause for 
a moment, and then say “lasting.” Or you can say “long space bar lasting” without 
pausing, to insert a space in place of the hyphen.

Dictating compound words 
Dragon NaturallySpeaking joins compound words (such as “notebook”) 
automatically, based on standard usage. To dictate a compound word, just say it as 
you normally would. 

TO ENTER SAY

speech-recognition software speech [hyphen] recognition software

power-sharing agreement power [hyphen] sharing agreement

Elizabeth Walker-Smith Elizabeth Walker [hyphen] Smith
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Compounding words as you dictate 
To compound words that Dragon NaturallySpeaking doesn’t join automatically, just 
say “No Space” between the words.

You can also dictate consecutive words without spaces by turning “no spaces” on 
and then turning them off when you’ve finished.

To dictate consecutive words without spaces:
1 Say “No Space On” to turn spaces off.

2 Dictate the words you want to appear without spaces.

3 Say “No Space Off” to turn spacing back on.

Compounding words later 
You can compound the last words you said or compound selected words by saying 
“Compound That.” This command removes all spaces between selected words. Or, if 
no words are selected, it removes all spaces in the last utterance. Any tabs or line 
breaks are also removed.

To compound words:
1 Select the text you want to join. For example, if you want to join the words 

“Web TV,” say “Select Web TV.”

2 Say “Compound That.”

Dictating names
Many names of people, places, and events are already in the Dragon 
NaturallySpeaking vocabulary. For example, you can dictate “Martin Luther King,” 
“New York Times,” and “Boston.”

To dictate a name, first try dictating the name. Dragon NaturallySpeaking 
automatically capitalizes the names it knows. If Dragon NaturallySpeaking 
incorrectly types the name, correct it by keyboard or by voice (see “Correcting and 
Editing” on page 41). 

TO ENTER SAY

unitednations united [No Space] nations

WorldWide Web [Cap] world [No Space] [Cap] wide [Cap] web
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If the program continues to type a name incorrectly after you’ve corrected it several 
times, train the word individually using the Train Word dialog box. See “Training a 
word or command” on page 130.

Dictating abbreviations and acronyms 
Dragon NaturallySpeaking knows many common abbreviations (such as NYC and 
BBC) and acronyms (such as NATO). To dictate an abbreviation or acronym, just 
say it as you normally would.

If Dragon NaturallySpeaking types the full word instead of the abbreviation or 
acronym, enters the wrong word, or includes incorrect punctuation, just correct it in 
your document by voice or by keyboard.

Dictating e-mail and Web addresses
Dictate e-mail and Web addresses as you would normally say them. Dragon 
NaturallySpeaking automatically formats them for you.

Here are some guidelines for dictating e-mail and Web addresses:

■ When you say “h t t p” or “w w w,” Dragon NaturallySpeaking knows to format 
the next words you say as a Web address.

TO ENTER SAY

US/Canada: Dr. 
Other Dialects: Dr

Doctor

UK U K (say each letter)

RSVP R S V P (say each letter)

HTML H T M L (say each letter)

8 cm eight centimeters

US/Canada: pp. 27–33
Other Dialects: pp 27–33

pages 27 hyphen 33

NATO NATO (say as one word)

NASDAQ NASDAQ (say as one word)

TO ENTER SAY

Virginia@aol.com Virginia at a o l dot com

info@samplecompany.com [No Caps On] info at sample 
company dot com [No Caps Off]

http://www.scansoft.com [No Caps On] h t t p w w w dot 
scansoft dot com [No Caps Off]
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■ Say the following abbreviations by pronouncing them as words: 
“co,” “com,” “gov,” “mil,” “net,” and “org.”

■ Say the following abbreviations by saying each letter: 
“a c,” “b n, “c a,” “e d u,” “ie” “h k,” “i d,” “i n,” “j p,” “m y,” “p h,” “s g,”
“t h,” and “u k.” 

■ Use the “No Caps On” and “No Caps Off” commands to enter an e-mail or Web 
address in all lowercase letters. For more information about controlling 
capitalization, see “Dictating consecutive words in all lowercase letters” on 
page 63.

 You can create Text and Graphics custom commands for e-mail and Web addresses you use 
often. See “Automate Your Work (Preferred and Professional)” on page 167.

Dictating special characters 

Dictating common special characters
The following special characters are in the Dragon NaturallySpeaking vocabulary. 
To dictate these characters, just say their names.

TO ENTER SAY

& ampersand or and sign

* asterisk

@ at sign

` backquote

© copyright sign

^ caret

 ° degree sign

$ dollar sign or dollar

euros or euro sign

% percent sign
® registered sign

§ section sign

™ trademark sign

+ plus sign

- minus sign

« open euro quote

» close euro quote

# All Dialects: hash sign or sharp sign
US/Canada: number sign or pound sign

TIP
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For more complete lists of special characters, see the online Help.

Dictating uncommon special characters
If you use uncommon special characters in your writing (for example, a double-
dagger sign ‡), you can enter them by voice using the Spell command. If you use a 
special character frequently, you can also add it as a new word using the Vocabulary 
Editor.

For the complete list of special characters and their names, see the Special 
Characters topic in the online Help.

To dictate a special character:
1 Just say “Spell”plus the name of the character. For example, if you want to enter 

a double-dagger sign (‡) into your document, say “Spell double dagger.” 

To add a special character to the vocabulary:
If you frequently want to dictate an unrecognized special character (for example, 
double-dagger sign - ‡) into your document, you could add “double dagger” as a new 
word in the Dragon NaturallySpeaking vocabulary. Follow these steps:

1 In your document, dictate the phrase you want to use to enter the special 
character (for example, say “double dagger”). Dragon NaturallySpeaking enters 
the words into your document. 

2 Say “Spell That” to open the Spell dialog box.

£ US/Canada: pound sterling sign
Other Dialects: pound sign or pound

:-) smiley face

:-( frowny face

;-) winky face

TO ENTER SAY
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3 Say the name of the special character. (In this example, say “double dagger” to 
enter ‡.)

4 Click or say “OK.” Dragon NaturallySpeaking types the special character (‡) in 
your document and adds it to your vocabulary.

5 To give a special character a spoken form, choose View/Edit from the Words 
menu on the DragonBar. This opens the Vocabulary Editor. 

6 From the Display drop-down list at the bottom of the Vocabulary Editor, 
choose Custom Words Only. You will see the special character you just entered 
under the Written form column, as shown in this illustration.

7 Click on the special character to select it. In the illustration above, the special 
character is already selected.

The special character 
you dictated is 
shown in the Written 
form column.
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8 In the Spoken form field, type the name you want for this character and click 
Add.

9 Click Train. The Train Words dialog box opens.

10 Click Go and say the name of the character, as shown in the Train Words dialog 
box. For example, say “double dagger.”

11 Click Done to close the Train Words dialog box.

12 The Vocabulary Editor now has two words in the vocabulary with the same 
written form. One has a spoken form and one does not. Click on the word that 
does not have a spoken form and click Delete. This leaves the word that does 
have a spoken form in your vocabulary.

Type the character’s 
name (for example, 
“double dagger”) in 
the “Spoken form” 
field.

Click the word (the 
special character) 
with no spoken 
form.
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13 Click Close to close the Vocabulary Editor.

Now when you dictate the character name (in this example, “double dagger”), 
Dragon NaturallySpeaking should enter the special character, not the words.

 You can perform this operation more quickly by directly opening the Vocabulary Editor, and 
directly adding the written and spoken form.

 You can change the formatting properties of a word (such as whether Dragon 
NaturallySpeaking should type a space before or after the word) by using the Word Properties dialog 
box. See “Changing word properties” on page 128.

Switching Recognition Modes
Dragon NaturallySpeaking lets you use different recognition modes in your 
dictation. Dragon NaturallySpeaking uses normal mode by default. In normal mode, 
the program distinguishes between words, numbers, and commands. 

In addition to normal mode, there are four additional modes:

■ Numbers mode—The software recognizes only numbers, commands, and 
punctuation. If you are dictating only numbers (including currencies), working 
in this mode will increase recognition accuracy.

■ Spell mode—The software recognizes only letters, numbers, commands, and 
punctuation. In Spell Mode, Dragon NaturallySpeaking allows you to say any 
combination of letters, digits, or symbols you might need dictate part numbers 
or license plate numbers. You can also say keystrokes such as space bar or 
backspace key. Spell Mode is also useful for dictating internet or Web 
addresses.

■ Command mode—The software interprets everything you say as a command 
and nothing is interpreted as dictated text.

■ Dictation mode—The software interprets everything you say as dictation and 
nothing is interpreted as a command, except for a few commands such as “New 
Line” and “New Paragraph.”

To changes modes, you can:

1 Select the Words menu on the DragonBar and click the name of the mode you 
want. 

TIP

NOTE
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2 Switch modes by voice by saying one of these commands:

Turning a mode off by voice is the same as switching back to normal mode.

 You cannot dictate fractions in number mode.

MODE TO TURN ON, SAY TO TURN OFF, SAY

Numbers Mode Numbers Mode On or
Start Numbers Mode or 
Switch to Numbers 
Mode

Numbers Mode Off or
Stop Numbers Mode or
Switch to Normal Mode

Spell Mode Spell Mode On or
Start Spell Mode or 
Switch to Spell Mode

Spell Mode Off or
Stop Spell Mode or
Switch to Normal Mode

Command Mode Command Mode On or
Start Command Mode 
or Switch to Command 
Mode

Command Mode Off or
Stop Command Mode 
or
Switch to Normal Mode

Dictation Mode Dictation Mode On or
Start Dictation Mode or 
Switch to Dictation 
Mode

Dictation Mode Off or
Stop Dictation Mode or
Switch to Normal Mode

NOTE
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9

Using the Command Browser

he Command Browser is the most comprehensive place to find which 
command work in Dragon NaturallySpeaking. The Command Browser lets 

you view both“global”(available everywhere) commands and application-specific 
commands for editing, formatting, and controlling specific applications. These 
application-specific commands let you avoid the multiple menu-selection and 
mouse-movement steps associated with the traditional Microsoft Windows 
interface.

Since the number of valid commands is large, you should just try saying what you 
want to do. Try finding a way of saying commands that is easy to remember and that 
works in Dragon NaturallySpeaking. 

You use the Command Browser to:

■ View and train both global and application-specific commands. Global 
Commands are the commands Dragon NaturallySpeaking recognizes regardless 
of the context. Application-specific commands let you control the applications 
on your computer. 

■ Create and modify custom commands. Custom commands are commands that 
have been added to the built-in command set. (Preferred and higher editions)

■ Change the availability of custom commands. (Preferred and higher editions)

■ Import and export custom commands. (Professional and higher editions)

Supported Applications
In addition to the global commands, the Command Browser displays commands for 
the following applications:

■ America Online® 8 and 9

■ Corel® WordPerfect® 10, 11, 12 (Standard Edition and higher)

■ DragonPad and DragonBar

■ Lotus® Notes 5, 6, and 7(Professional editions)

■ Microsoft® Chat

■ Microsoft® Excel 2000, XP, and 2003 (Preferred and Professional editions)

T
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■ Microsoft® Outlook Express 5 and 6 

■ Microsoft® Internet Explorer® versions 5 and higher 

■ Microsoft® Outlook 2000, XP, and 2003 (Professional Edition and higher)

■ Microsoft® Paint

■ Microsoft® Powerpoint 2000, XP, and 2003 (Professional Edition and higher)

■ Microsoft® Windows Explorer 2000, XP, and 2003

■ Microsoft® Word 2000, XP, and 2003 

■ Microsoft® Wordpad

 The Command Browser only displays commands for applications currently installed on your 
computer. In Professional and higher, you can also display commands for all applications supported by 
the Command Browser. 

Starting the Command Browser
To open the Command Browser, click Command Browser from the Tools menu on 
the DragonBar. To launch the Command Browser by voice, say "Start the Command 
Browser." You can also start the Command Browser from the Accuracy Center.

When the Command Browser starts, it first displays a list of Global Commands. 
Global Commands are those commands available in every application. You can train 
these commands so that Dragon NaturallySpeaking will understand you better, but 
you cannot change or remove most of these commands from your system. 

NOTE

What you see 
depends on your 
version. For example, 
Script and Manage 
are displayed only in 
the Preferred and 
higher editions.
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Finding specific commands
To see what commands are available for specific applications, click the pull-down 
menu next to the field labeled Current command context. For example:

There may be more than one entry for any given application. Each entry is defined 
by Application Name - Window Caption. For example, Microsoft Outlook 2003 - 
Message (Rich Text) would show you the commands available in the following 
Outlook Message window:

Finding commands
To see if a specific command is available:

1 Click the pull-down menu for the Current command context and select the 
appropriate application context. The Command Browser displays all the 
commands supported in the selected context. 

2 Click the “Only Available” button (Professional and higher) or the “Include 
Global” button depending on which commands you want to see.

■ “Only Available” (Professional and higher) shows only the commands for 
those applications currently installed on your computer. You can click “Only 
Available” to display commands for all applications supported by Dragon 
NaturallySpeaking, not just those currently installed on your machine.

■ “Include Global” shows all the commands that are available in the current 
command context, including global commands available in all contexts.

Window 
caption
name
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3 Click the Filter button. This displays the Choose Word screen:

4 Type or dictate in the specific command(s) you are looking for, one word at a 
time, in the "Choose Word" box. The list below the box scrolls to find that word 
in the list. If the word exists, it is selected. If the word does not appear, then 
there is no command in the current context that uses that word. 

5 Press the space bar or click Add until you have added as much of the specific 
command as you can to the "Current list of words" box.

6 When you are finished adding keywords, click or say "Done" or press or say 
"Enter". This displays the commands containing the words you entered, if any.

 Try to be as specific as possible when entering commands.

Example
To see if the command "set that to bold" exists in Microsoft Word 2000:

1 Select Microsoft Word 2000 - Message from the Current command context menu.

2 Click Filter.

3 Type or dictate the words "set", "that", and "bold" one word at a time in the 
"Choose Word" field.

TIP
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4 Click Done or press Enter. The Command Browser displays the set of 
commands valid in the chosen context; in this case all those commands that 
contain the words “set,” “that” and “bold”:

Expanding commands
Some commands will not be fully expanded; either due to their complexity or 
because only partial information was entered in "Choose Word" field. To expand a 
command:

1 Select the command in the Command Browser.



9 Using the Command Browser

Dragon NaturallySpeaking User’s Guide108

2 Use one of the following buttons to act on the selected command. The examples 
all assume that Global Commands is selected in the Current command context.

BUTTON ACTION EXAMPLE

 Refine

Refine shows just the current selection 
and expands the selection. At this 
point, the selection can resolve to a 
single command or a list of similar 
commands that you may need to 
refine further. Using refine may be 
helpful if you have many displayed 
commands and want to look at only 
one. In many cases, clicking Refine 
will show you the commands you 
want.

Scroll down the list of Global Commands and select 
…mode on. Click Refine. 
...mode on refines to:·

■ command mode on·
■ dictation mode on·
■ numbers mode on·
■ spell mode on

 Optional

Optional expands optional 
statements. Optional statements are 
parts of the command you don't have 
to say for the command to work. 
Optional statements are shown in 
brackets: [ ]. 

Scroll down the list of Global Commands and select 
close [the] list. This expands to:·

■ close list·
■ close the list

 Or

Or expands Or statements. Or 
statements are used to indicate a 
number of alternative commands. Or 
statements are usually preceded or 
followed by other commands. Or 
statements are shown by a separator 
bar, |, and are usually enclosed by 
parenthesis.

Scroll down the list of Global Commands and select 
page (up | down). This expands to:·

■ page down
■ page up

Ellipses

Ellipses expands ellipsis. Ellipses 
indicate that more expansion is 
possible.

Scroll down the list of Global Commands and select 
…mode off. This expands to:·

■ command mode off·
■ dictation mode off·
■ numbers mode off·
■ spell mode off

 Undo All

Undo All reverses all operations and 
re-displays the list of commands in the 
currently selected context with your 
filtering criteria in place.

Click or say “Undo All” for any of the examples 
above. The full list of global commands display.
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Training commands
If Dragon NaturallySpeaking consistently misrecognizes a specific voice command 
(for example, it hears "Paste That" as "Paste dot"), you can train it to recognize your 
pronunciation of the command.

1 Open the Command Browser (say "Start Command Browser" or click Command 
Browser on the Tools menu of the DragonBar). 

2 In the Command Browser, select the current command context from the 
Current command context list. 

3 Locate the command you want to train and select it using the steps described in 
the Finding specific Commands section.

4 Click:

Working with Custom Commands 
(Preferred and higher)

Dragon NaturallySpeaking comes with a limited set of custom commands that you 
can use "as is" to fit your needs.

You can view these custom commands only in the Preferred and higher editions. 
The ability to create, modify, delete, import, and export custom commands 
depends on your edition. The differences in editions is listed in each section.

BUTTON TO

Train

To immediately train the selected command. Follow the directions 
on the Train Words dialog box that appears.

 Train Later

Adds the command to a list of commands to the Train List for later 
training. By selecting Train Later, you activate the Train List button.

 Train List

Displays the Train Words dialog box with a list of commands to be 
trained. Note: If you close the Command Browser while you still 
have words in the Train List, you will be warned that you could lose 
those commands.
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Viewing Custom Commands
1 Open the Command Browser (say "Start Command Browser" or click Command 

Browser on the Tools menu of the DragonBar). 

2 Click the Script button. This displays the command grammars where custom 
commands are available. By default, the custom global commands are displayed.

3 To change the command grammar, select a grammar from the Current command 
grammar list.

The Scripting window shows the following types of custom commands:

You can expand each command by clicking the plus sign next to that command or by 
double-clicking the command name. The name of the command is what you say to 
execute that command. A variable in the commands is shown in brackets <>. The 
command name can be displayed as two parts:

■ Parts of the command name

■ Values for any variables

 The displayed command name corresponds to the MyCommand name in the MyCommands 
Editor.

Creating a new command
You can automate your work by creating custom commands that let you type text, 
insert graphics, or activate menu and keystroke commands in any application. 
(Preferred and higher editions)

1 Open the Command Browser (say "Start Command Browser" or click Command 
Browser on the Tools menu of the DragonBar). 

ICON DESCRIPTION

Advanced Scripting, which allows people familiar with programming 
languages such as Microsoft® VBA to program commands that can 
perform virtually any function on the computer with voice commands. 
(Professional and higher editions)

 Text and Graphics, which you can use to enter text and graphics of your 
choosing. (Preferred and higher editions)

 Step-by-Step, which lets you activate menu and keystroke commands to 
control your application. (Professional and higher editions)

 Macro Recorder, which lets you record a sequence of mouse movements 
and keystrokes. (Professional and higher editions)

NOTE
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2 Click the Script button. This displays the command grammars where custom 
commands are available. By default, the custom global commands are 
displayed.

3 Select a grammar from the Current command grammar list to select a context 
where the new command will be used.

4 Click the New button. This displays the MyCommands Editor. Use the editor 
to name the command and assign properties to it. For information on how to 
use the MyCommands dialog box, click the Help button on the dialog box, or 
see the MyCommands section listed below.

You can also base a new command on an existing command. For more information, 
see Modifying a command below.

You can also use Tools>Add New Command from the DragonBar to create a new 
command.

Modifying a command
To modify an existing command:

1 Open the Command Browser (say "Start Command Browser" or click Command 
Browser on the Tools menu of the DragonBar). 

2 Click the Script button. This displays the command grammars where custom 
commands are available. By default, the custom global commands are 
displayed.

3 Use the Current command grammar list to select the program or context in 
which the command is found. A list of commands display.

4 From the list, select the command that you want to modify.
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5 Click:

6 Click Save when you are done.

Deleting a command
You can delete commands that you have either created or imported.

1 Open the Command Browser (say "Start Command Browser" or click Command 
Browser on the Tools menu of the DragonBar). 

2 Click the Script button. This displays the command grammars where custom 
commands are available. By default, the custom global commands are displayed.

3 Use the Current command grammar list to select the program or context in 
which the command is found. A list of commands display.

4 From the list, select the command that you want to delete. 

5 Click the Delete button  

6 Confirm that you want to delete the command. The command disappears from 
the Command Browser.

 You cannot delete many application-specific commands, Natural Language Commands, or 
other built-in commands.

BUTTON DESCRIPTION

Edit button

This displays the MyCommands Editor with current 
command. Use the editor to modify the command's 
properties.For information on how to use the 
MyCommands dialog box, click the Help button on the 
dialog box, or see the MyCommands section listed 
below.

New Copy button

This displays the MyCommands Editor with current 
command, but with a unique name. For example, if you 
chose go to sleep in Global Commands, the new copy 
would be named go to sleep 2. Use the editor to modify 
the command's properties.For information on how to use 
the MyCommands dialog box, click the Help button on 
the dialog box, or see the MyCommands section.

NOTE
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Importing and exporting commands
(Professional and higher editions)

You can share custom commands with other users by exporting them to a file and 
then having the other user import that file. If you have created several users on your 
computer, this allows you to use these commands no matter which user you 
currently have open.

The ability to import and export commands is available only in Professional and 
higher editions.

Exporting commands
1 Open the Command Browser (say "Start Command Browser" or click Command 

Browser on the Tools menu of the DragonBar). 

2 Click the Manage button. This displays the groups where custom commands 
are available. By default, the groups Dragon, User-defined, and all are available. 
Use the plus (+) icon to expand the commands. For example:

3 Select one or more commands to export by selecting the box to the left of the 
command name; causing a check to appear.

 You can select an entire group by selecting the box to the left of the group name.

4 Click Export:. This displays the Choose a file to export to… dialog box.

5 In the Choose a File to Export to… dialog box you can: 

■ Choose a File name from the ones listed, click Save, and then Click either 
Overwrite, Merge, or Cancel on the Exporting MyCommands dialog box 
that appears. Overwrite replaces the commands in the existing file with the 
ones you selected. Merge adds the commands you selected to the ones 
already in the file. 

■ Enter a new file name and click Save. 

NOTE
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Importing Commands
1 Open the Command Browser (say "Start Command Browser" or click Command 

Browser on the Tools menu of the DragonBar). 

2 Click the Manage button. This displays the groups where custom commands are 
available. By default, the groups Dragon, User-defined, and All are available. 

Use the plus (+) icon to expand the commands.

3 Click Import  

4 Use the "Choose a file to import from" dialog box to navigate to the location of 
the voice command file, for example, My_Commands.dat, which you want to 
import.

5 Click Open. The status of the import process and any error messages appear in 
the Import Status dialog box.

6 On the Importing MyCommands dialog box, select the commands you want to 
import and click the Import button. You may notice a delay, depending on the 
size of the file you are importing. For more information, click Help.

After importing a voice command file, you can use all the custom voice commands it 
contains in addition to any custom voice commands that were already in your voice 
command file. You can also edit commands that are contained in the imported file.

Changing the command group and availability
You can change the group or availability of a selected set of commands.

The command group is a category where you place the command. You use these 
groups to locate the command in the Command Browser. By default, the groups 
Dragon and User-defined are available. To create your own group, select User-
defined and type over it with a group name of your choosing.

The Availability defines where the command will be available:

■ Global: The command will be available in every application. 

■ Application-specific: The command will be available in the application you 
specify. When you select this option, the applications currently open appear. If 
the application you want is not open, use the Browse button to locate the 
application on your computer. 

■ Window-specific: The command will be available in the window you specify. 
When you select this option, the Window list appears. If the window you want is 
not in the list, you must close the MyCommands Editor dialog box, open the 
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window you want, and reopen the MyCommands Editor dialog box to see the 
window listed. 

Changing the command group and availability
1 Open the Command Browser (say "Start Command Browser" or click Command 

Browser on the Tools menu of the DragonBar). 

2 Click the Manage button. This displays the groups where custom commands 
are available. By default, the groups Dragon, User-defined, and All are 
available. Use the plus (+) icon to expand the commands.

3 Select one or more commands to modify by selecting the box to the left of the 
command name. A check   appears when you select the command.

 You can select an entire group by selecting the box to the left of the group name.

4 Click Edit Properties. This displays the MyCommands Properties dialog box. 
For more information about this, see the My Commands Properties Dialog 
section in MyCommands or click Help on the MyCommands Properties dialog 
box.

5 In the MyCommands Properties dialog box, you can:

■ Change the group in which the command is found. 

■ Create a new group. To create your own group, select the Group name and 
type or dictate over it with a group name of your choosing.

■ Change where the command will be available.

6 When you are done, click Save.

NOTE
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10

Improving Accuracy

s you speak to Dragon NaturallySpeaking, it makes its best estimate as to 
what you are saying and it will make some mistakes. This chapter describes 

what you can do to improve you recognition accuracy.

You can take concrete steps toward improving your accuracy, which is one of the 
most important factors in using the program productively.

The Accuracy Center
The Accuracy Center provides a "home page" for taking advantage of all the Dragon 
NaturallySpeaking tools available to ensure excellent recognition.

From the Accuracy Center, you can access the tools that Dragon NaturallySpeaking 
provides to improve accuracy. To open the Accuracy Center, click Accuracy Center 
on the Tools menu of the DragonBar. In the Accuracy Center, either click or say the 
name of the link you want. Each tool in the Accuracy Center is described below. 

A
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“Which tool should I use”
If you are not sure where to begin or how to use the Accuracy Center, click the first 
link, “Which tool should I use?” The Accuracy Assistant will display a series of 
questions that will help you find the best tool for your needs. 

 You can also access the Accuracy Assistant by clicking Improve my accuracy on the Help 
menu of the DragonBar.

Tools to improve your acoustics

Check your audio settings
You can check the volume level of your microphone and your sound card by clicking 
or saying “Check your audio settings” in the Accuracy Center. This runs the Audio 
Setup Wizard, which checks the volume level of your microphone and sound card. 

 You will need to run “Check your audio settings” if you change microphones or sound cards.

Run the Acoustic Optimizer
As you make corrections and perform additional training, Dragon NaturallySpeaking 
stores this data in an archive and uses it to enhance recognition accuracy. The 
Acoustic Optimizer accumulates this data from session to session. The Acoustic 
Optimizer uses much more data to enhance the user file and is therefore more 
accurate. 

If you plan to run the Acoustic Optimizer, be sure that the "Store corrections in 
archive" option is selected on the Data tab of the Options dialog box. Otherwise you 
may see a message that there is not enough data for the Acoustic Optimizer to 
process. The "Store corrections in archive" option should be selected.

Incorporating the acoustic data into your user files can take a hour or longer; plan to 
run the Acoustic Optimizer at the end of your workday or when you don’t need to 
use the computer for other tasks.

NOTE

TIP
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To tell the software to make use of this information, in the Accuracy Center 
window, click the “Run the Acoustic Optimizer” link. 

▲ Click the Go button to start the Acoustic Optimizer.

How often you should run the Acoustic Optimizer depends on how much you 
dictate. Run the Acoustic Optimizer about two weeks after you begin using Dragon 
NaturallySpeaking and then once each month as you continue to use it.

Scheduling the Acoustic Optimizer
The Acoustic Optimizer Scheduler allows you to run the Acoustic Optimizer at a 
time that is convenient for you. Because the Acoustic Optimizer requires a 
significant amount of your computer's resources to run, you should schedule the 
Optimizer to run at a time when the computer will not be needed for any other task.

The Acoustic Optimizer Scheduler window is divided into two parts.

■ Left Pane: The left window pane is an expanding list similar to the list-tree in 
the Windows Explorer. Use this list to select a particular acoustic model for a 
user name. Click on the plus (+) sign to expand the list and the minus (-) sign to 
contract it.

■ Right Pane: The right window pane lists the user names along with information 
about the Acoustic Optimizer schedule currently set for that user. As you add or 
modify schedules using the Select Frequency dialog box, the updated 
information appears in this window.

The following information on each user is available:

■ User: The name of the user files 

■ Dictation Source: The input device used for dictation. Users can have multiple 
dictation sources, such as a headset microphone, an array (wide field) 
microphone, or a digital recorder. This field identifies which of those multiple 
sources the Acoustic Optimizer will be updating. 

■ Frequency: How often the Acoustic Optimizer is scheduled to run, for 
example, daily, weekly, or once. 
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■ Next Run time: Date and time that the Acoustic Optimizer is scheduled to run 
for that user. 

■ Last Run Time: Date and time that the the Acoustic Optimizer last selected for 
that user. 

■ Last Result: The results of the last Acoustic Optimizer run for that user. 

■ Creator: Name of the Windows user that created the Dragon NaturallySpeaking 
user. 

Opening the Acoustic Optimizer Scheduler
1 Open the Accuracy Center by clicking Accuracy Center on the Dragonbar tools 

menu or by sating "Open Accuracy Center". 

2 On the Accuracy Center click or say "Schedule Acoustic Optimizer to run later". 

Scheduling the Acoustic Optimizer
1 Click New Task on the File menu, click the New Task tool, or double-click the 

name of the user for which you want to create a schedule. 

2 If your operating system requires a password to run (such as Windows 2000, or 
Windows XP) a dialog box will appear asking for your Windows user name and 
password. 

3 In the Open Select Frequency dialog box select the user and dictation source for 
which you want to create a schedule from the User Information options if they 
are not already selected. 

4 Select the frequency for the schedule and then select the start date and start 
time. 

5 Click OK to return to the Acoustic Optimizer Scheduler. 

For more information on the Acoustic Optimizer Scheduler, see the online help.

Perform additional training
Additional training will help to improve your recognition accuracy. Consider doing 
additional training when:

■ You have used Dragon NaturallySpeaking for a few days. By then, you will be 
accustomed to dictating, and supplemental training should reflect how you 
actually dictate. 

■ You move to an environment that is significantly noisier or quieter or that has 
different background sounds. 

■ You change your microphone or sound card. 
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To perform additional training:

1 From the Accuracy Center, click or say "Perform additional training." 

2 Follow the same guidelines as when you trained the first time. 

3 When you are finished, click Finish. 

Tools to Manage Commands

Launch the Command Browser
From the Accuracy Center, click or say “Launch the Command Browser” to display 
the Command Browser. The Command Browser lets you see many of the 
commands available in your edition of Dragon NaturallySpeaking. In the Command 
Browser, you can also create new commands customized to speed up your work. For 
more information on the Command Browser, see page 103.

Tools to improve your vocabulary
When Dragon NaturallySpeaking gets a word wrong, it’s often because the word is 
not in the vocabulary. This is more likely if the word is an uncommon name or 
specialized term. The tools described in this section let you teach Dragon 
NaturallySpeaking these new words.

Add a single word to your vocabulary
To add any word to the vocabulary, click or say “Add new word”. When the Add 
Individual Word dialog box appears, type or say the word you want to add and click 
or say “Add.”

When you check “I want to train the pronunciation of this word,” Dragon 
NaturallySpeaking displays the Train Word dialog box where you tech the program 
how you pronounce the new word you’ve added.

 You can also access the Add Individual Word dialog box by clicking New from the Words 
menu on the DragonBar.
NOTE
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Add words from your documents to the vocabulary
You can have Dragon NaturallySpeaking analyze your documents to analyze your 
writing style and the words you use most often.

This procedure will add:

■ Words that match backup dictionary words that have the same capitalization, for 
example, Punxsutawney (uppercase) or jackstraws (lowercase)

■ Words with at least one uppercase letter that are not in the backup dictionary, 
for example, eBusiness and Brooklynese, or a name, such as Rusinow

 The program expects to find capitals at the beginning of sentences, or in a sequence of 
words that are all capitalized or have initial caps, such as a book title. It does not expect to find capitals 
in the middle of words or sentences.

To Add Words from Documents
You must have Microsoft® Word installed to process Microsoft® Word files and you 
must have Corel® WordPerfect® installed to process Corel® WordPerfect® files.

1 From the Accuracy Center, click or say “Add words from your documents to the 
vocabulary”. This displays the Add Words from Documents Wizard box. Once 
you have made your selections, click Next to display the “Add documents” 
screen.

2 On the Add Documents sreen, click or say “Add Document” to add documents or 
“Add Folder” to add all the documents in the folder you select. Click Next to 
start the document analysis. 

3 When the document analysis completes, click Next. 

NOTE
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4 If you chose to preview words, a checklist of words displays (from all the 
documents in the list) that are not in your current vocabulary. For example:

■ Clear any check box to remove a word from the list.

■ Add only words you think you’ll use frequently, not ones you’re unlikely to 
need.

■ Don’t add capitalized words unless you plan to dictate the capitalized form of 
the word often (for example, a pet’s name “Fluffy”).

5 Click Next to scan the documents for the words you want to add to the 
vocabulary. Your speech files will be updated and saved automatically.

6 You can optionally select new words to train so that the program can better 
recognize your pronunciation of the words you are added to the vocabulary. 
Click Next to continue.

7 The Wizard will now adapt to your writing style. In this step the wizard builds a 
new language model with the information that it has gathered in the preceeding 
steps. A progress bar tells you when the process is complete. Click Next to 
complete and exit.

Increase accuracy from e-mail
To increase accuracy, you can analyze your sent e-mail as well as add the names of 
the people in your e-mail address book. The following e-mail applications are 
supported: Microsoft® Outlook® Express, Microsoft® Outlook®,Lotus® Notes®. 
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To add contact names:
1 From the Accuracy Center, click or say “Increase Accuracy from E-mail.” The 

Increase Accuracy from E-mail dialog box opens. Click Next to continue.

2 Select the e-mail program you use from the choices provided. After selecting 
one or more e-mail programs and the appropriate options, select Next. For 
example:

■ Scanning the contents of your sent e-mail can take several minutes if you 
have a large amount of e-mail in your program's Sent mail folder.

■ Depending on how your system is set up, you may be prompted to supply a 
password.

■ The “Improve my speech files from my e-mail writing style” option lets you 
analyze the e-mails that you’ve already sent for your style. For best accuracy 
when writing e-mail, leave this option selected.

3 Once e-mail processing is complete, the dialog box displays a list of contact 
names to add to your vocabulary. Check the contacts you would like to add to 
your vocabulary and click Next.

4 Check the contacts for which you would like to train the pronunciation and click 
Next. A check mark indicates that you want to train the word. 

5 For each contact you selected to train, Dragon NaturallySpeaking brings up the 
Train Words dialog, where you can speak the name of the contact. Once you 
train a name, the next name you selected appears in the dialog box until you 
have trained the entire list of selected names.

6 Once you are done, Dragon NaturallySpeaking adapts your speech files based 
on your selections.

Add a list of words to your vocabulary
Using the “Add a list of words to your vocabulary” feature, you can add many new 
words to the Dragon NaturallySpeaking vocabulary at the same time. This feature is 
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useful when adding words from employee lists, product code lists, and similar 
documents. 

To add a list of words:
1 Create a text (.txt) file and enter each word or phrase you want to add to the 

vocabulary on a separate line. Make sure words are spelled correctly. Each 
word, phrase or name that you add must be on a separate line.

2 From the Accuracy Center, click or say “Add a list of words to your vocabulary.” 
You can optionally choose to preview the words to add and find words with 
unknown capitalization. Click Next to continue.

3 Click Add File and select the.TXT file that contains the new words you want 
to add. 

4 Click Next. Dragon NaturallySpeaking will add the words in the document you 
selected.

5 If you want Dragon NaturallySpeaking to add words from more documents, 
repeat steps 3 and 4.

View or edit your vocabulary
The Vocabulary Editor shows you all the active words (the most commonly used 
words) in the Dragon NaturallySpeaking vocabulary. You can open Vocabulary 
Editor to find out whether a word is in the active vocabulary. If it’s not there, you 
can add it. If it is, you can create a different spoken form.

You can also use the Vocabulary Editor to:

■ Add words that are spoken one way but written a different way. This feature 
lets you add a word that, for example, types your phone number whenever you 
say “phone number line.”

■ Change the formatting properties of a word, such as whether Dragon 
NaturallySpeaking should type a space before or after the word. You can do this 
by using the Word Properties dialog box. See “Changing word properties” on 
page 128.

By choosing the appropriate option from the Display list, you can view:

■ All words: displays all the words in the current vocabulary. 

■ Custom words only: displays only words added to the vocabulary by the user. 

■ Words with spoken forms only: displays only words with spoken forms that are 
different from their written forms. 

■ Words with formatting properties only: displays only words with special 
formatting properties that influence how they appear in the transcription of 
dictated text. 
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To edit your vocabulary:
1 From the Accuracy Center, click or say “View or edit your vocabulary.” You can 

also click View/Edit on the Words menu on the DragonBar. 

2 Words you have added are marked with a colored star  (not including any 
words that were previously in the backup dictionary). To see only the words you 
have added, click “Custom words only.”

A word’s written form is what Dragon NaturallySpeaking types when you say the 
word. The spoken form is how you say the word. For example, the spoken form for 
“Sgt.” is “Sergeant.” 

 Want to check to see if a word is already in the vocabulary? Type the first few letters of the word 
into the Written form box. If the word is in the vocabulary, it will appear on the screen.

3 Type the new word or phrase into the Written form box. Leave the Spoken form 
box empty, unless the word or phrase is not pronounced the way it’s spelled. If 
so, see “View or edit your vocabulary” on page 125.

4 Click Add.

5 Click Close to close the Vocabulary Editor.

Notes:

■ If the spoken form is blank, you must say the written form for the word to be 
recognized. 

■ Some special words have a blank written form. These words are special dictation 
words built into Dragon NaturallySpeaking. You cannot add your own words 
with a blank written form. 

■ Words with a written form that begins with a number (for example, "99th" or a 
fraction like "½") appear in the list before words that begin with the letter "a". To 
see these words, you must scroll the list up. 

To create a spoken form for a word or phrase:
Creating a spoken form can be useful in automating some words or phrases that you 
dictate frequently. To create a spoken form:

1 Find the word you want in the list by typing the first few letters in the Written 
form box of the Vocabulary Editor.

 If the word you want to edit doesn’t appear in Vocabulary Editor, it means the word isn’t in 
the active vocabulary. You need to add it to the active vocabulary before you can edit it. (See “View or 
edit your vocabulary” on page 125.)

2 Select the word. 

TIP

NOTE
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3 Type the new spoken form into the Spoken Form box. Make sure you type it 
exactly as is it pronounced. 

4 (optional) Make any changes, such as punctuation or capitalization, to the 
Written Form box.

5 Click Add. This adds the word with your changes. 

If the word was already in the active vocabulary before you edited it, you should 
then delete the original word.

Creating a spoken form can be useful in automating some words or phrases that you 
dictate frequently. For example, you can define a spoken form for a phone number 
that you frequently use instead of dictating a string of numbers.

Here are some examples of words with different written and spoken forms. Look in 
the Vocabulary Editor window for more examples.

To delete a custom word from your vocabulary

Normally, you do not need to delete words from the active vocabulary. If a word is 
regularly confused with another one that you never use, however, you might want to 
delete the word you never use.

To delete a word, select it and click Delete. (You can select multiple words by 
holding down the CTRL key while you click. Clicking while holding the SHIFT key 
will select consecutive words.) 

Some common words (like “the”) cannot be deleted, since Dragon 
NaturallySpeaking wouldn’t understand you very well without them.

WRITTEN FORM SPOKEN FORM

eBusiness ee business

Daniell Daniel with two ells

Niamh Nev

CINCPAC sink pack

mdbowman@company.com my e-mail address

Robert F. Kennedy R. F. K.

Waldron, Lichtin & Foust Waldron Lichtin and Foust

(617) 965-5200 my phone number
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Changing word properties
You can use the Vocabulary Editor to change the formatting properties of a word, 
For example, you can change whether Dragon NaturallySpeaking should type a 
space before or after the word, or whether the word should be capitalized when used 
in a title. For complete information on this feature, see the online help.

To change the properties of a word:
1 From the Accuracy Center, click or say “View or edit your vocabulary.” You can 

also click View/Edit on the Words menu on the DragonBar. The Vocabulary 
Editor displays.

2 Find the word whose properties you want to modify and select it,

3 Click the Properties button to open the Word Properties dialog box. The 
Property column lists the different possible properties for a word, namely, the 
spacing, capitalization, and other ways a word behaves when it is recognized and 
printed in your document.

.

4 Click OK to close the Word Properties dialog box.

5 Click Close to close the Vocabulary Editor.

For more information on word properties, see the Dragon NaturallySpeaking online 
Help.

The word whose 
properties you are 
editing.

Click on the word 
property you want in 
the Properties 
column.

The Example column 
lists example words 
for each Property.
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Run the Vocabulary Optimizer
The Vocabulary Optimizer analyzes your writing style to increase your recognition 
accuracy during dictation. This tool scans the following for appropriate words to use 
when building the vocabulary:

■ Documents in your My Documents directory. This includes Microsoft Word, 
Corel WordPerfect, text and rich text files (.rtf).

■ E-mail you have sent from Microsoft Outlook, Microsoft Outlook Express, and 
Lotus Notes.

To start the Vocabulary Optimizer:
1 On the Tools menu of the DragonBar, click or say “Accuracy Center.”

2 In the Accuracy Center click or say "Run the Vocabulary Optimizer." This 
displays the Vocabulary Optimizer dialog box: 

3 Select:

■ E-mail to have Dragon NaturallySpeaking build a language model from the 
contents of your sent e-mail, so that it can better recognize the phrasing and 
word order you typically use in your communication.

■ Documents to have Dragon NaturallySpeaking build a language model from 
the contents of any Microsoft Word, Corel WordPerfect, text and rich text 
format file in your MyDocuments folder.

4 Click or say “Start” to continue. A status bar displays while the Vocabulary 
Optimizer scans your system.

5 Click or say “Done” when the Vocabulary Optimizer finishes.

Notes:
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■ Your sent e-mail must be from either Microsoft Outlook, Microsoft Outlook 
Express, or Lotus Notes or the Vocabulary Optimizer cannot scan it. 

■ Documents older than 90 day and documents less than 512 bytes are not 
processed.

■ Because the scanning process can take a long time and use much of your 
computer's memory and processing power, it is best to run the Vocabulary 
Optimizer only when you are not using your computer for other purposes. 

Managing your vocabularies
Click the last link in the Accuracy Center, “How to manage and personalize your 
vocabularies,” to open an online Help topic about vocabularies. (To display the 
Accuracy Center, click Accuracy Center on the Tools menu of the DragonBar.)

The Professional and higher editions of Dragon NaturallySpeaking allow one user to 
create multiple vocabularies. This can be useful if you dictate on several unrelated 
topics—for example, if you dictate medical reports part of the time and dictate a e-
mail at other times. In this case, you could create separate vocabularies for medical 
dictation and for your personal writing, thereby increasing accuracy. 

Multiple vocabularies share the same pronunciations but have different words and 
word usage information. This means that you do not need to train for each 
vocabulary. Your acoustic information resides in your user files. You can imagine 
vocabularies as subdirectories of your user files, with one set of acoustic files that 
works across all your vocabularies. For additional information about using multiple 
vocabularies, see the online Help.

Training a word or command
Sometimes Dragon NaturallySpeaking will misrecognize a word or command more 
than once, even after you correct the program’s misrecognition. When this happens, 
use the Training dialog box to easily train the word or command.

To train a word or command:
1 Click Train on the Words menu of the DragonBar to open the Training dialog 

box.
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2 Type the word or command you want to train (capitalization does not matter).

▲ In this example, the word to be trained is “Springdale.”

3 Click Train to open the Train Words dialog box.

4 Click Go.

5 Say the word or command you are training.

6 Click Done.

Using the Performance Assistant 
The Performance Assistant helps you determine how to increase the speed with 
which Dragon NaturallySpeaking recognizes your speech. 

The Performance Assistant is presented as a series of questions. As you answer 
questions about how you normally use Dragon NaturallySpeaking and click or say 
the corresponding link, you will get help with specific techniques to customize 
Dragon NaturallySpeaking for better performance.

To start the Performance Assistant, click or say "Performance Assistant" from the 
Dragon Bar Help menu.

As you answer questions about how you normally use Dragon NaturallySpeaking 
and click or say the corresponding link, you will get help with specific techniques to 
customize Dragon NaturallySpeaking for better performance.
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Managing Users

ore than one person can use Dragon NaturallySpeaking on the same 
computer. You can even dictate in different languages or dialects (Preferred 

and higher editions).

Each person who wants to use the program needs to create a new set of user speech 
files and train Dragon NaturallySpeaking to understand his or her voice. A single 
person might want to have more than one set of user speech files (called a user) if, 
for example, you dictate into a mobile recorder or in more than one language.

This chapter explains how to set up Dragon NaturallySpeaking so that more than 
one person can use it, and describes how to open, rename, delete, back up, and 
restore users. This chapter also describes setting up multiple dictation sources for a 
user.

Creating a new user 
When someone new wants to use Dragon NaturallySpeaking, that person needs to 
follow the steps described in this section to create a new user.

 Preferred and Professional editions of Dragon NaturallySpeaking allow you to create and 
train users with multiple dictation sources. For example, with a single set of user files you can dictate 
with a headset microphone, an array microphone, or a portable recorder. This way you can keep the 
same custom vocabulary and training, but use the dictation source most convenient for you at that 
moment. For more information, see “Creating Multiple Dictation Sources” on page 140.

To create a new user:
1 From the NaturallySpeaking menu, select Open Users.

What are user speech files?
Your user speech files contain all the information that Dragon 
NaturallySpeaking gathers about you: your pronunciation, your vocabulary, 
how often you use certain words, and your preferences. 

M

NOTE
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2 In the Open Users dialog box, click New.

3 Follow the steps in the New User Wizard.

Creating a user on a portable device
You can create a user on a portable device or removable device, such as a Zip drive. 
Before creating the user, make sure the device is attached to your computer.

1 Click Open User from the NaturallySpeaking menu.

2 Select Browse and pick the appropriate location.

3 Click New to create the user. Follow the steps in the New User Wizard.

Opening a user
When someone else has been using Dragon NaturallySpeaking, you need to open 
your own user before you start using the program. Or, if you have more than one user 
of your own (for example, you have a separate user for your portable recorder), 
always remember to switch to the appropriate user before you start.

To open a user:
1 From the NaturallySpeaking menu, select Open User.

2 Select a user and click Open. 

This loads your speech files. These files include information about your 
pronunciation that Dragon NaturallySpeaking needs to recognize your voice.

Viewing user properties
Clicking Properties... on the Open User dialog opens the User Properties dialog box. 
The User Properties dialog box lets you view information about the selected user, 
including the language, dictation source, speech model, and what steps you have 
taken to set up this user.
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Closing a user
You can close the currently active user. 

To close the currently active user, select Close User from the NaturallySpeaking 
menu.

When there is no user loaded, most of the NaturallySpeaking menu items are 
disabled.

Renaming a user 
You can change the name of a user at any time.

To rename a user:
1 From the NaturallySpeaking menu, select Manage Users.The Manage Users 

dialog box opens.

2 Select a user and click Rename. 

3 Type a new name and click OK. 

The name can contain up to 128 characters, including spaces. Special characters 
are not allowed in user names.

4 To close the Manage Users dialog box, click Cancel.

 You cannot rename the currently open user. If you have only one user and want to rename that 
user, you must first close that user. For more information see “Closing a user” on page 135.

Deleting a user
If you know you will not need a user that you have created, you can delete it and 
free up hard-disk space. Removing a user can’t be undone, so make sure you don’t 
need it before you remove it.

To delete a user:
1 From the NaturallySpeaking menu, select Manage Users.The Manage Users 

dialog box opens.

2 In the Manage Users dialog box, select the user you want to delete and click 
Delete.

TIP
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3 A dialog box will appear asking if you really want to permanently remove this 
user. To confirm, click “Yes.” To cancel, click “No.”

You cannot delete the currently open user. If you want to delete the currently open 
user, you must first close that user. For more information see “Closing a user” on 
page 135.

 Always use the Delete button to delete users. Do not remove folders from the 
\...NaturallySpeaking\Users folder on your hard disk. Using the Delete button is the only way to 
completely remove all information about a user from your computer.

Backing up and restoring a user
When you make changes to your user (for example, by adding words to the 
vocabulary), Dragon NaturallySpeaking prompts you to save your user speech files. 
The program automatically makes a backup copy every fifth time you save your 
speech files. 

You can change the frequency of automatic backups or turn this feature off. On the 
NaturallySpeaking menu, click Tools>Options>Data tab.

Using the “Automatically back up user files every "n" saves” option, you can set how 
often you want to automatically back up your speech files.

 This feature is not available with a roaming user.

To back up a user:
To back up a user:

1 From the NaturallySpeaking menu, select Manage Users. 

2 In the Manage Users dialog box, select the user you want to back up.

3 Click the Advanced> button and then select Backup.

This backs up the selected user in the location specified in the Backup location 
dialog box. The default location, <default>, is the individual user's folder. You can 
change the Backup location to any directory where Windows has both read and write 
permissions, including portable devices such as Zip drives and CD burners. If you 
change the location, backups for all users will be located in the same directory. For 
information on changing the default location, see “Changing the backup location” 
on page 137.

NOTE

NOTE
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If you made recent changes to your user (for example, added words to the 
vocabulary), Dragon NaturallySpeaking prompts you to save these changes before it 
makes the backup.

Restoring a backup copy of a user
If you make unwanted changes to your speech files (for example, you process the 
wrong documents in Vocabulary Builder), you can restore the last backup copy of 
your user. 

To restore a user:
1 From the NaturallySpeaking menu, select Manage Users. 

2 In the Manage Users dialog box, select the user you want to restore. For 
example, “Elmo.”

3 Click the Advanced> button and then select Restore.

Dragon NaturallySpeaking restores the last backup that was made and saves it 
with a different name, for example, “Elmo - Restored1.” 

4 Open the restored user to begin working with it. 

Delete the older version (in this example, the user named “Elmo”) and rename the 
one you just restored.

Changing the backup location
You can specify where NaturallySpeaking stores your user files and backs them up. 
You can define any location for which you have read and write permissions, 
including portable or removable drives and CD burners. 

 You can use a network device for the backup location but not for a portable user location. 
This feature is not available with a roaming user.

To set a back up location:
1 Close the currently open user by select “Close User” from the 

NaturallySpeaking menu.

2 From the Tools menu, select “Administrative Settings”. This displays the 
Administrative Settings diaog box. 

3 Click the Change button to open a dialog box in which you can specify a new 
location. If you change the location, backups for all users will be located in the 
same directory.

NOTE
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4 Select the location where you want to back up your user files and click OK.
The default backup location is:
\Documents and Settings\All Users\Application 
Data\ScanSoft\NaturallySpeaking8\Users\<username>\

 On Windows XP and 2000, you must have administrator privileges to change the Backup 
Location. This field is grayed out for restricted users. Dragon NaturallySpeaking will not let restricted 
users create backup files in directories reserved for the operating system (for example, the \Windows 
directory). When specifying a backup location, make sure that directory can be accessed by all users.

Importing and exporting users
Importing and exporting users is available only in the Preferred and higher editions.

To import or export a user:
1 From the NaturallySpeaking menu, select Manage Users. 

2 In the Manage Users dialog box, select the user you want to import or export.

3 Click the Advanced> button and then select Import or Export; depending on 
what action you want to take. This opens a Windows Browse dialog box that you 
can use to specify a location for the imported or exported user.

Upgrading Users

If you did not upgrade your Version 6 or Version 7 users during the V8 installation, 
you can use the Upgrade Wizard tool to upgrade these users.

At the same time that the User Upgrade Wizard modifies your user files to work with 
Dragon NaturallySpeaking version 8, it can move a copy of the upgraded user to 
another location while keeping the old files untouched. This allows you to return to 
the old user files in case you need them again.

 If you did not upgrade your V6 or V7 installation, you may need to copy the V6/V7 users to 
the computer where installed NaturallySpeaking V8, or alternately, an accessible network location. This 
location must have read/write permissions.

NOTE

NOTE
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You must have a drive letter mapped to the network location to access the user files from the Open 
User dialog box. UNC paths are not supported.

To upgrade V6/V7 users:
1 From the Windows Start Menu, select Dragon NaturallySpeaking 8>Dragon 

NaturallySpeaking Tools>Upgrade. This displays the User Upgrade Wizard 
dialog box:

2 Click Add to open a dialog box where you can specify the location of the users 
to upgrade. Once you have selected the users, click Next.

3 For the users selected, the Upgrade Wizard lets you specify to upgrade only the 
selected user, all users in the directory you selected, or choose which users 
should be upgraded. Once you have selected the user files to upgrade, click 
Next.

4 The Upgrade Wizard lets you choose where the upgraded users are to be 
stored. 

The <Default> location is:
Documents and Settings\All Users\Application 
Data\ScanSoft\NaturallySpeaking8\Users directory. 

Click the Browse button to navigate to another directory to use a directory other 
than <Default>. 

Click the Advanced button to specify different target directories for different 
users and to select new base vocabularies for the upgraded users.
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Click Next to continue.

5 The New User Wizard displays the users to upgrade. 

When you have confirmed that the wizard will upgrade the correct number of 
users, click the Begin button. The progress bar lets you know how far along the 
upgrade process has gone. When the upgrade process is complete, the Finish 
button becomes active so that you can close the wizard. If you want to stop the 
upgrade process, click the Cancel button.

 You can also launch the User Upgrade Wizard using the Open User dialog box on the 
NaturallySpeaking menu.

Creating Multiple Dictation Sources

Some editions of Dragon NaturallySpeaking allow you to create and train users with 
multiple dictation sources. For example, with a single set of user files you can dictate 
with a headset microphone, an array microphone, or a portable recorder. This way 
you can keep the same custom vocabulary and training, but use the dictation style 
most convenient for you at that moment. 

This ability is especially useful for a roaming user that you use for dictation at 
different locations using a variety of computing devices and microphones. For 
example, you might use a headset microphone at one computer, an array microphone 
at another, and a portable recorder that you use for transcription at a third computer. 
By allowing multiple dictation sources for a single set of user files, Dragon 
NaturallySpeaking lets you move from computer to computer regardless of the 
microphone type or differences in ambient noise.

You can add dictation sources to a user in the following way:

To add a new dictation source to a user
1 On the Open User dialog box, select the User for which you want to create a 

new dictation source. 

2 Click the Source button and then click New. 

3 On the New Dictation Source dialog box that appears, select a new input device 
for your dictation from the list. For example, you can choose from among 
different microphone or recorder types. 

4 Click OK. You return to the Open User dialog box. 

NOTE
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5 Select the user you just modified and click Open. If you have not previously 
trained the user with the new dictation source, the New User wizard appears 
and you can begin training. 



1 1 Managing Users

Dragon NaturallySpeaking User’s Guide142



C H A P T E R

Dragon NaturallySpeaking User’s Guide 143

12

Setting Up Roaming Users

he Roaming User feature let a single user dictate at different locations using a 
variety of computing devices connected to a network, without having to create 

and train individual user files at each location. For example, a doctor may need to 
dictate reports in a medical office building using a desktop computer, in a hospital 
room using a Tablet PC, or even at home using a laptop computer. In each case the 
Roaming User feature allows the doctor to use the same set of user files containing 
the same vocabulary words and acoustic information.

Roaming User Concepts
The Roaming User feature works by employing a single network (or master) user 
that can be opened from multiple networked machines running Dragon 
NaturallySpeaking. When you first open the network roaming user, the program 
makes a copy of it in a directory on your computer. You can then disconnect your 
computer from the network and dictate with that user.

The local roaming user is a copy of the user data taken originally from the network 
user but modified locally by corrections and acoustic data gathered during a 
dictation session. 

T

Local copy of
the Roaming User

Local copy of
the Roaming User

Local copy of
the Roaming User

Network location of the
network roaming User
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When you exit Dragon NaturallySpeaking, switch users, close a user, or save a user, 
the program saves changes to the local roaming user and synchronizes these changes 
with the network (or master) roaming user. In a situation where you are always 
connected to a network, this occurs at the time you perform one of these operations. 
When you dictate using a portable computer not currently connected to a network, 
synchronization occurs when you reattach the computer to the network containing 
the network roaming user and open that user again.

Roaming User Scenarios

Some situations that the Roaming User feature makes possible:

■ Among a group of networked computers, a central storage device can contain all 
the user files. You can load a user from the central location across the network 
and dictate at any computer on which Dragon NaturallySpeaking is installed. 
When you exit Dragon NaturallySpeaking and save the changes to your user 
files, these changes are saved in the central location. The next time you run 
Dragon NaturallySpeaking with that user, all the changes you saved are 
available to you regardless of which computer on the network you use for 
dictation.

■ You have a laptop, tablet, or other portable computer for which you have a 
network connection but which you want to use disconnected from that network. 
The Roaming User feature maintains consistency for all the user files once you 
reconnect your portable device to the network. 

For example, say you want take your laptop, which is networked at the office, 
home for the evening. Before leaving the office you load the user you want from 
a central location on the network to your laptop. Once home, you complete a 
dictation session and save new corrections and acoustic data on the laptop. 
When you return to the office, you reconnect the laptop to the network and the 
Roaming User feature synchronizes the updated user files on the laptop with 
those at the network’s central location the next time you load that user. 

Setting up the Roaming User feature

You must perform the following steps to enable the Roaming User feature:

■ Turn the Roaming User feature on

■ Tell Dragon NaturallySpeaking where the network roaming user is located

■ Tell Dragon NaturallySpeaking where the local roaming user is located

■ Choose the roaming user options you want
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To turn the Roaming User feature on
1 Start Dragon NaturallySpeaking. If the Open User dialog box appears, click 

Cancel. If a user file opens automatically (Dragon NaturallySpeaking will do 
this if there is only one user available), click Close User on the Dragonbar 
NatuallySpeaking menu. 

2 Click Administrative Settings on the Dragonbar Tools menu.

3 On the open Administrative Settings dialog box, select the Enable check box.

Selecting the check box makes the other options in the Roaming User group 
available.

To specify the location of the network roaming user
On each computer where someone will be dictating with a roaming user, you must 
tell that installation of Dragon NaturallySpeaking where the network roaming user 
is located, and if necessary, create that location. You do this on the Administrative 
Setting dialog box as follows:
1 On the open Administrative Settings dialog box, click the Browse button to the 

right of the Network directory box. 

2 Use the Browse for Folder dialog box to open a location where you want to 
store the network roaming user. It should be in a location accessible to all 
computers on the network that you want available for dictation with Dragon 
NatuallySpeaking. 

3 If the directory does not currently exist, click Make New Folder and type a 
name for the new folder. The new directory can have any name, but calling it 
something meaningful, such as network roaming User, will make the folder easier 
to find in the future.

4 Click OK.

To specify the location of a local roaming user
Dragon NaturallySpeaking must also know where to store a local copy of the 
network roaming user.
1 On the open Administrative Settings dialog box. The default location is 

<Roaming local>. If you want to change this path, click the Browse button to 
the right of the Local directory box.

2 Use the Browse for Folder dialog box to open a location where you want to 
store the network roaming user. This is the location on the computer where 
changes made during dictation, such as corrections or new acoustic data are 
stored before they are synchronized with the network roaming user.



1 2 Setting Up Roaming Users

Dragon NaturallySpeaking User’s Guide146

3 If the directory does not currently exist, click Make New Folder and type a 
name for the new folder. The new directory can have any name, but calling it 
something meaningful, such as Local Roaming User, will make the folder easier to 
find in the future.

4 Click OK.

Roaming user options
The Administrative Settings dialog box also contains several options that affect how 
the roaming user feature works. You can select from among the following options to 
modify the behavior of a roaming user:

■ Copy Dragon Log to Network: Select this box to copy the file, Dragon.log from 
the local roaming user folder to the network roaming user folder at the same 
time that the program synchronizes the local and the network roaming user. 
Dragon.log contains information that can help to diagnose problems that you 
might encounter using Dragon NaturallySpeaking.

■ Access network at user open/close only: Select this box to transfer local roaming 
user changes to the Options dialog box to the network roaming user when the 
program synchronizes the local and the network roaming user. 

■ Enable access to non-roaming users: Select this box to permit opening a non-
roaming user for a Dragon NaturallySpeaking session. Clear this option to 
prevent anyone from dictating with a non-roaming (local) user by accident.

■ Conserve archive size on network: Select this box to prevent making the files 
that contain the acoustic data from the latest ion available to the Acoustic 
Optimizer when the program synchronizes the local and the network roaming 
user. The roaming user feature prevents the Acoustic Optimizer from running 
on a local roaming user, so copying these files to the network roaming user 
allows the Acoustic Optimizer update the network roaming user with this 
acoustic data. If you do not wish to retain this information, you can use this 
option to prevent the transfer.

■ Set audio levels on each machine (recommended): Select this box to run the 
Check your audio settings option from the Accuracy Assistant window before 
before the first session with a roaming user. This includes the volume check and 
the microphone quality check. Because the audio setup data can vary depending 
on differences in the microphone, sound card, and ambient sound levels at each 
roaming user location, ScanSoft recommends that you select this option.

■ Ask before breaking locks on network users (recommended): Select this box to 
keep the option of maintaining or breaking a network lock when opening a 
roaming user. Normally, network locks prevent anyone from opening a roaming 
user at the same time someone else is opening that user. While this process does 
not take a long time, network problems can cause a lock to become “stuck” and 
not release when the open process is completed. When this happens, the next 
time anyone tries to open that user, they will see a message informing them of 
the lock and giving them the option of overriding it. If you do not wish anyone 
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to be bothered by this message and always want to break a network lock in this 
situation, you can clear this option to prevent the message from appearing. 
Because the presence of a lock can indicate a problem that needs to be 
addressed, ScanSoft recommends that you select this option.

Creating a roaming user

There are three ways to create a roaming user:

■ Train a new user with the Roaming User feature turned on

■ Copy an existing local user into the network roaming user location

■ Convert an existing user into a roaming user with the Manage User dialog box

To train a new roaming user
1 Make sure that no local user is open. Click Close User on the Dragonbar 

NaturallySpeaking menu if one is open.

2 Open the Administrative Settings dialog box by clicking Administrative 
Settings on the Dragonbar Tools menu.

3 Select the Enable check box and make sure the network directory for the 
network roaming user and the local directory for the local roaming user are set 
(see the procedures in the section Setting up the Roaming User feature).

4 Click OK.

5 Open either the Open User or the Manage User dialog box and make sure that 
the Location of user files box points to the network directory location of the 
network roaming user. If it does not, click the arrow a select the correct location 
from the list, or click the Browse button to locate the directory using the browse 
for folder dialog box.

6 Click New and begin training the user as you would any other user. See the 
chapter (reference here to chapter on getting started) for more information. 
When you are finished training the user, the program copies the user files into 
the network roaming user location specified in the Location of user files box.

You can also copy a local user into the network directory of the network roaming 
user. This has the advantage of allowing you to turn a number of local users into 
roaming user with a single operation.

To copy a user into the network user location
1 Double-click the My Computer icon and navigate to the location of the local 

user files you want to convert to roaming users. 
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2 Select the files you want to copy, right click, and click Copy from the shortcut 
menu that appears.

3 Navigate to the network directory for the network roaming user, right click, and 
click Paste from the shortcut menu that appears.

You can also convert an existing local user to a roaming user with the Manage Users 
dialog box.

To convert a local user into a roaming user
1 Open the Manage User dialog box. (Click Manage Users on the Dragonbar 

NaturallySpeaking menu.)

2 Use the list in the Location of user files box to select the location of the local 
user you want to convert to a network roaming user.

3 Select the user you want to convert. 

4 Click the Advanced button and then click Save to Roaming. The program will 
save the user in the location specified as the Network directory in the 
Administrative Settings dialog box.

5 Repeat the process for any other local users you want to convert to network 
roaming users.

Opening a Roaming User
You open a roaming user by telling Dragon NaturallySpeaking where the network 
roaming user is located and the location you want for the local roaming user. 

To opening a roaming user
1 If a local user is open, close it by clicking Close User on the Dragonbar 

NaturallySpeaking menu. 

2 Click Administrative Settings on the Dragonbar Tools menu. 

3 Select the Enable check box in the Roaming User group. This allows you to set 
the other roaming user options.

4 Set the location of the Network directory, the Local directory, and any other 
roaming options you want (see the section Setting up the Roaming User feature for 
procedures for setting the directories and descriptions of the options). 

5 Click OK. 
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6 Click Open User on the Dragonbar NaturallySpeaking menu. The users 
displayed on the list are the network roaming users available in the network 
directory location specified in the Administrative Settings dialog box.

7 Select the user you want and click Open. 

Synchronizing roaming users
When you complete a dictation session with a roaming user and exit Dragon 
NaturallySpeaking, the program attempts to synchronize the changes you have 
made to the local roaming user with the network roaming user. If your computer is 
connected to the network, synchronization happens automatically at the time you 
exit. If your computer is not currently connected to the network (such as when you 
use a laptop in a remote location), changes are saved with the local roaming user. 
The next time you connect to the network and load the network roaming user, the 
program synchronizes the local and the network roaming users before it loads the 
network roaming user.

The following changes take place when you synchronize roaming users:

■ Words added to the local roaming user during a dictation session are combined 
with the network roaming user vocabulary, while words deleted from the local 
roaming user are removed from the network roaming user vocabulary.

■ Acoustic data (files with a .DRA extension) is copied from the local roaming 
user and added to the network roaming user where the data is available to the 
Acoustic Optimizer. 

■ Custom commands you have created or modified using the MyCommands 
editor are copied to the network roaming user.

■ Any user options that you changed on the Options dialog box that are normally 
saved with the user are saved to the network roaming user. The only options 
that are not synchronized, but remain with the local roaming user, are the Use 
Active Accessibility for menu and dialog control option on the Miscellaneous tab, the 
Conserve disk space used by speech files option on the Data tab, and the Create 
usability log option on the Advance dialog box that opens from the Data tab.

Scheduling the Acoustic Optimizer for a roaming user
Even though you can only run the Acoustic Optimizer for a network roaming user, 
the Roaming User feature allows you to schedule the Acoustic Optimizer to run 
even while you are using a local user. Doing this requires that you have 
administrator privileges for operating systems that require them, such as Windows 
XP Pro.

To set the Acoustic Optimizer Scheduler
1 Open the Accuracy Center (say “Open Accuracy Center” or click Accuracy 

Center on the Dragonbar Tools menu) 
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2 On the Accuracy Center, click or say “Schedule Acoustic Optimizer to run 
later.”

3 On the tree pane of the Acoustic Optimizer Scheduler window, select the user 
and, if available, the acoustic profile you want to schedule for optimization.

4 Say “New Task” or click the New Task button. If your operating system 
requires a password (such as Windows NT, Windows 2000, or Windows XP), a 
dialog box will appear asking for your Windows user name and password.

5 On the Select Frequency dialog box, make sure that the user you want to 
schedule and acoustic model is selected on the User Name list 

6 Select the frequency for the schedule and then select the start date and start 
time. 

7 Click OK to return to the Acoustic Optimizer Scheduler.
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Using Portable Recorders 
(Preferred and Professional)

f you have Dragon NaturallySpeaking Preferred or a higher edition, you can 
dictate into a portable recorder and then use Dragon NaturallySpeaking to 

transcribe your recorded speech.

To prepare Dragon NaturallySpeaking for use with a recorder, follow these steps:

■ Install the recorder software (required only for certain recorders).

■ Create a user specifically adapted to the sound of your recorded speech.

Once you have created a user, follow these steps whenever you want to use your 
recorder with Dragon NaturallySpeaking:

■ Dictate into your recorder

■ Transcribe the recorded dictation

■ Correct mistakes

Supported recorders

Dragon NaturallySpeaking supports specific recorders that have been certified 
by ScanSoft, including:

■ Dragon NaturallyMobile recorder

■ Many Sony® IC recorders.

■ Many Panasonic IC recorders, including RR-US and RR-XR series.

■ Many Olympus recorders.

■ Pocket PC devices, including the Compaq iPAQ. (If you are using a iPAQ 
3830 with 32 MB of memory, you may need more memory to store both 
the training text and additional recordings.)

■ Devices that support the Palm OS®.

For a complete list of supported recorders, see the following Web site:
http://www.scansoft.com/naturallyspeaking/support/

I
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Installing recorder software

Some recorders require additional software to work with Dragon NaturallySpeaking. 
If you are using a:

■ Sony® IC recorder, you must install the Sony PC application software. For more 
information, see the documentation that came with your recorder

■ A Panasonic® IC recorder, you must install the Panasonic® Voice Editor. For 
more information, see the documentation that came with your recorder. 

■ An Olympus recorder, you can optionally install the Olympus DSS Player or 
DSS Player Plus. For more information on using the Olympus DSS Player with 
Dragon NaturallySpeaking, see the documentation that came with your recorder 
and the ScanSoft Knowledge Base ScanSoft website: www.ScanSoft.com/
NaturallySpeaking/support/.

■ A Pocket PC (for example, a Compaq iPAQ), you must install the ScanSoft 
Voice Recorder software. See below for more information.

■ Devices that support the Palm OS®, see the documentation that came with your 
recorder. This functionality is installed separately from Dragon 
NaturallySpeaking. See the online help for more information on installing Palm 
OS® using Dragon NaturallySpeaking to transcribe your recordings.

■ A Dragon NaturallyMobile recorder, you can install the Voice It® Link software, 
which is not required, but can enhance the recorder’s usability. 

Pocket PC: Installing ScanSoft Voice Recorder

If you are using a Pocket PC device like the Compaq iPAQ as a mobile recorder, you 
can install ScanSoft Voice Recorder either at the same time you install Dragon 
NaturallySpeaking, or at a later time.

To install ScanSoft Voice Recorder at the same time you install 
Dragon NaturallySpeaking:
1 If you don’t already have ActiveSync 3.5 on your desktop, you must install it. 

See http://www.microsoft.com/windowsmobile/resources/downloads/pocketpc/
activesync35.mspx for more information.

2 Connect your PocketPC device to your computer using the device's USB 
connection.

3 Install Dragon NaturallySpeaking.

4 At the end of the installation process, a message will appear stating that the 
Setup program has detected a PocketPC device connected to the computer and 
asks if you want to install ScanSoft® Voice Recorder.
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5 Click Yes.

6 Follow the instructions to install ScanSoft Voice Recorder on your device.

ScanSoft® Voice Recorder is automatically installed on your device. 

Installing ScanSoft Voice Recorder after you install Dragon 
NaturallySpeaking:
1 If you don’t already have ActiveSync 3.5 on your desktop, you must install it. 

See http://www.microsoft.com/mobile/pocketpc/downloads/activesync35.asp 
for more information.

2 Connect your PocketPC device to your computer using the device's USB 
connection (or the COM port for NT systems). 

3 Place the Dragon NaturallySpeaking CD in your computer's CD reader.

4 Open the Voicerec folder on the Dragon NaturallySpeaking CD.

5 Double-click on Setup.exe and follow the instructions on the screen.

ScanSoft® Voice Recorder is installed on your device.

Installing Palm OS support
Dragon NaturallySpeaking (Preferred and higher) you can dictate into any device 
that supports the Palm OS® and have your recording transcribed by Dragon 
NaturallySpeaking when you synchronize with your PC with the Palm OS device.

This functionality is installed separately from Dragon NaturallySpeaking. See the 
Dragon NaturallySpeaking online help for more information installing Palm support 
and using a Palm OS device to transcribe your recordings.

Creating a user adapted to your 
recorded speech

Before you can use Dragon NaturallySpeaking with a handheld recorder or mobile 
device, you must create a user specifically adapted to the sound of your recorded 
speech. You do this by running the New User Wizard and selecting one of the 
recorder options as the dictation source.

 Steps 1 and 2 assume that you have already created a headset microphone user. If you 
have not previously created a user for Dragon NaturallySpeaking, then the New User Wizard will 
appear when you first start the program and you can skip to step 3.

NOTE



1 3 Using Portable Recorders (Preferred and Professional)

Dragon NaturallySpeaking User’s Guide154

 Some editions of Dragon NaturallySpeaking allow you to create and train users with multiple 
dictation sources. For example, with a single set of user files you can dictate with a headset 
microphone, an array microphone, or a portable recorder. This way you can keep the same custom 
vocabulary and training, but use the dictation style most convenient for you at that moment. For more 
information, see “Creating Multiple Dictation Sources” on page 140. 

To create a user:
1 From the NaturallySpeaking menu on the DragonBar, click or say “Open User.”

2 In the Open User dialog box, click or say “New.” The New User Wizard guides 
you through the steps of creating a user. As you complete the steps, click Next 
whenever you are ready to continue.

3 On the Create User screen, enter a unique name for the user. Then select the 
appropriate recorder type from the Dictation source list. 

Use the following table as a guide for selecting a Dictation source and deciding what 
to do next.

DICTATION SOURCE HOW TO PROCEED

Dragon NaturallyMobile 
recorder connected to serial 
port

Use the recorder as a microphone attached to your 
computer with the supplied serial cable. Do not 
proceed any further with the training instructions in 
this chapter. Instead, use the instructions for new 
user training that begin on page 14. Also see 
“Using the Dragon NaturallyMobile recorder as a 
microphone” on page 165.

Sony® IC recorders Go to step 4.

Panasonic IC recorder Go to step 4.

NOTE
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4 The New User Wizard starts to guide you through training for the mobile user. 
Click Next to continue. 

For the Pocket PC, choose the “Start a New Training Recording” option.

5 On the Training - Recording your speech screen, select the text you would like 
to read from the list of choices. Click View if you want to read the text from the 
screen. Click Print if you want to send the text to your printer so you can read it 
while away from your computer. 
Printing out the text you selected to read may greatly help reading the text 
while using a handheld recorder. 

Olympus Digital recorders Go to step 4.

Pocket PC device used as 
digital recorder

Make sure that the power option "Turn off device if 
not used for " and “Turn off backlight if device is 
not used...” are not activated on your Pocket PC so 
that you can record for 10 minutes without 
interruption.
Go to step 4

Recording device plugged into 
Line-In jack 

Be sure the recorder is connected to your computer 
with a cable plugged into your sound card, and 
proceed to step 4.

Digital recorder using sound 
files (.wav) on disk (includes the 
Sony® ICD-R100 recorder)

Go to step 4.

DICTATION SOURCE HOW TO PROCEED
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6 After you have recorded approximately 15 minutes of your reading the selection, 
click Next.

 If you do not have enough available memory for 10 minutes of recording, a message box 
will warn you. Open the Pocket PC Main menu, tap Settings, tap the System tab, and then tap the 
Memory icon. Drag the Memory slider to the right until you have at least 12 MB of memory free for 
Storage.

7 The screen that appears and what you do next depends on the recorder type you 
have selected.

Recording with ScanSoft Voice Recorder on a Pocket PC
If you are using the ScanSoft Voice Recorder on a Pocket PC, do the following 
on the Pocket PC:

■ Tap File and then tap Training.

■ Tap the name of the text file you want to record and then tap OK.

■ Tap the Record button on the screen or press your device's Record button 
and begin reading the text on the screen or from a print-out. Read for at 
least 10 minutes. Do not stop the recording when you make a mistake. 
You will get a message when enough training data is collected.

■ Attach the Pocket PC to your computer.

RECORDER TYPE HOW TO PROCEED

Sony® IC Recorder Click the “Sony Memory Stick Voice Editor” or 
“Sony Digital Voice Editor” button and follow the 
instructions on the screen. 

Panasonic IC recorder Click the “Panasonic Voice Editor” button and 
follow the instructions on the screen.

Pocket PC In the "Select training recording" screen, select the 
location of your training file. Click Next to adapt 
the file.

NOTE
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8 Depending on your system, it can take up to 60 minutes to adapt your user for 
mobile recording. You do not have to sit at your computer while the program is 
adapting to your recorded voice.

Dictating into your recorder
You can start dictating once you have trained Dragon NaturallySpeaking to 
recognize your recorded speech.

When you dictate into your recorder, you should follow the same guidelines you use 
when talking directly to the computer.

Recording device plugged into 
Line-In jack

Be sure that the recorder is connected to the line-in 
jack on your computer and (optionally) select the 
Detect end of recording and automatically adapt 
user files box. If you do this, choose the number of 
seconds of silence before the wizard assumes that 
the recording is finished. Then click Start Recording 
and start your recorder to play back your dictation. 

Olympus recorder If you have the most recent version of the Olympus 
DSS Player or DSS Player Plus installed on your 
system, you will see an “Olympus DSS Player” 
button. Click the “Olympus DSS Player” button and 
follow the instructions on the screen. 
Otherwise, transfer the.wav file to your computer’s 
hard disk and then use the Browse button to locate 
the file. If you are not sure how to transfer recorded 
data to your computer, see the documentation for 
your recorder. Finally, click Next and follow the 
instructions on the screen.
For more information on using the Olympus DSS 
Player or DSS Player Plus with Dragon 
NaturallySpeaking, see the documentation that 
came with your recorder and the Knowledge Base 
ScanSoft website: www.ScanSoft.com/
NaturallySpeaking/support/.

Digital recorder using sound 
files (.wav) on disk (includes 
the Sony® ICD- R100 recorder)

Transfer the .wav file to your computer’s hard disk 
and then use the Browse button to locate the file. If 
you are not sure how to transfer recorded data to 
your computer, see the documentation for your 
recorder. Finally, click Next and follow the 
instructions on the screen.

RECORDER TYPE HOW TO PROCEED
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Here are some additional tips for getting good results:

■ If you talk directly into a built-in microphone, always hold your recorder at the 
same distance from your mouth. Some users report that it is easier to rest the 
recorder on their jaw for the most consistent results. Be sure to hold the recorder 
at the same distance you used when you dictated the training text.

■ Don’t change the recording volume setting on your recorder (if it has one). Keep 
the same setting you used during training. 

■ For a better quality recording, consider connecting your headset microphone to 
your recorder, rather than talking into the built-in microphone. Most recorders 
include connection for an external microphone a mike-in connection.

The restricted command set
When you are dictating into a recorder, most of the Dragon NaturallySpeaking voice 
commands cannot be used effectively because they require that you see the results 
on a computer screen. The restricted command set, however, can be used without 
visual feedback when you are dictating into your recorder. These are the commands 
in the restricted command set:

■ New Paragraph

■ New Line

■ Tab Key

■ Cap [word] or Cap Next [word]

■ All Caps [word]

■ No Caps [word]

■ No Space [word]

■ Caps On/Caps Off

■ All Caps On/All Caps Off

■ No Caps On/No Caps Off

■ No Space On/No Space Off

■ Scratch That

■ Resume With

Using the ScanSoft Voice Recorder on a Pocket PC
To start ScanSoft Voice Recorder:

■ On the Start menu, tap ScanSoft Voice Recorder.

■ Tap the appropriate button to record, pause, stop, or play.
The amount of available recording time appears in the upper right in the 
Available box. The amount of available time depends on the amount of 
memory in your Pocket PC device. 
For more information, see the ScanSoft Voice Recorder Help file on the 
Pocket PC.
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 “Resume With” is particularly useful when you are using a recorder. It lets you return to where 
you want to go within a recording if you misspeak or change your mind after dictating a phrase. For 
more information, see “Going back as you dictate” on page 50.

Later, when you transcribe your recorded dictation, you can choose to make Dragon 
NaturallySpeaking ignore all commands except the restricted command set. This 
prevents potentially damaging recognition errors (for example, a phrase being 
incorrectly interpreted as the command “Delete Previous 5 Paragraphs,” which would 
actually delete the previous five paragraphs from your transcription). For more 
information on how to do this, see the “The Advanced Settings dialog box” on page 
162.

Transcribing recorded dictation

Connecting a recorder to your computer
Before Dragon NaturallySpeaking can transcribe your recorded dictation, you must 
connect your recorder (or, in some cases, your recorder’s memory card) to your 
computer. Connect your recorder in the same way as you did when you created a 
user trained for your recorded speech. 

The following procedures describe the different methods you use for transcription, 
depending on the type of recorder you are using. Use the method that is appropriate 
for your recorder.

Transcribing from a handheld recorder or Pocket PC
Dragon NaturallySpeaking has features specifically adapted to work with the 
Dragon NaturallyMobile recorder, Sony® IC recorders, Panasonic® IC recorders, 
Olympus IC recorders, Palm OS devices, and Pocket Pcs. To transfer files from 
these recorders, use the following procedure.

To transcribe recorded dictation:
1 Start Dragon NaturallySpeaking. (You don’t need to turn the microphone on.)

2 Open the user adapted (trained) for your recorded speech. (Click Open User 
from the NaturallySpeaking menu on the DragonBar, select the user you want, 
and click Open.)

3 From the Sound menu on the DragonBar, click Transcribe Recording. (If the 
Extras toolbar is displayed, you can click the Transcribe button instead.) What 
you see next depends on the type of recorder you have. 

TIP
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Transcribe a Recording dialog box
If you have a Pocket PC, a Panasonic IC recorder, or a Sony IC recorder, or an 
Olympus IC recorder, the Transcribe a Recording dialog box opens. The illustration 
below shows the text for Transcribe a Recording dialog box when you have a Sony® 
Memory Stick™ IC Recorder:

Click the recorder icon.

If you want to change the target window of the transcription, specify which 
commands Dragon NaturallySpeaking will understand or change the recorder-
specific options, and click the Advanced button. For a more detailed description of 
the options, see the “The Advanced Settings dialog box” on page 162.

Transcribe From... dialog box
If you have recorded using sound files (.wav) like the Sony ICD-R100, the 
Transcribe From... dialog box opens. For example:

Click the Browse button to locate the sound file.

 If you are transcribing a wave file, make sure the file is in the following format: PCM, 11.025 
or 22.050 kHz, 16 Bit, Mono.

If you want to change the target window of the transcription, specify which 
commands Dragon NaturallySpeaking will understand or change the recorder-
specific options and click the Advanced button. For a more detailed description of 
the options, see the “The Advanced Settings dialog box” on page 162.

Recorder icon

NOTE
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4 What you see next, depends on your recorder:

 After transcription, your recorded speech should appear on the screen. If text doesn’t 
appear, see “Troubleshooting” on page 164.

Dragon NaturallyMobile recorder or the ScanSoft Voice Recorder
If you are using the Dragon NaturallyMobile recorder or the ScanSoft Voice 
Recorder, the Select Files for Transcription dialog box opens.  

With the Dragon NaturallyMobile recorder or the ScanSoft Voice Recorder, select 
the file or files you want to transcribe, and click the Transcribe button. You can only 
transcribe the .nwv format with this dialog

You can also select the memory location of the Pocket PC folder if the file you want 
is not displayed in the list. You can store recording in either the device's internal 
memory or in a memory card, if you have one attached to your device.

Dragon NaturallyMobile recorders
With the Dragon NaturallyMobile recorder, select the file or files you want to 
transcribe and click the Transcribe button.

Pocket PCs
With Pocket PCs using the ScanSoft Voice Recorder, select the file or files you 
want to transcribe and click the Transcribe button. You can only transcribe files in 
the .nwv format from this dialog box. To transcribe .wav or .eur files, open the 
Transcribe a Recording dialog box, and choose “Other Sources” and then “Audio 
File from Pocket PC”

NOTE
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Sony Memory Stick or ICD-BP recorders
If you are using the Sony® IC Recorder, the Sony® Memory Stick™ Voice Editor or 
Digital Voice Editor dialog box opens. 

In the Sony® Voice Editor or Digital Voice Editor screen, click the Voice 
Recognition tool  on the toolbar or the Voice Recognition option on the File 
menu.

Panasonic IC recorders
If you are using a Panasonic IC recorder, the Panasonic Voice Editor  dialog box 
opens. In the Panasonic Voice Editor, click the Dragon button.

Recorders using sound files (.wav)
If you are using a recorder that uses sound files (.wav) and you clicked the Browse 
button to locate the file, the Open dialog box displays. 

Locate the files you want to transcribe and click the Transcribe button to begin 
transcription.

Recorders plugged into the Line-In jack
If your dictation source is “Recording device plugged into Line-In jack,” press the 
Play button on your recorder. 

 If you are playing back recorded dictation through the Line-In jack, transcription stops 
automatically by default as soon as the computer hears 10 seconds of silence. 

Drag-and-drop transcription
You can transcribe a wave file (.wav) by dragging the file to the DragonPad window 
or onto the DragonBar. By doing this, NaturallySpeaking starts to transcribe the 
wave file automatically. 

The Advanced Settings dialog box
The Advanced Settings dialog box allows you to change how Dragon 
NaturallySpeaking transcribes the dictation from your recorder. The options you see 
when you open the dialog box depend on the type of recorder you are using. The 

NOTE
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illustration shows the Advanced Settings dialog box that appears when you are 
transcribing from the Dragon NaturallyMobile recorder.

The following sections describe the options on the Advanced Settings dialog box:

Destination
You can choose to specify that the recording should be transcribed into the 
DragonPad window or into a selected window you click in after closing the 
Transcribe a Recording dialog box. Make sure the window you select accepts text.

Commands
You can choose either the All Commands, Restricted Commands, or Dictation Only 
option.

■ “All Commands” enables all Dragon NaturallySpeaking commands during 
transcription. Any command recognized in the recording is carried out.

■ “Restricted Commands” disables all but the restricted command set during 
transcription. If other commands are recognized, they are entered as text. This 
prevents potentially damaging misrecognitions (for example, a phrase being 
misrecognized as “Delete Previous Paragraph”). For more information about 
the restricted command set, see page 158.

■ “Dictation Only” disables all commands during transcription, except for 
dictation commands. If the recording contains commands, they are entered as 
text in the document. 
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Communication options (for the Dragon NaturallyMobile recorder only)

■ “Select the Baud Rate to connect to the Dragon NaturallyMobile recorder” 
specifies the communication speed between your computer and your recorder. 
Generally, the speed should be set to the highest number (115,200). If you are 
having communication errors, try selecting a lower number.

■ “Dragon NaturallyMobile recorder is on <Com Port Number>” specifies the 
serial communications (COM) port that corresponds to the connector where you 
plugged in your recorder. If you have a problem connecting to your recorder, try 
selecting a different COM port. The default COM port is COM1.

Miscellaneous options (for Line-In recorders only)
“When using a Line-In recorder, stop transcribing after <N> seconds of silence” 
instructs Dragon NaturallySpeaking to finish transcribing a recording after it detects 
a certain number of seconds of silence. You can enter any value between 1 and 99 
seconds, but it should be long enough that Dragon NaturallySpeaking will not think 
you have finished when you are only pausing. Then, when you are dictating, be sure 
not to pause for more than the number of seconds you choose. At the end of your 
dictation, be sure that you record silence for at least that number of seconds.

Troubleshooting
If text doesn’t appear on the screen, check the following:

■ If you are using the Transcribe a Recording dialog box, did you click in a 
window after closing it? If you aren’t transcribing in the DragonPad window, you 
must click in the window in which you want the text to appear.

■ If you selected Through the Line-In Jack as your source, did you remember to 
press the play button on your recorder? Is your recorder properly connected to 
the computer?

■ Are you playing the right part of the recording? Listen to the source file to make 
sure it contains dictation.

■ If you are using an analog recorder, have you changed the volume setting on 
your recorder since running training? If so, check the audio volume and quality 
again. From the Tools menu on the DragonBar, click Accuracy Center, then 
“Check your audio settings.”

■ Is your recorder working properly? Check the power source. If you are using a 
battery, make sure it is fully charged.

■ If you are transcribing a wave file, make sure the file is in the following format: 
PCM, 11.025 or 22.050 kHz, 16 Bit, Mono.

Correcting mistakes
After Dragon NaturallySpeaking transcribes your dictation, make sure you correct 
any mistakes. To help you check for mistakes, you can play back your recorded voice 
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as you read what Dragon NaturallySpeaking transcribed. Listening to your dictation 
as you read the transcription will help you identify misrecognized words or phrases. 
For more information, see “Correcting and Editing” on page 41.

Using the Dragon NaturallyMobile 
recorder as a microphone

If you have a Dragon NaturallyMobile recorder, you can use it as a microphone 
when it is connected to the computer. This feature is convenient for editing your 
transcribed text by voice.

To use the recorder as a microphone:
1 Open the user you created for the Dragon NaturallyMobile recorder, if it is not 

already open.

2 Make sure the recorder is connected to the serial port of your computer.

3 Click the Microphone button on the DragonBar so the microphone is on (  ).

4 Wait until the recorder display reads “Mic On.” This takes about two or three 
seconds after you click the Microphone button.

5 Begin speaking, holding the built-in microphone of the recorder almost 
touching the corner of your mouth and a bit to the side. Do not hold the 
recorder so that the microphone is directly in front of your mouth.

6 When you have finished, click the Microphone button again so the microphone 
is off. 

 Turning off the microphone in this way does not turn off the recorder. To conserve your 
batteries, turn off the recorder by pressing the Power button.
NOTE
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14

Automate Your Work 
(Preferred and Professional)

 f you have Dragon NaturallySpeaking Preferred or a higher edition, you can 
create your own custom voice commands using the MyCommands Editor. These 

commands let you automate repetitive text entry and graphics insertion tasks while 
working in virtually any Windows application. In some editions of Dragon 
NaturallySpeaking you can use the MyCommands command-and-control and 
advanced scripting features to create customized macros and scripts to speech-
enable applications and to control them by voice.

There are five types of commands you can create. 

■ Text and Graphics, which you can use to enter text and graphics of your 
choosing. (Preferred and higher editions)

■ Macro Recorder, which lets you record a sequence of mouse movements and 
keystrokes. (Professional and higher editions)

■ Step-by-Step, which lets you activate menu and keystroke commands to control 
your application. Step-by-Step commands are useful for controlling applications 
and for multistep tasks. (Professional and higher editions)

■ Advanced Scripting, which allows people familiar with programming languages 
such as Microsoft® VBA to program commands that can perform virtually any 
function on the computer with voice commands. (Professional and higher 
editions)

■ Structured Commands are text and graphics commands with dynamic variables. 
You can set the values of these variables to be used as boilerplate text. 
(Professional and higher editions)

 If you’d like to use Step-by-Step, Macro Recorder, or Advanced Scripting commands and 
you have Dragon NaturallySpeaking Preferred or lower edition, you can upgrade to a higher edition 
of Dragon NaturallySpeaking. For more information on how to upgrade, see page 207.

 In addition to the custom commands described in this chapter, there is another way to create a 
command that types up to 128 characters of text. You can use the Vocabulary Editor to create a new 
word that has a written form that is different from its spoken form; for instructions, see ”View or edit 

I

NOTE

TIP
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your vocabulary” on page 125. You can use this technique for phone numbers, URLs, and short 
phrases. 

MyCommands edition differences
The following information will help you determine whether your edition of Dragon 
NaturallySpeaking supports creating and editing MyCommands.

Viewing and editing commands
You use the Command Browser to view and edit the commands available to you. 
These commands are the commands you create as well as the commands included 
with Dragon NaturallySpeaking that you can modify.

For more information, see “Working with Custom Commands (Preferred and 
higher)” on page 109.

Creating new commands
There are two ways to create a new command:

■ Using the Command Browser. For more information, see “Creating a new 
command” on page 110.

■ Select Tools>Add New Command from the DragonBar.

Both methods display the MyCommands Editor. See the section below for more 
information on using the MyCommands Editor.

Using the MyCommands Editor (Preferred and higher)

You use the MyCommands Editor to create and edit your voice commands. You use 
this dialog box to specify the command type, name, and other aspects of the 
command you are creating. You also can create and modify what the command does. 

EDITION SUPPORTS...

Standard Not supported

Preferred The creation of Text and Graphics commands only.

Professional and above All custom command types
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Note that not all command types are available in all editions of Dragon 
NaturallySpeaking.

To create a new command:

1 Type a name for your new command in the MyCommand name box. This is 
what you will say to execute the command.

2 Optionally, you can type a description for this command in the Description 
field.

3 Pick a group into which to place the command. You use these categories to 
locate the command in the Command Browser. By default, the groups Dragon 
and User-defined are available. To create your own group, select User-defined 
and type over it with a group name of your choosing. The new group name will 
appear in the list the next time you create a command. 

4 If you plan on creating many commands, use group names that will make it easy 
for you to find and manage your commands.

5 Define the Availability, or where the command will be available:

■ Global—the command will be available in every application. For example, if 
you are creating a command to type your address, you probably want it to be 
available globally so that the command can be used in all applications.
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■ Application-specific—the command will be available in the application you 
specify. When you select this option, the Application list appears. This list 
displays all the applications open on your system. If the application you want is 
not open, use the Browse button to locate the application on your computer or 
open the application as you would normally. 

■ Window-specific—the command will be available in the window you specify. 
When you select this option, both the Application list and Window list appears. 
If the application window you want is not in the list, open the application and 
check the list again.

6 Use the Command Type list to choose the type of command you want. The 
available Command Types depend on your version. 

7 Create the content for your command. See the sections below for more 
information. 

For information on Macro Recorder commands or Advanced Scripting commands, see the Dragon 
NaturallySpeaking online Help.

Creating Text and Graphics commands (Preferred and higher)
To create a Text and Graphics command, begin by following the steps in “Creating 
new commands” on page 168. Then follow the procedure described below. 

1 In the Content box, supply the text, formatted text, bitmap, or combination of 
all three that this command will insert into a document. 

You can type or dictate plain text into the Content box and press keys such as 
Tab or Enter. To format text, use the formatting buttons underneath the 
Content box or a keyboard shortcut, such as CTRL-b for making text bold. You 
can also copy formatted text from another application. For bitmaps, create the 
bitmap in another application and paste it here.
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The example below creates a command called “home address” that types a street 
address.

2 You can change the formatting of the text in the Content box with the 
formatting buttons below the Content box. 

To have the text in the Content: field entered into documents with the same 
font style and size as the text preceding it in the document, select the Plain 
Text check box. This setting is not valid for graphics.

3 Click Save to save your new command.

4 Switch to the application you want and test your new command by saying its 
name. For example, switch to Microsoft® Word and say “home address.” Your 
address should appear in your Word document. As with all commands, make 
sure to pause before and after saying the command.

Notes: 

■ Text and Graphics commands create rich text file (.RTF format) that includes 
formatting information that you specify. Programs that cannot accept .RTF 
format text, such as Notepad, will only show a plain text version of the 
command's contents. 

■ Make sure to test your command. For example, if you are in graphics program 
and you say “home address,” the command may not work if the graphics program 
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does not accept keystrokes. Also, application-specific commands work only in 
the specific applications for which they were defined.

■  New commands are saved only when you save your user files. To save your user 
files, select Save User files from the NaturallySpeaking menu or say “Save User 
Files.”

Creating Step-by-Step commands (Professional and higher)
To create a Step-by-Step command, begin by following the steps in “Creating new 
commands” on page 168. Then do the following:

1 Select Step-by-Step in the Command Type list.

2 Select a type of step from the list in the lower-left corner of the MyCommands 
Editor dialog box, as shown below.

There are eight different types of steps:

■ Keystrokes: acts as if you pressed a particular key. 

■ Open (application): Open a particular application or document or switches to 
that application or document if it’s already open.

■ Wait: Do nothing for a specified time. This step is useful, for example, to pause 
while an application opens.

■ Type Text: Type the text you specify.

Select a type of 
step from the list.
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■ Send Keys: Type a sequence of keys including CTRL, ALT, and SHIFT key 
sequences.

■ Stop Listening: Put Dragon NaturallySpeaking into sleep mode.

■ Microphone On: Turn the microphone on.

■ Microphone Off: Turn the microphone off.

For more information about each type of step, see the online Help.

3 Click the Insert button.

4 Depending on the type of step, Dragon NaturallySpeaking may ask you for 
more information. For example, for a Keystrokes step, you’ll be asked to enter 
the keystroke you want. Press the keystroke or dictate the keystroke using the 
“Press” command. Click OK.

5 Continue adding steps (repeat items 2 through 4 above). To edit a step, select it 
and click Edit. To delete a step, select it and click Delete.

6 Click Save to save your new command.

7 Switch to the application in which you want to use the command and test your 
new command by saying its name. 

 New commands are saved only when you save your user files. To save your user files, select 
Save User files from the NaturallySpeaking menu or say “Save User Files.”

Creating Structured Commands (Professional only)

Structured Commands are an extension to text and graphics commands that let you 
to set the values of variables in text blocks based on voice input. 

Simple text and graphics commands with variables can be created in the 
MyCommands editor without having to write large amounts of code.

For complete information on structured commands, see the online help.

Application states
Structured commands let you control the action of a command based on the 
existence of a state in the application. 

NOTE
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For example, when you assign a state to each field in a form, the same command can 
perform different actions depending on which field is activated. 

You can use Advanced Scripting methods to control the states within structured 
commands or to set the initial state from a non-structured command. You can also 
create structured commands that prompt the user to select values from a predefined 
list. 

When the user speaks a command, the user is presented with a list of pre-defined 
values for the command. Once the user selects a value, the value is inserted into the 
correct location in the macro.

Structured Commands Samples 
Dragon NaturallySpeaking includes several sample text and graphics commands 
with variables and sample structured commands. You can import the samples into 
Dragon NaturallySpeaking to use them as templates for your own commands. The 
sample commands are fully commented.

Getting more information on structured commands
For more information on structured commands, including the samples location and 
how to import the samples, see the online help.

Deleting custom commands
You use the Command Browser to delete commands that you have either created or 
imported. By clicking the Script button, you can display and then delete these 
commands.

For more information, see “Deleting a command” on page 112.

Importing and exporting commands
You can share custom commands with other users by exporting them to a file and 
then having the other user import that file. If you have created several users on your 
computer, this allows you to use these commands no matter which user you 
currently have open. 

You use the Command Browser to import and export commands. By clicking the 
Manage button, you can display the commands to import and export.

For more information see “Importing and exporting commands (Professional and 
higher editions)” on page 113.
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Changing the command group and availability
You can change the group or availability of a selected set of commands.

The command group is a category where you place the command. You use these 
groups to locate the command in the Command Browser. By default, the groups 
Dragon and User-defined are available. To create your own group, select User-
defined and type over it with a group name of your choosing.

The Availability defines where the command will be available:

■ Global: The command will be available in every application. 

■ Application-specific: The command will be available in the application you 
specify. When you select this option, the applications currently open appear. If 
the application you want is not open, use the Browse button to locate the 
application on your computer. 

■ Window-specific: The command will be available in the window you specify. 
When you select this option, the Window list appears. If the window you want 
is not in the list, you must close the MyCommands Editor dialog box, open the 
window you want, and reopen the MyCommands Editor dialog box to see the 
window listed. 
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15

Customizing Dragon 
NaturallySpeaking

sing the Options dialog box, you can customize Dragon NaturallySpeaking to 
specify hot keys, customize how text is formatted, start Dragon 

NaturallySpeaking with the microphone on, change how frequently your user files 
are backed up, and make many other changes to the standard behavior.

To open the Options dialog box, click Options on the Tools menu of the 
DragonBar, or say "View Options."

Correction options
Use this tab to control how correction and spelling features work.

U
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Correction options
The Correction options affect the Correction menu, which is the list of alternate 
recognitions that appears when you select words in your document. 

■ "Select" commands bring up Correction menu: Select this box to make the 
Correction menu appear every time you select a word or phrase by voice in the 
text you are dictating.

■ "Select" commands search backwards: Select this box to have the selection 
commands ("Select <text>" and "Select Again") search for matching text 
backward from the insertion point. Clear this box if you want the Select <text>" 
commands to search for the nearest occurrence from the insertion point, and the 
Select Again commands to continue searching in the resultant direction.

■ "Correct" commands bring up Spell dialog box: Select this box to make the Spell 
dialog box appear every time you correct a word or phrase in the text you are 
dictating.

■ "Spell" commands bring up Spell dialog box: Select this box to have the Spell 
dialog box appear when you speak a spelling command ("Spell <letters>" or 
"Spell That <letters>"). Note that if you pause after saying the command "Spell" 
the Spell dialog box will appear even if this box is not selected.

■ Automatic playback on correction: Select this box to automatically enable the 
playback of your dictation when you make a correction.

Correction menu
The second group of options in this dialog box lets you set additional correction 
preferences. 

■ Show only the choices: Select this box to display only the alternative words or 
phrases on the Correction menu rather than the additional commands. This will 
make the menu take up less space on your screen.

■ Anchor: Select this box to lock the Correction menu in its current location until 
you drag it to a new location. Clear this box to allow the Correction menu to float 
around the window as you select text by voice.

■ Enable double-click to correct: Select this box to open the Correction menu 
when you double-click a word to select it. Double-clicking to correct is useful if 
you are revising your dictation by mouse and keyboard, rather than by voice.

■ Show no more than n choices: Controls the maximum number of choices that 
can appear in the Correction menu.

For more information about spelling commands, see “Spelling as you dictate” on 
page 52.

 If you find that the Correction menu often does not contain the correct word, try increasing the 
number of choices displayed.
TIP
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Restore defaults
Click this button to restore the values of the Correction tab to what they were when 
you installed Dragon NaturallySpeaking.

Commands Options
Use this tab to set options that control how Dragon NaturallySpeaking interprets 
commands. 

Commands options

■ Pause required before commands: Adjusts the time interval considered to be a 
pause before you speak commands. The default setting is 250 milliseconds (.25 
second). You should normally leave this at its default setting.

■ Enable Natural Language Commands: Allows the use of Natural Language 
commands that you can use with a variety of applications such as Microsoft 
Word, Corel WordPerfect, AOL, and Microsoft Excel. This feature uses an 
additional 8 megabytes of memory and requires that you restart your computer 
before it takes effect.

■ Enable commands in HTML windows: Allows the use of commands designed 
specifically for use with Internet Explorer. You must also have this option 
selected in order to use voice commands in certain Microsoft Outlook dialog 
boxes when you are creating or editing messages in HTML format. These 
dialog boxes appear with the Internet Explorer symbol (a small document icon 
with the letter "e" in it) in the right corner of the window header.
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■ Require "Click" to select menu or control: Selecting this check box requires you 
to speak the word "Click" to select a menu command or Windows control, such 
as "Click File" instead of just "File." By default, this feature is turned off.

■ Enable mouse motion commands: Select this check box to allow you to use 
mouse motion commands such as "Move Mouse left," "Faster," and "Slower." 
Click the Speed button to select a mouse motion speed between 2 (slowest) and 
25 (fastest).

Restore defaults
Clicking this button restores the values of the tab to what they were when you 
installed Dragon NaturallySpeaking.

View options
Use the View tab to control the behavior and appearance of the DragonBar and the 
Results box. Changing these options only affects the current user; any other users 
keep their existing settings.

DragonBar options

■ Preview: illustrates the selected DragonBar mode.
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■ Mode: controls the appearance of the DragonBar. The choices are:

■ Show messages: displays useful hints that appear in the DragonBar periodically.

■ Show Extras: displays the extras toolbar automatically every time you start the 
DragonBar. (Preferred and higher editions)

Results Box

■ Beep after recognition: Dragon NaturallySpeaking beep each time it recognizes 
a word or phrase.

■ Anchor: Locks the Results box in its current location until you drag it to a new 
location. Clear this check box to allow the Results box to float around the 
window as you dictate.

■ Auto-hide delay: Adjusts the length of time before the Results box disappears 
after a recognition. From a list, you can choose to never hide it or never show it, 
or you can set a delay after which it automatically hides itself. The default 
setting is Never Hide.

Restore defaults
The Restore defaults button restores the values of the View tab to what they were 
when you installed Dragon NaturallySpeaking.

Docked to Top  The DragonBar appears along the top of the screen.

Docked to Bottom  The DragonBar appears along the bottom of the screen.

Floating  The DragonBar appears as a window on top of any 
other open window on your screen. You drag the 
DragonBar to reposition it.

Cling  The DragonBar is attached to the top of the currently 
active window.

Tray Icon Only  The DragonBar appears only as a microphone icon in 
the system tray. Right-click on the icon to see the 
DragonBar menu.
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Hot keys options
Use the Hot keys tab to specify hot key assignments. Changing these options only 
affects the current user, all other users keep their existing settings.

■ Microphone on/off: Changes the hot key that turns the microphone on or off. 
The default is the plus key (+) on the numeric keypad.

■ Correction: Changes the hot key that opens the Correction menu. The default is 
the minus key (-) on the numeric keypad.

■ Force command recognition: Changes the hot key that forces words to be 
recognized as commands rather than dictation words. The default is the CTRL 
key.

■ Force dictation recognition: Changes the hot key that forces words to be 
recognized as dictation words rather than commands. The default is the SHIFT 
key.

■ DragonBar menu: Changes the hot key that opens the NaturallySpeaking menu 
on the DragonBar. The default is the asterisk key (*) on the numeric keypad. 

■ Microphone sleep/on: Changes the hot key that causes the microphone to go to 
sleep or wake up. When the microphone is asleep, the only command it will 
recognize is "Wake Up," which turns the microphone back on. The default is the 
slash key (/) on the numeric keypad.

■ Press-to-talk: Changes the hot key that causes the microphone to turn on for as 
long as you hold down the key and turn off as soon as you release it.

■ Playback: Changes the hot key that causes Dragon NaturallySpeaking to play 
back your dictation so you can more easily identify what you meant to say during 
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correction. The default is the SHIFT key plus the minus key (-) on the 
numeric keypad. Preferred and higher editions.

■ Fast Playback: Changes the hot key that increases the play back speed. The 
default is the SHIFT key plus the asterisk key (*) on the numeric keypad. 
Preferred and higher editions.

Restore defaults
The Restore defaults button restores the values of the Hot keys tab to what they 
were when you installed Dragon NaturallySpeaking. Click the Related Topics 
button to see a list of the default hot keys.

 If you are using a laptop computer that does not have a numeric keypad, you should assign 
different hot keys before you use them, as the defaults will be difficult to use or may not work.

Text-to-speech options (Preferred and higher 
editions)

Use the Text-to-speech tab to adjust the attributes of text-to-speech playback. 
Changing these options only affects the current user; any other users keep their 
existing settings.

Attributes

■ Volume: Adjusts the volume of text-to-speech playback.

■ Pitch: Adjusts the pitch of text-to-speech playback if supported by your version 
of Text-to-Speech.

NOTE
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■ Speed: Adjusts the speed of text-to-speech playback.

■ Voice: Determines the voice to use for text-to-speech playback. You can select a 
voice from the list if you have more than one installed on your system.

Preview
Enter or paste text in this box to preview text-to-speech playback.

■ Read text: Click Read Text to start playback of the text in the Preview box.

Unload text-to-speech
Removes the text-to-speech engine from memory. Dragon NaturallySpeaking loads 
the text-to-speech engine the first time you use a text-to-speech command after 
starting Dragon NaturallySpeaking. The text-to-speech engine should not affect 
performance, so generally you will not need to unload it.

Restore defaults
Clicking this button restores the values of the Text-to-speech tab to what they were 
when you installed Dragon NaturallySpeaking.

Miscellaneous options
Use this tab to set miscellaneous options. Unless otherwise indicated, changing an 
option only affects the current user; any other users keep their existing settings.

User Open

■ Microphone on (asleep): Specifies that Dragon NaturallySpeaking automatically 
puts the microphone in sleep mode when you start the program. You must say 
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"Wake Up" or "Listen to Me" before Dragon NaturallySpeaking will recognize 
dictation or other commands. 

■ Launch DragonPad: Opens DragonPad when Dragon NaturallySpeaking first 
starts.

User Close

■ Automatically save user files: Saves your user files when exiting Dragon 
NaturallySpeaking without displaying a dialog box asking you to confirm that 
you want the user files saved.

Other options

■ Speed vs. Accuracy: Adjusts the number of words and phrases that the program 
examines in order to find a word match. The more words examined, the greater 
the possibility of an accurate match at the expense of using more memory and 
taking a longer time to recognize your speech. You can use the Speed vs. 
Accuracy slider to influence the performance of Dragon NaturallySpeaking. As 
a general rule, you should move the slider farther to the right on faster 
machines than on slower ones.

■ Use screen reader compatible menus: Allows a screen reader to read menu 
items out loud to vision-impaired users. Some screen readers have trouble 
reading menus unless this option is turned on. If this option is on, the small 
icons next to menu items will disappear.

■ Use Active Accessibility for menu and dialog control: Specifies that Dragon 
NaturallySpeaking should use Microsoft Active Accessibility features, which 
are required by some versions of Windows to control the menus and dialog 
boxes of certain applications by voice. 

This option is dimmed if Active Accessibility is not installed or if your version 
of Windows does not require it. Changing this option affects all users.

■ Launch in QuickStart mode on Windows startup: Allows Dragon 
NaturallySpeaking to load in the background when you start your computer or 
log in to your operating system, depending on your version of Windows. When 
Dragon NaturallySpeaking is launched in QuickStart mode the microphone 
icon appears in the system tray. When you start Dragon NaturallySpeaking in 
QuickStart mode, it is available for use more quickly than when you start it in 
normal mode.

Restore defaults
Clicking the Restore defaults button restores the values of the Miscellaneous tab to 
what they were when you installed Dragon NaturallySpeaking.
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Formatting options
Use this tab to set options that affect your dictation. Changing these options only 
affects the current user, all other users keep their existing settings.

■ Do not automatically format text: Turns off different forms of automatic number 
formatting. With this option selected you can still dictate numbers by saying 
"Numeral" before the number, but you must explicitly specify the digits and 
format characters such as commas, periods, or dollar signs. Note that the 
punctuation of numbers and currency depends on the settings on the Number 
and Currency tabs of the Windows Control Panel Regional Settings Properties 
sheet.

■ Automatically format text: Turns on different forms of automatic number 
formatting, which lets you dictate numbers in a natural manner and different 
forms of word formatting, such as abbreviations, contractions, and e-mail 
addresses. Note that the punctuation of numbers and currency depends on the 
settings on the Number and Currency tabs of the Windows Control Panel 
Regional Settings Properties sheet.

The following options are available only if the "Automatically format numbers 
and phrases" option is selected:

■ Web and E-mail: Turns on automatic e-mail and Web address formatting, 
which lets you dictate these addresses in a natural manner. It concatenates 
names in Web and e-mail addresses and recognizes the word "at" as the @ 
sign.

■ Street addresses: Turns on automatic formatting of postal addresses, such as 
For example, if you say "49 Orchard Lane, Boston, Massachusetts Oh Two 
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Four Four Six", Dragon NaturallySpeaking will transcribe "49 Orchard 
Lane, Boston, MA 02446."

Certain addresses can be hard for Dragon NaturallySpeaking to interpret. 
For example, "Two Hundred Forty Fifth Street" could be intrepreted as 
245th Street, 200 45th Street, or 240 5th Street. In a situation like this, 
Dragon NaturallySpeaking uses context to try to determine what you 
meant. In some cases, using the word "And" can help to narrow down the 
choices. In the example above, saying "Two Hundred And Forty Fifth 
Street" would eliminate 200 45th Street as a possibility.

■ Abbreviations: Enables Dragon NaturallySpeaking to recognize most 
standard abbreviations while transcribing your dictation if you say 
"Abbreviated" after the word. For example, if you say "February 
Abbreviated" Dragon NaturallySpeaking will transcribe "Feb." If you clear 
this box, Dragon NaturallySpeaking will transcribe spoken abbreviations in 
a more formal manner. For example, if you say "Ltd", Dragon 
NaturallySpeaking will transcribe "Limited."

■ Contractions: Enables Dragon NaturallySpeaking to recognize contractions 
while transcribing your dictation. If you clear this box, Dragon 
NaturallySpeaking will transcribe spoken contractions in a more formal 
manner. For example, if you say "Don't go near the water", Dragon 
NaturallySpeaking will transcribe "Do not go near the water."

In some situations, the formal expression of a contraction may be 
ambiguous. For example, the phrase "It's always" could either mean "It is 
always" or "It has always" depending on the tense of the verb that follows. 
In this situation, Dragon NaturallySpeaking will always transcribe the 
contraction, regardless of how this option is set.

■ ISO currency codes: If you have selected the Currency option, then you 
can select "Use ISO currency codes." This setting enables Dragon 
NaturallySpeaking to display currency amounts with the international 
symbol for the language you have choosen in the Windows Regional and 
Language Options tool. For example if you have United States English 
selected and say "Ten Dollars" Dragon NaturallySpeaking will transcribe 
"USD10." You can change the symbol displayed by changing the language 
on the Regional and Language Options tool in your Windows control panel 
and restarting Dragon NaturallySpeaking. You open the Windows control 
panel by clicking Start on the Windows task bar, pointing to Settings, and 
clicking Control Panel. 

■ Units of measure: Turns on automatic formatting of standard units of 
measure, such as feet and inches. For example, if you say "Six Feet Three 
Inches", Dragon NaturallySpeaking will transcribe "6'3"."

■ Phone numbers: Turns on automatic formatting of telephone numbers 
when you speak a sequence seven or ten numbers. For example, if you say 
"7815551234", Dragon NaturallySpeaking will transcribe "781-555-1234."
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■ Time: Turns on automatic formatting of standard time formats. For 
example, if you say "Six Thirty PM", Dragon NaturallySpeaking will 
transcribe "6:30 p.m."

■ Dates: Turns on automatic formatting of dates according to the format you 
select in the list just below the option. 

■ Currency: Turns on automatic formatting of standard forms of currency, 
such as dollars. For example, if you say "Six Dollars and Seventy Five 
Cents", Dragon NaturallySpeaking will transcribe "$6.75."

■ Other numbers: Enables the formatting of all numbers not covered by other 
options on this dialog box, such as negative numbers, numbers with 
punctuation, fractions, decimals, and roman numerals. For example, if you 
say "Ten Thousand", Dragon NaturallySpeaking will transcribe "10,000."

■ Allow pauses while speaking numbers and phrases: Allows number and phrase 
formatting to work together if you pause while speaking a number.

■ Automatically add commas and periods: Tells Dragon NaturallySpeaking to add 
commas and periods (full stop outside USA or Canada) at the appropriate places 
in your dictation without your having to explicitly speak that punctuation. 
Dictation with this feature turned on should duplicate the same natural pauses 
for commas and periods that you typically use in conversational speech. If 
commas and periods consistently do not appear where you expect them, try 
changing the length of your pauses. For example, if you normally speak rapidly, 
try to lengthen the time of your pauses to indicate the need for punctuation.

■ Enable postal code commands: Specifies the format of Canadian and UK postal 
codes in your dictation.

For example, to format a postal code in London, say "London Comma Post 
Code W Two Four R J" to enter London, W2 4RJ; and to format a postal code in 
Toronto, say "Toronto Comma Ontario Post Code M Five H Two L Two" to 
enter Toronto, Ontario M5H 2L2.

Note: You must reload your user before a change to this option will take effect.

■ Insert two spaces after period: Adds two spaces after the end of a sentence 
instead of a single space. Having two spaces at the end of a sentence was a 
standard with mono space fonts when most text was written with typewriters, 
but is less common with proportional fonts used in word processing programs. 
Clear this check box to add only one space.

Restore defaults
The Restore defaults button restores the values of the Formatting tab to what they 
were when you installed Dragon NaturallySpeaking.
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Data Options
Use this tab to instruct Dragon NaturallySpeaking to store corrections in an archive, 
conserve disk pace for easier portability of user files, and control how Dragon 
NaturallySpeaking adapts training, saves recorded dictation, and backs up user files. 
Unless otherwise indicated, changing an option only affects the current user; any 
other users keep their existing settings.

■ Store corrections in archive: Determines whether or not a list of your 
corrections are stored for later incorporation into your user files by the Acoustic 
Optimizer. Click the Archive size button to specify how much data is stored. If 
this option is not selected before you run the Acoustic Optimizer, you may see a 
message that there is not enough data for the Acoustic Optimizer to process. Be 
sure that this option is selected whenever you use Dragon NaturallySpeaking 
for an extended period of time.

Click the Archive Size button to change the archive size by dragging a slider 
from 30minutes of stored corrections (the minimum size) to 80 minutes of 
stored corrections (the maximum).

■ Conserve disk space used by speech files (for portability): Instructs the 
software to maintain a smaller set of user files so that you can more easily move 
them from computer to computer.

■ Incremental adaptation in additional training: Instructs the software to run the 
Acoustic Optimizer after a user performs additional training using only the data 
gathered from the training session. If not selected, the software uses all the data 
collected by the acoustic optimizer for adaptation.
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■ Save recorded dictation with document: Use this list to have Dragon 
NaturallySpeaking always save dictation files when you save a document 
without asking, ask you with a prompt, or never save dictation files. Saving 
dictation allows you to play back your speech after the original dictation session.

When you choose to save dictation, Dragon NaturallySpeaking saves it in the 
same directory as the document you are dictating into in a file with the same 
name as your document and the extension of .DRA. Since each .DRA file takes 
up approximately 1.5 MB of disk space per minute of saved dictation, you 
should delete the file when you no longer need it for corrections.

■ Automatically back up user files every "n" saves: Adjusts how often your user 
files are automatically backed up.

■ Advanced: Click this button to open the Advanced dialog box containing 
options to create a usability log, conserve the amount of disk space required by 
user files, and to enable the collection of acoustic data that ScanSoft can use to 
enhance the accuracy of Dragon NaturallySpeaking.

Restore defaults
The Restore defaults button restores the values of the Data tab to what they were 
when you installed Dragon NaturallySpeaking.
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A

Version 8 File Structure

Upgrading from Dragon NaturallySpeaking V6 or V7 to V8 will automatically relocate some 
NaturallySpeaking directories and files to ensure compatibility with the latest release of the 
Microsoft Windows platform.

Note: The following directory structures and file locations assume an installation to the default location. The location 
of the directories and files moved by the V8 upgrade cannot be changed or specified by the user.

V6 Directory structure for all supported Windows operating systems
The directory structure before upgrading to V8:

C:\Program Files\Dragon\NaturallySpeaking
\Custom 
\Data
\Help
\Program
\Results

  \Training
\Tutorial (optional installation)
\Users

Note: The \Custom directory is present only if you use nsadmin to create custom words, commands, or vocabularies

V7.0 Directory structure for all supported Windows operating systems
The V7.0 directory structure before upgrading to V8:

C:\Program Files\ScanSoft\NaturallySpeaking
\Custom 
\Data
\Help
\Program
\Results

  \Training
\Tutorial (optional installation)
\Users

Notes: The \Custom directory is present only if you use nsadmin to create custom words, commands, or vocabularies. The 
Dragon NaturallySpeaking V7.3 directory structure is the same as V8.
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V8 Windows 2000/XP Pro/XP Home directory structure
The Directory structure after installing V8 on Windows 2000/XP Pro/XP Home:

C:\Program Files\ScanSoft\NaturallySpeaking
\Help
\Program
\Tutorial (optional)

C:\Documents and Settings\All Users\Application Data\ScanSoft\NaturallySpeaking\
\Custom 
\Data
\Data\Training
\Users

C:\Documents and Settings\<username>\Application Data\ScanSoft\NaturallySpeaking\
\Results

V8 Windows ME directory structure (Standard and Preferred editions only)
Directory structure after installing V8 on Windows ME:

C:\Program Files\ScanSoft\NaturallySpeaking
\Help
\Program
\Tutorial (optional installation)

C:\Windows\Profiles\All Users\Application Data\ScanSoft\NaturallySpeaking\
\Custom 
\Data
\Data\Training
\Users

C:\Windows\Profiles\<username>\Application Data\ScanSoft\NaturallySpeaking\
\Results
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B

MSI Installation Options

Dragon NaturallySpeaking Preferred and higher editions include a native 
Windows Installer (MSI) that lets you customize your installations as well as 
install across a network to multiple client machines. In addition, you use this 
service to modify, repair, or remove an existing NaturallySpeaking 
installation. 

This appendix describes:

■ Command line options specific to the Microsoft Installer Service (msiexec.exe).

■ Command line options specific to how InstallShield Setup (setup.exe) calls 
msiexec.exe.

■ Command line options specific to NaturallySpeaking setup using msiexec.exe

MSI Installer location
Dragon NaturallySpeaking compiled .msi file, Dragon NaturallySpeaking 8.msi, is 
located on your installation CD.

Installation notes:
Unless otherwise noted

■ All command line options are case insensitive and may be combined

■ No options require special values based on the values of other options. 

In the examples below, user-supplied information is displayed between angle 
brackets. Do not use angle brackets (<,>) as part of the command line. 

Do not use quotation marks except when specifying a full path name with the 
-path command.
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Windows Installer (MSI) options
All native MSI command line options are supported. All options are 
documented in the MSI documentation:, found on:

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/msi/setup/
command_line_options.asp

All msiexec.exe command-line options must be prefaced with a forward slash 
(/) only. 

The following are the most useful MSI options for installing Dragon 
NaturallySpeaking:

OPTION DESCRIPTION

/q or /qn Quiet (or silent) mode installation.

/l 
[i|w|e|a|r|u|c|m|o|p|v|x|+|!|*] 
Logfile

Specifies the location of an installation logfile and specifies the 
nature of the information to be logged:
i - Status messages.
w - Nonfatal warnings.
e - All error messages.
a - Start up of actions.
r - Action-specific records.
u - User requests.
c - Initial UI parameters.
m - Out-of-memory or fatal exit information.
o - Out-of-disk-space messages.
p - Terminal properties.
v - Verbose output.
x - Extra debugging information. Only available on Windows 
Server 2003.
+ - Append to existing file.
! - Flush each line to the log.
"*" - Wildcard, log all information except for the v and x options. 
To include the v and x options, specify "/l*vx".

PROPERTY=VALUE Overrides default public property value. For example, setting 
"XYZ=ABC" will replace the default property value of XYZ to ABC.
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InstallShield (setup.exe) options
Like the Microsoft Installer Service (msiexec.exe), the InstallShield Setup 
program (setup.exe) can accept a number of command line options and can 
pass options through setup.exe to the included .msi file.

All setup.exe command-line options must be prefaced with a forward slash 
(/) only. 

All options are documented in the InstallShield documentation:

http://helpnet.installshield.com/robo/projects/helplibdevstudio9/
IHelpSetup_EXECmdLine.htm

The following are the most useful command line options for installing 
NaturallySpeaking:

OPTION DESCRIPTION

/v Passes command line and public properties options to the Windows Installer 
(msiexec.exe) installation.  
If you run setup.exe (rather than msiexec.exe) to install NaturallySpeaking, you can 
specify any Windows Installer command line options using the "/v" option.  
For example, for MSI quiet mode, you'll need to run setup.exe /v/qn.  To set the 
public property of XYZ to "ABC", you would run setup.exe /v"XYZ=ABC".

/s Formerly "noui"
Runs setup in a "silent" mode, suppressing the initialization window.  However, 
unless the MSI installation is also specified as silent, the MSI installation will run 
normally.  
In order to run both setup.exe and msiexec.exe silently, you will need to combine the 
/s and the /v options. Use the following command line: setup.exe /s /v/qn.  
Using these options, no dialogs of any kind will be displayed during installation or 
uninstallation.  All messages are suppressed or, if a log file is also specified, sent to 
the MSI log file in the user-specified temp directory.  
The "noui" command line flag is no longer supported.

/l (followed by the 
Windows 
Language Code)

For Multi-lingual installations, specifies the language to use for installation and 
bypassed the "Choose Installation Language" dialog box.  
For example to launch the installation in French, the command line would be 
setup.exe /l1036.
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MSI options specific to NaturallySpeaking
This section described the msiexec.exe options specific to Dragon 
NaturallySpeaking.

The Dragon NaturallySpeaking command line options do not need to be 
prefaced hyphens or slashs. 

 Launching <msiexec.exe "Dragon NaturallySpeaking 8" XYZ=ABC> automatically sets the 
property "XYZ" to the value of "ABC" internally and continues the installation.  However, installation 
through setup.exe will still require the "/v" command line option in order to pass the property override 
value on to the MSI service.

The following table documents the supported global property overrides.  
Unless noted otherwise, all property values are in UPPERCASE.

OPTIONS DESCRIPTION

SERIAL NUMBER=abcde-fgh-hij-
klmo-pqrst-uv

The serial number, in the form of "abcde-fgh-hij-klmo-pqrst-uv". 
A serial number is required for all installations.  If one is not already 
built into the ereg.ini file, then a valid one must be specified on the 
command line.  
Note: Specifying a serial number on the command line does not 
bypass the serial number checking within setup. 

INSTALLDIR="c:\xyz” The default installation directory.  
Long path names need to have their quote strings "escaped" (\"). If 
you do not use this option, NaturallySpeaking is installed to the 
defualt directory: [PROGRAMFILES]\ScanSoft\NaturallySpeaking8.
If you are upgrading from a previous version, you must set 
INSTALLDIR to that versions installation directory.

PRODUCTUPDATEFLAG="YES" (or 
"")

Sets the default state of the checkbox at the end of installation to 
determine if the installation will automatically check the ScanSoft 
website for product updates.
Set this to an empty string ("") if you do not want to check for 
updates.
The default setting is "YES" (check for product updates).

RUNTIME=0 (or 1) Enables the "runtime" features.
This option suppresses the UI for shortcuts and for the product itself.  
The default value is "0" ("regular" UI).

NOTE
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The Roamng User .ini file
You can create a "roaming user ini file" to change the roaming user settings at 
installation time. These options are the same settings as displayed in the Roaming 
User section of the Administrative Settings dialog box.

RebootYesNo=No Stops Windows from rebooting, even if the installation will not be 
complete until Windows is restarted.
This option will also suppress the prevention of installation when a 
reboot is necessary. 
Note case: This should not be uppercased.

WEBREGISTRATION=1 (or 0) Determines whether or not to launch the on-line product registration 
form.
0 disables the product registration.
The default is 1 (enabled).

ROAMINGUSERINI="c:\xyz.ini Professional only.
Specifies a "roaming user ini file", which contains settings to be 
merged into nssystem.ini at installation time. These are the same 
settings as displayed in the Roaming User section of the 
Administrative Settings dialog box.
Long path names need to have their quote strings "escaped" (\").
The default is empty (no .ini file will be used).

OPTIONS DESCRIPTION

Roaming User On=0 (or 1) Turns on the Roaming User feature.
Default 0 = Off

Roaming User Master 
Directory=”existing directory”

The location of the master roaming user you want to open.
This directory must exist.

Roaming User Local Cache 
Directory=”existing directory”

The location of the local copy of the roaming user.
The default location is: Documents and Settings\All 
Users\Application 
Data\ScanSoft\NaturallySpeaking8\Roaming User\.

Roaming User Restrict Local User 
Access=1 (or 0)

Permits non-roaming user to be opened when the roaming user 
feature is active. 
Defaults to "1" which restricts access to roaming user only and 
prevents dictating with a non-roaming (local) user by accident.

Roaming User Copy Dragon Log=1 
(or 0)

Copies the Dragon.log file from the local roaming user location to 
the master roaming user location at the same time that the 
program synchronizes the local and the master roaming user. 
Default 1= On

OPTIONS DESCRIPTION



A P P E N D I X  MSI Installation Options

Dragon NaturallySpeaking User’s Guide198

Example .ini file:

[Settings]

Roaming User On=1

Roaming User Master Directory=G:\TEMP\user1

Roaming User Restrict Local User Access=0

Roaming User Copy Dragon Log=1

Roaming User Limited Network Traffic=1

Roaming User Local Cache Directory=D:\roam

 

Roaming User Limited Network 
Traffic=1

Transfers local user changes to the Options dialog box to the 
master roaming user when the program synchronizes the local 
and the master roaming user.
Default 1= On

Roaming User Always Break Lock=0 
(or 1)

Ask before breaking the locks on network users (recommended). 
A network lock prevents the opening of a roaming user while that 
user is already open. While this process does not take a long 
time, network problems can cause a lock to become "stuck" and 
not release when the open process is completed. When this 
happens, the next time anyone tries to open that user, they will 
see a message informing them of the lock and give them the 
option of overriding it.
Default 0 = ask before breaking lock

Roaming User Max Container 
Size=500MB

Controls the maximum size for each container directory in the 
master user directory.
Defaults to 500 MB, max of 10000 MB

ASW Override=0 (or 1) Runs a Volume Check and the Microphone Quality Check each 
time you open a roaming user.
Turn this option on if your users experience reduced accuracy 
because of differences in the microphone, sound card, and 
ambient sound levels of each roaming user location.
Default 0 = off

Roaming User Do Not Copy Dra 
Files=0 (or 1)

Prevents making the files that contain the acoustic data from the 
latest dictation session available to the Acoustic Optimizer when 
the program synchronizes the local and the master roaming user. 
This prevents the Acoustic Optimizer from running on a local 
roaming user. If you do not wish to retain this information, you 
can use this option to prevent the transfer.

OPTIONS DESCRIPTION
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A
abbreviations 96
accuracy

improving 117
Accuracy Assistant 118
Acoustic Optimizer 118

scheduling 119
Acoustic Optimizer Scheduler 119
acronyms 96
Active Accessibility 184
active vocabulary 125
add a word 121
Advanced Settings dialog box 162
All Caps Off 63
All Caps On 63
All Caps That 63
All Caps [text] 62
America Online 67
American English 8
apostrophe ’s 93
applications

opening 27
switching 28

Audio Setup Wizard 12
Australian English 8
automating your work 167

B
backing up a user 136
BACKSPACE key 52
back-up location

changing 137
Bold That 66

bookmarks. See Favorites
British English 8
bulleted text 66
buttons, selecting 29

C
Cap That 63
Cap [word] 62
Capitalize That 63
Capitalize That 63
capitalizing text

already in a document 63
applying lowercase 63
consecutive words 62-63
next word 61

Caps Off 62
Caps On 62
Center That 66
characters

deleting 52
moving to next/previous 49
selecting 47

check boxes, selecting 29
clicking the mouse 38
Command Browser 103, 121
Command Mode 101
commands

browsing available commands 103
training 130
using with a recorder 158
See also custom commands

commas
autoimatically adding 91

Index
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Compound That 95
compound words 94-95
contact names, adding 123
contractions. See apostrophe ’s
Copy That 50
copying text 50
Correct [text] Through [text] 2, 46
Correct [text] To [text] 2, 46
Correction menu 41
Correction options 178
creating a new user 10
currency 90
custom commands

creating 168
deleting 174
Step-by-Step 172
Text and Graphics 170
types of 167
viewing 168

custom words, deleting 126
custom words. See Vocabulary Editor
Cut That 47, 50
cutting text 50

D
Data options 189
dates 85
deferred correction 56
Delete That 51
deleting commands. See custom commands, deleting
deleting text

backing up and resuming dictation 50
characters 52
last words dictated 50
lines 51
paragraphs 51
specific words 47, 51-52

deselecting text 46
dialects

dictating currency 90
dictating times of day 86
spelling and punctuation conventions 2

dictate now, correct later 56
Dictation Mode 101
dictation sources, multiple 133, 140, 154
dictation, saving for later playback 56

documents
moving to top/bottom 48
opening 27
selecting all text in 47

dollar sign 90
Drag-and-drop transcription 162
Dragon Log 26
Dragon NaturallyMobile recorder 152, 161

used as microphone 165
DragonBar 17, 23

Extras toolbar on 23
hiding 180
options 180
Tray Icon Only mode 180

DragonPad 18

E
Edit Vocabulary 125
e-mail 67

adding contact names 123
checking for new 68
closing 68
composing 68
deleting 70
dictating 69
forwarding 69
navigating fields 69
opening 68
printing 69
replying to 69
sending 69
transferring dictation 69

e-mail addresses, dictating 96
errors, reducing 117
ESC key 55, 58
Euro symbol, changing 186
Extras toolbar 23, 59

F
Favorites, in Web pages 70
folders, opening 27-28
fonts, changing 64
Format That 65
Format That Centered 66
Format That Left Aligned 66
Format That Number 84
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Index

Format That Right Aligned 66
Format That Spelled Out 84
Formatting options 186
formatting text 64

applying bold 66
applying italics 66
applying underlining 66
changing font face, size, and style 64
removing formatting 66

fractions 87
frames 75

G
Give Me Help 21
Go to Beginning of Line 48
Go to Bottom 48
Go to End of Line 48
Go to Sleep 18
Go to Top 48

H
handheld recorder. See recorder
help

online 21
homophones, tips for selecting 46
Hot key options 182
Hyphenate That 94
hyphenated words 93

dictating 94
hyphens 94

preventing 94
removing 94

I
icons, selecting 30
improving performance. See accuracy
Indian English 8
Insert After [text] 49
Insert Before [text] 49
installation 6
installing recorder software 152
International Communications Alphabet 32
Internet addresses 96

Internet Explorer
adding a favorite Web page 71
clicking check boxes, list boxes and radio 

buttons 74
clicking images 74
clicking named buttons 74
dictating URLs 71
entering a Web address 71
entering text in a text box 72
following links 72
frames and panes 75
going back or forward in Web pages 71
going to a favorite Web page 70
scrolling in a Web page 75

Italicize That 66
italics, adding or removing 66

K
keyboard shortcuts

stopping playback 55-56, 58
keyboard, pressing keys 32, 34-35

L
Left Align That 66
lines

deleting 51
moving to beginning/end of 48
moving up/down 49
selecting 47

list boxes 31-32
Lotus Notes 67
lowercase, applying 63

M
macros. See custom commands
making selections

list boxes 32
measurements. See abbreviations
menus, opening and closing 28
microphone

on/off key, changing 182
plugging in 6
proper positioning 12
sleep mode 18
turning on and off 17
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Microsoft
Excel 80
Internet Explorer 70
Outlook 67
Outlook Express 67
Word 76

minus (-) key 56
Miscellaneous options 184
modes 101
money 90
mouse

clicking 38
moving the pointer 36-38

MouseGrid 36
Move to Bottom 48
Move to Top 48
moving around a document

before/after specific words 49
to beginning/end of line 48
by paragraphs or lines 49
scrolling 31
to top/bottom of page 48
by words or characters 49

multiple dictation sources 133, 140, 154
multiple users 6
MyCommands. See custom commands

N
names

adding 123
dictating 95

Natural Punctuation 19, 91
new commands. See custom commands, creating
new features in version 8 3
New User Wizard 133, 153
new user, creating 10
No Caps Off 63, 97
No Caps On 63, 97
No Caps That 63
No Caps [text] 63
No Space 95
No Space Off 95
No Space On 95

numbers 83
changing formats 84
currency 84, 90
dates 85
fractions 87
Roman numerals 88
telephone numbers 86
times of day 86

Numbers Mode 85

O
Olympus Digital Recorders 155
Olympus DS-150/650 Recorder 157
opening

e-mail 68
folders 27

opening applications 27
Options dialog box 177
options, selecting 29

P
Page Down 48
Page Up 48
pages. See moving around a document
Palm OS support 153
Panasonic IC recorder 152
paragraphs

deleting 51
moving up/down 49
selecting 47

Paste That 50
pasting text 50
Pause Required Before Commands control 179
Performance Assistant 131
performance, improving 131
periods

automatically adding 91
periods, spacing after 186
phone numbers 86
Play That Back 55
playback controls 54
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playing back dictation 54
correcting mistakes 56
in the Correction dialog box 54
in a document 55
skipping backward 56
skipping forward 56
stopping 55-56
storage space for 56

portable devices
creating users on 134

portable recorder
using Dragon NaturallySpeaking with 151

possessives. See apostrophe ’s
postal and ZIP codes 88
pound sterling 90
problems dictating currency or time 84
programs, opening. See opening applications
proper names, dictating 95
properties of words 128
punctuation 19, 91

automatic 91

Q
QuickStart 25

R
Read That 58
recorder

correcting mistakes 164
installing software for 152
transcribing with 159
transcribing with Drag-and-drop 162

Regional Settings control panel 84
removing Version 5 7
Restore That 66
Restoring 137
restoring a user 137
restricted command set 158
Resume With 50, 159
revising text. See Select-and-Say
Right Align That 66

Roaming User 143
creating 147
opening 148
options 146
scenarioes 144
scheduling the Acoustic Optimizer 149
setup 144
synchronizing 149

Roman numerals 88

S
’s 93
saving dictation 56

storage space for 59
saving speech files 136
Scratch That 47, 50
scrolling 31
scrolling, in Web page 75
searching while selecting 46
Select Again 46
Select All 47
Select Document 47
Select [text] 45
Select-and-Say
selecting text 45

again 46
characters 47
a document 47
lines 47
paragraphs 47
punctuation 45
specific words 46-47

Set Font 64-65
Set Size 64
Setup Log 26
Skip Backward 56
Skip Forward 56
Skip Word button 15
sleeping 18
software installation 6
Sony IC recorder 152, 156
Sony ICD-R100 recorder 155
Southeast Asian English 8
spaces

after periods 186
speakers, plugging in 6
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special characters 97
Speed vs. Accuracy control 184
Spell Mode 101
Spell That 42
Spell [text] 52
spelling

as you dictate 52
errors 54

spoken forms 126
creating 126

starting applications. See opening
applications

Startup options 179
Step-by-Step commands. See custom commands
Stop Listening 18
Strikeout That 66
Structured Commands 173

Samples 26
student voice models 11
switching windows 28

T
Tab key 30
tabs (dialog box), selecting 29
tape recorder. See recorder
teenage voices 11
telephone numbers 86, 186
Text and Graphics commands. See custom commands
text-to-speech 58
times of day 86
training

commands 130
for recorded speech 155
words 130

troubleshooting 22
recorder transcription 164

typeface, changing 64

U
UK English 8
Uncapitalize 63
Uncapitalize That 63
Underline That 66
unselecting text 46
Upgrading 7, 26, 138, 191

directory structure 191

URLs, dictating 71
user files

creating 10, 153
multiple users 6

users
backing up 136
closing 135
creating new 133, 153
deleting 135
on portable devices 134
opening 134
renaming 135
restoring from a backup copy 137
speech files 133, 136
upgrading 138

users. See user files

V
View options 180
vocabularies

editing 125
managing 130

vocabulary
adding contact names 123

Vocabulary Editor 125
vocabulary tools 121
Voice It Link 152
volume setting, on a recorder 158

W
Web addresses 71, 96
What Can I Say 21
what’s new in version 8 3
windows

switching between 28
Word Properties dialog box 128
words

adding 121-122
adding a list 124
changing properties 128
deleting 47, 51-52
moving to next/previous 49
placing insertion point before/after 49
selecting 46-47
training 130

written forms 126



Dragon NaturallySpeaking User’s Guide 205

Index

Y
years 85

Z
ZIP codes 88
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Technical Support

If you purchased your product directly from a certified ScanSoft Applications Solutions Partner, 
contact them directly for technical support.

The answers to many Dragon NaturallySpeaking technical support questions can be found on 
our Web site at www.ScanSoft.com/NaturallySpeaking/support/.

Information and Sales

ScanSoft, Inc.
9 Centennial Drive
Peabody, MA 01969
USA
Web: www.ScanSoft.com/Contact/



Training and Customization

Professional training and customization services from a ScanSoft-certified Applications Solutions
Partner can help you achieve the maximum return on your investment. If you would like to un-
leash the full potential of Dragon NaturallySpeaking software, please contact one of our Partners
for training, customization, and more.

ScanSoft Application Solution Partners are the best in the industry; distinguished by their exper-
tise, experience, and commitment to providing top-level services for Dragon NaturallySpeaking
speech recognition products.

For details on ScanSoft Application Solutions Partners near you, please visit:
www.ScanSoft.com/NaturallySpeaking/locator/
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